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4. About Labris Networks Inc. 

Since 2002, Labris Networks Inc. has been an R&D focused and rapidly-growing provider of 

network security solutions through its globally-proven products. Labris ensures ultimate network 

security through its extensive product line including Firewall/VPN, Web Security, E-Mail Security, 

Lawful Interception and Availability Protection solutions on LABRIS UTM, Labris LOG and Harpp 

DDoS Mitigator appliances. Next-generation solutions are developed to detect, identify all kinds 

of real-time threats, applications providing a smart shield against intrusions, viruses, spam, 

malware and availability attacks. 

Labris products protect networks of all sizes with a variety of topologies and deployment 

scenarios. Through Labris FLEX firmware options, the customers have privileges to get the 

security software they need as well as extra modules such as Wireless Guest Authentication, 

Detailed Internet Reporting, Lawful Interception and Logging. Having a customer-focused, 

future-oriented and flexible approach, Labris also offers its state-of-the-art security software as 

a Cloud Service. 

Having operations in a rapidly growing global network of more than 20 countries, Labris products 

protect enterprises, brands, government entities, service providers and mission-critical 

infrastructures. 

Labris with its worldwide partners is committed to the highest levels of customer satisfaction 

and loyalty, providing the best after-sales support by the multilingual Global Support Center. 

Being one of the Common Criteria EAL4+ certified security gateway brands in the world and 

rapidly growing global player, Labris provides its customers the top-level security with optimum 

cost. Labris, headquartered in Ankara, Turkey, has offices serving Europe, Middle East, North 

Africa, Caucasus and Southeast Asia. 
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5. About LABRIS UTM 

Labris UTM is an Identity-based UTM Appliance. Labris UTM’s solution is purpose-built to meet 

the security needs of corporates, government organizations, and educational institutions. Labris 

UTM’s perfect blend of best-of-breed solutions includes Identity based Firewall, Content filtering, 

Anti Virus, Anti Spam, Intrusion Detection and Prevention (IDP), and VPN. 

Labris UTM provides increased LAN security by providing separate port for connecting to the 

publicly accessible servers like Web server, Mail server, FTP server etc. hosted in DMZ which are 

visible to the external world and still have firewall protection. It also provides assistance in 

improving bandwidth management, increasing employee productivity and reducing legal liability 

associated with undesirable Internet content access. 

Labris UTM is available for Small Enterprises , Medium Enterprises as well as Large Enterprises 

Labris UTM Web Security provides further control to block inappropriate and illegal web sites as 

well as instant messaging and peer-to-peer applications while Labris UTM Application 

Intelligence and Control broadens control over inefficient web applications such as social media 

platforms (Facebook, twitter, etc.), online trading, IM/chat, peer-to-peer sharing and streaming 

video sites. Labris Email Security completes the offering with effective protection against spam 

and phishing attacks so employees only read legitimate emails and are not exposed to fake 

emails. Labris UTM’s intelligent solutions simplify the centralized management of local and 

remote network services while protecting your precious information and communications 

resources with low TCO. 

6. How to Purchase LABRIS UTM ? 

To purchase LABRIS UTM, Visit - http://labrisnetworks.com/products/product/lbrutm-series-

appliances/  

You can purchase through authorized distributors http://labrisnetworks.com/authorized-

distributors/ 

 

 

 

 

 

 

http://labrisnetworks.com/products/product/lbrutm-series-appliances/
http://labrisnetworks.com/products/product/lbrutm-series-appliances/
http://labrisnetworks.com/authorized-distributors/
http://labrisnetworks.com/authorized-distributors/
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7. LABRIS UTM Appliance deployment Architecture 

This section provides information about the logical and physical design for the prescribed 

deployment architecture. LABRIS UTM Appliance deployment architecture consists of software 

processes called servers, topological units referenced as nodes and the security device known as 

Labris UTM. In the below deployment architecture, all the Servers and LAN users are connected 

to the Labris UTM through L2 switches. Labris UTM Appliance is connected to external network 

through Router. 

 

 

8. Connecting Appliance 

Connect appliance to a management computer’s Ethernet interface. You can use a cross-over 

Ethernet cable to connect directly or use straight-through Ethernet cable to connect through the 

hub or switch. Both the cables are provided along with the appliance. Connect Ethernet cable 

one end to Labris UTM device in eth0 and other end to computer. 

 

 

•Labris UTM Device will provide default IP addressNote
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9. Accessing the Web Admin Console 
Labris Default Management Port = eth0/Port1/Net0/Mgt (first port to device) 

Labris Default IP Address: 169.254.1.1 

Labris Default Username: admin 

Labris Default Password:labris 

Connect your computer to the first port on the Labris and then open computer's network settings 

section and assign IP address 169.254.1.2 and subnet 255.255.0.0. Open your browser and 

browse https://169.254.1.1:81(Here IP address is the IP address of your device) to access LABRIS 

UTM Web Console (GUI). Login page is displayed and you are prompted to enter login 

credentials. Use default username andpassword to log on. 

 

10. LRMS into the LABRIS UTM Appliance 

LRMS – Labris Report and Monitoring Service 

Once you set and install LABRIS UTM Appliance properly this is how you will login in to the 

LABRIS UTM Appliance 

It has a login screen as well as languages selection screen  

 

These are the inputs for LABRIS UTM Login screen 

•Latest versions of Browsers like Internet Explorer or Mozilla Firefox are required 
to access web Admin ConsoleNote

1 Username Type in your valid Default username.This username 
is the one which you have given during the 
installation 

2 Password Type in your valid Default password. This password 
is the one which you have given during the 
installation.A good password is a mix of alphabets 
, numericals , special characters with a minimum 
length of 8  

3 Warm Me Warm Me before logging me into other sites. 

4 Clear Clear all Input 

5 Login Click on “Login” button to login to your appliance 

6 Languages Select your prefered language before logging into 
your appliance .Currently available languages are 
English and Turkish 

https://169.254.1.1:81/
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•You can also change your prefered language even after you login to the appliance 
as shown in following imageNote



 
 

17 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

Understanding your landing page or home screen 

In this section you will understand various sections of LABRIS UTM appliance’s home screen 

after the initial login.   

 

1 Page Header 
Section 

In this section, you will find links to LMC, Logview, Visibility, Wizard, Authentication and Settings 
toggle, Help and Logout. Notice the right hand top corner for Help and Logout. 

2 Main 
Dashboard 

After the initial login, you will be landed on to your Labris Security Gateway Software Dashboard. 
Main dashboard will show you System Information and various historical & real time statistics. 

3 Navigation You can navigate to various sections such as. In addition to these you will also find options to change 
your preferred language. 

 

On Dashboard, You will find widgets such as System Information, Network Interfaces, 

Resources, Protection Information, Application Data and Signature Databases. 
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1 System 
Information 

System Information field in the dashboard displays information on the No.of users , 
Host Name , Labris Version , System Time and Uptime 

2 Resources Resources field displays information on resources(Processors , Memory , Disk) and 
their utilization levels with diagrams which makes us to understand easily. 

3 Signature 
Databases 

Signature Databases displays information which is related to the UTM device 

4 Network Interfaces Network Interfaces field displays information like Ip Address , NetMask , Status and 
Error Information. We can also find a chart which gives pictorical representation of 
the Ethernet utilization. 

5 Accept-Deny Data Accept-Deny Data witget summarizes Accepted and Denied traffics count by a single 
date from Firewall(Network) and Webfilter(Access) data. 

6 Protection 
Information 

Protection field displays information related to the virus / spams caught and also the 
No.of websites blocked and Attacks prevented. 

7 Application Data Application Data widget shows a treemap graph for most used application along the 
whole network. 

 

How to Pop-in/out and Maximize/Minimize widgets on the Main Dashboard 

You can pop-out/in and maximize/minimize these widgets on the main dashboard by clicking 

icons which, are shown as below based on your need.  
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Wizard Installation  

 

Installation wizard enables simple configuration of Labris UTM products by users in just a few 

steps. Installation wizard can be accessed via product’s web interface. The wizard is fixed at the 

top right corner of the web interface.  

 

 

Pop-out/in 
Maximize / Minimize 
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11. How to use Wizard Installation? 

 

The product configuration can be started by clicking the Wizard icon on the web interface. The 

product configuration can be made in five steps in total. 

1. Hostname and Gateway Mode Configuration 

a. Gateway Mode Network Configuration 

i. Network Configuration for LAN  or DMZ 

1. Network Configuration for HotSpot and Web Filter on the LAN or 

DMZ interface 

ii. Network Configuration for IP Type DHCP 

iii. Network Configuration for IP Type Static 

iv. Network Configuration for IP Type PPPoE 

b. DNS Configuration 

c. DHCP Server Configuration 

2. Hostname and Bridge Mode Configuration 

a. Bridge Mode Network Configuration 

 

1. Hostname and Gateway Mode Configuration 

Configure as Gateway if you want to use Labris UTM as 

 A firewall or replace an existing Firewall 

 A gateway for routing traffic 

 Link load balancer and implement gateway failover functionality 

Apart from configuration Gateway IP address (IP address through which all the traffic will be 

routed), you must also configure LAN and WAN IP addresses. 
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Hostname and Working Mode; 

 

 

1 Hostname Device Hostname 

2 Working Mode Select a Working Mode. Gateway or Bridge 

3 Back The Back Step Now 

4 Next The Next Step Now 

5 Apply & Next Apply Changes and goto Next Step 

6 Jump to Selected Section Connect The Desired Step 
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12. A – Gateway Mode Network Configuration 

 

This is the section where the hostname and working mode settings of the device can be 

made. 

 

i - Network Configuration for LAN or DMZ; 

 

1 Interface Select Interface 

2 Interface Type Select Network Type for WAN,LAN or DMZ 

3 Interface Name Name for Network 

4 NAT Network Address Translate ON or OFF 

 

ii - Network Configuration for IP Type DHCP; 

 

6 IP Type Select IP Type for DHCP, Static or PPPoE 

7 IP Address IP Address for Network LAN,WAN or DMZ  

8 Netmask Netmask for Network LAN,WAN or DMZ 

9 Default Gateway Gateway for Network WAN 

 

iii - Network Configuration for IP Type Static 

 

6 IP Type Select IP Type for DHCP, Static or PPPoE 

7 IP Address IP Address for Network LAN,WAN or DMZ  

8 Netmask Netmask for Network LAN,WAN or DMZ 

9 Default Gateway Gateway for Network WAN 
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10 VLAN VLAN ON or OFF for Network 

11 VLAN ID ID for VLAN 

 

iv - Network Configuration for IP Type PPPoE 

 

6 IP Type Select IP Type for DHCP, Static or PPPoE 

7 IP Address IP Address for Network LAN,WAN or DMZ  

8 Netmask Netmask for Network LAN,WAN or DMZ 

9 Default Gateway Gateway for Network WAN 

10 DSL Username Username for DSL Authentication 

11 DSL Password Password for DSL Authentication 

12 Verify DSL Password Again Password for DSL Authentication 

 

1 - Network Configuration for HotSpot and Web Filter on the LAN or DMZ interface; 

 

13 WAUTH Wireless Authentication enable or disable for Network LAN or DMZ 

14 WAUTH SSL Connection Connect with SSL on the WAUTH Management Page  

15 HTTP Filtering Web Filtering enable or disable HTTP Protocol for Network LAN or 
DMZ 

16 HTTPS Filtering Web Filtering enable or disable HTTPS Protocol  for  Network LAN 
or DMZ 
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13. B - DNS Configuration 

 

This is the section where DNS IP address settings can be made. 

 

 

1 DNS 1 IP First DNS Server for IP Address 

2 DNS 2 IP Second DNS Server for IP Address 

3 DNS 3 IP Third DNS Server for IP Address 

4 Internal DNS Domain Name Internal DNS Server Domain Name 

5 Time Zone Select a Time Zone 

 

14. C - DHCP Configuration 

 

This is the section where we can activate or deactivate DHCP server in which the 

interface and IP settings of the IP addresses to be distributed to our DHCP Local users, 

are made. 

DHCP OFF 

 

1 DHCP Server for LAN Select DHCP Server Active or Passive 

2 DHCP Interface Interface list for DHCP Server or Relay 

 

DHCP ON 
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1 DHCP Server for LAN Select DHCP Server Active or Passive 

2 DHCP Interface Select DHCP Interface 

3 DHCP IP Start DHCP IP Start Address 

4 DHCP IP End DHCP IP End Address 

5 DHCP Netmask Netmask for IP Address 

6 DHCP Gateway Gateway IP Address for Client s 

7 DNS 1 IP First DNS IP Address for Clients 

8 DNS 2 IP Second DNS IP Address for Clients 

 

 

2. Hostname and Bridge Mode Configuration 

Configure as Bridge if 

 You have a private network behind an existing firewall or behind a router and you do 

not want to replace the firewall. 

 You are already masquerading outgoing traffic. 

 

A - Bridge Mode Network Configuration 
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1 Hostname Device Hostname 

2 Working Mode Select a Working Mode. Gateway or Bridge 

3 Back The Back Step Now 

4 Next The Next Step Now 

5 Apply & Next Apply Changes and goto Next Step 

 

 

1 Bridge Name Name for Bridge 

2 Left Bridge Interface Select Bridge Interface for Left 

3 Right Bridge Select Bridge Interface for Right 

4 Bridge IP Bridge IP for Management 

5 Bridge Netmask Bridge IP Netmask for Management 

6 Submit Apply Changes 
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Accessing LABRIS UTM through LMC 

Click on LMC tab (Labris Management Console) from the Dashboard. 

 

 

After all the validation and verification, the following LMC screen appears.  

 

Now, we are ready to get connected to our appliance for further activities.  

 

 

 

 

LMC Interface 

This is the default LMC interface we get when we connect to the Labris Management Console 

•LMC requires JAVA addon. While opening the LMC, you will be offered certifcate 
and security related information. Please accept the information and proceed as 
appropriate

Note
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In Labris Management Console we will find three sections. 

Section 1 Menu Tab Menu Tab is a horizontal strip that contains lists of 
available menus  

Section 2 Module  Module Tab consists of three short cut icons for Change 
view, Add module, Delete Module  

Section 3 Server List Server List consists of list of servers added to LMC 

 

 

 

 

 

 

 

Menu 

A Menu Tab is a region of a screen or application interface where drop down menus are 

displayed. A Menu tab is an integral graphical user interface (GUI) component in LMC. 

In Menu Tab we will find Device, File Menu, Edit Menu, View Menu and About Menu. 
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Brief Summary about each of the parameters in Menu tab: 

1 Device Device helps  to manage the server with different options 

 
2 

 
File Menu 

File Menu offers commands for closing windows and exiting 
the current program. It contains commands relating to the 
handling of files, such as New, open, save, exit 

3 Edit Menu Edit Menu consists of LMC options and Certificates. We can 
manage Certificates by using this Menu 

4 View Menu View Menu provides two different options like Sort and GUI 
templates to view the content in different modes 

5 About About Menu gives information about LMC 

 

 

File Menu 

File Menu enables us to connect to new LMC, Open a file, save a file and Exit from the LMC 

Under File Menu we find the following options  

1 New This  option enables to connect to the New LMC  

2 Open This option enables to open an existing document which 
is located in the local machine 

3 Save This option enables  to save the contents of a Files 

4 Exit This option enables to close and exit from the LMC 

 

To open New Labris management console 

1. Go to File>New 

2. New Options helps us to connect to the New Labris Management Console (LMC). 

When we click on New the following screen appears. 
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Opening an existing file using LMC 

1. Go to File>Open 

2. Using Open option we can open an existing file in LMC 

 

 

3. Browse the path of the file, Select the File and click Ok 

 

Saving the files in LMC 
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1. Go to File>Save 

 

 
 

2. Using Save option we can save the files in LMC  

       

 

Exiting from LMC console  

1. Go to File>Exit 

2. When we click on Exit it prompts us with a message “Do you really want to exit?” 

3. Click on “Yes” to exit,  or click on “No” to remain in the same LMC 

 

           
 

Edit Menu 

Edit Menu helps us to manage LMC options like change of Language (English & Turkish), 

settings etc. Certificate details can also be viewed and managed from Edit Menu 

Under Edit Menu we find the following options 

1 Options This option helps us manage LMC options 

2 Certificates This option helps us to View details and manage 
certificates in LMC  

 

Editing options in LMC 

1. Go to Edit>Options 
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2. Using Options we can view settings and select interface language in LMC and click “Ok” to 

apply settings. 

1 View settings View Settings consists of show button bar and 
open module list on start. Choose appropriate 
option  

2 Language 
options 

This option enables us to choose preferred 
language either English or Turkish 

3 OK Select OK  to apply the settings 

4 Cancel Select Cancel if we don’t want to apply these 
settings 

5 Help Help options gives the related information 
about LMC options. It provides online help. 
 

 

 

 

Certificates details in LMC  

1. Go to Edit>Certificates 

2. When we click on “Certificates” the Certificate manager console gets opened, where we  

can manage the Certificate using options like Delete, View Details, Close, Help 
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3. If we want to view the certificate details click on “View Details”. A screen appears as below 

with all necessary details of the certificate 

1  Delete Delete options helps us to delete the 
selected certificate from LMC 

2  Close Close option helps us to close the 
Certificate manager window 

3  Help Help Options gives information about the 
certificates and its related options 
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1 View public Key This option helps us to view the public key 

2 Cancel This option helps us to close the Certificate details window 

 

View Menu 

 

View Menu is one of the option in Menu Tab. View Menu helps us to view the contents in 

different modes depending on the options available in LMC. 

Under View Menu we find the following options 

1 Sort This option helps to sort by server or 
module 

2 GUI Templates This option helps to change the view of 
LMC to Aero mode or MacWin mode 

 

Sorting Labris management console 

1. Go to View>Sort> By Server 

 
 

2. When we sort By Module the view of the LMC appears as below 



 
 

35 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 

1. Go to View>Sort> BY Module 

2. When we sort by module the view of the LMC changes as below 

 
 

View using GUI Templates option in Aero Mode 

 

1. Go to View>GUI Templates> Aero 

2. When we click on Aero the view of the LMC appears as below 

 

View using GUI Templates option in MacWin Mode 

 

1. Go to View>GUI Templates>MacWin 

2. When we click on MacWin  the view of the LMC appears as below  

 

Device Menu 

Device Menu provides us with different options like Add, Remove, Connect, Disconnect server 

from LMC. We can manage the server using the options in Device Menu 
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Under Device Menu we find the following options 

1 Add Server This option helps  to Add server to the LMC 

2 Remove Server This option helps us to Remove server from the LMC 

3 Connect This option helps to Connect the server to the LMC 

4 Disconnect This option helps to Disconnect the server from LMC 

Add Modules from Server Menu 

To manage and configure the appliances we will add Server to the LMC. 

1. Go to Device>Add server 

 

 

 

 

After clicking on the “Add Server”,  you will see the “Add Devices from Server” menu. .  

Type in the appropriate Default Username and Default Password and click on 

“Authenticate” button. 

Notice & verify your appliance’s IP address in the “Add Devices from Server” menu and 

click on the “Login” button as shown below 

•We can even choose a short cut icon under Module to Add server   Note
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2. After successful authentication process, you will notice your new appliance 

appearing on LMC’s Server list as shown in the following images.   
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User Management 

User Management system providing administrators with the ability to effectively manage users 

on the network. It is an authentication feature that provides administrators with the ability to 

identify and control the state of users logged into the network. 

It is not limited to, the ability to query and filter users that are currently logged into the 

network, but also manually log out users, and control users login counts and login times. 

 

Viewing Options in User Management 

When we Right click on “User Management Tab” we find following options 

1 Connect It enables  Users, Groups & WAUTH to connect 
to the LMC  

2 Disconnect It enables Users, Groups & WAUTH to 
disconnect from LMC  

3 Properties It helps us to view properties of User 
Management in LMC 

 

15. Users 

Users Tab in LMC enables us to Add new User, Edit existing Users, Delete User in User 

Management Section in LMC. 

When we click on Users tab all the existing Users are displayed with fields User Name, Name 

Surname, Source, Domain, Global and Note 

Adding User 

Add tab in user management helps us to Add a new user to the LMC Appliance 

Click on Add tab to add a New User 
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These are the inputs for adding New User 

1 User Name Type the name of the new User 

2 Name 
Surname 

Type the Surname of the new User 

3 Password Type Password of the new User s 

4 Password 
Again 

Re type the same Password for confirmation 

5 Domain By default Slave is being selected in Domain 

6 Global It is deemed central management. In the case of the device is the 
same as the firm’s global projects marking more than one user is 
deemed to be used every time a user was created in the location is 
achievable UTM device. 

7 Comment Type reason for the User creation (Optional) 

8 Select Group You can make a user, member of a group 

9 Select Quota 
Policy 

You can choose a quota policy for user 
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Global, Comment and Select Group fields can be selected according to the User requirement 

and click on OK to apply these settings.  

 

Type the name of the User in the Filter Tab to check whether the user is added to the list or 

not. If the user is not added click on Refresh Tab 

 

 

Below screen appears stating that it takes some time to Refresh, click OK to continue the 

Refresh process 
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After completing Refresh process type the name of the User in the Filter tab, then you can 

notice the New User displaying in the User’s list 

 

Deleting User 

Delete Tab in user management helps us to delete the user permanently from the LMC 

Appliance 

 Type the name of the User which you want to delete in the Filter tab, Select the User and click 

on Delete Tab 

 

 

Then the below screen appears, Click OK to delete a User in User Management in LMC 

 

It takes some time to Delete an User from User’s list 
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Below screen gives information that the selected User is deleted successfully. Click OK 

 

 

 

Changing password / Editing User 

Select a User from the User’s list and click on 

Edit Tab 

 

 

Edit option helps us to change the password of the existing User and edit the comment. 
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1 Password Type new Password of the User 

2 Password 
Again 

Re Type new Password again for confirmation  

3 Comment Type reason for the User creation (Optional) 

 

Click OK to apply these settings. 

 

 

 

 

 

 

16. Groups  

Groups permit us to easily assign to all members of a group abilities in a space that are 

specified to that Group. After creating a Group we are able to manage its membership by 

adding or deleting Users to that Group. All the created Users may be a member of any Group 

with Guest abilities. We can have same Users in multiple Groups. 

Groups Tab in LMC enables us to Add New Group, Edit existing Groups, Delete Groups in User 

Management Section in LMC. 

When we click on Groups Tab all the existing groups are displayed with the fields Group Name, 

Source, Domain. 

 

Adding Group 
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Click on Add Tab to add New Group to the Groups in User Management 

 

Below screen appears with Group Name & Group Configuration. 

 

 

Group Name consists of two fields Group Name & Domain. 

1 Group Name Type name of the New Group 

2 Domain In this field   slave  is selected by default 

 

Group Configuration consists of two fields All Users and Groups and Group Components. 

1 All Users and 
Groups 

All the users and groups are displayed in this 
field 

2 Group 
Components 

Users in specific Group are displayed in this 
field 

3 

 

Click this icon to add Users in to Group 
Components 
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4 

 

Click this icon to delete Users from the 
Group Components 

 

Click OK to add New Group to the Group’s list. 

 

 

 

It takes some time to apply changes. 

 

 

Type the New Group name in the Filter tab and click Refresh to find out the New Group in the 

Group’s list is added or not. 
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Now you can notice the newly added Group in the Group’s list.  Right click on the Group and 

select Show Group. 

 

When you click on Show Group, Users in that group are displayed. Click OK to close the current 

tab. 
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Deleting Group 

Select the Group from the Group’s list and click on Delete Tab. 

 

 Warning screen is displayed; Click OK to delete a Group from the LMC. 

 

Deleting process is in progress. 

 

Below screen appears stating that the selected Group is Deleted successfully & click OK to close 

the current tab 
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Editing Group 

Select the Group which you want to edit from the list and click on Edit Tab. 

 

 

Select the User from the Group components list and click on the icon 1to remove User from the 

Group Components and click OK 

Select the User from All Users and Groups field and click on the icon 2 to add Users in to Group 

Components list and click OK 

 

 

It takes some time to apply the changes. 
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To notice changes made to the Group right click on the User and select Show Group 

 

Then information about Group Components are displayed and click OK to close the current tab. 

 

17. Identity Integration 

Identity Integration Tab in LMC enables us to Add new Identity, Edit existing Identities, Delete 

Identity in User Management Section in LMC. 

When we click on Identity Integration tab all the existing Identity Integrations are displayed 

with fields Name, Domain Name, Hostname, Server IP, Type. 
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Adding Identity 

Add tab in identity integration helps us to Add a new integration to the LMC Appliance 

Click on Add tab to add a New Identity Integration. 

 

 

 

You can type credentials and test without integration using Test button below.  
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These are the inputs for New Integration: 

1 Name Unique name for integration 
2 Type Server configuration type 
3 Domain Name Domain Name  
4 Hostname Hostname of Server  
5 Server IP IP Address of Server 
6 Workgroup Workgroup of User 
7 User Username  
8 Password Password 
9 Port Connection port  
10 Search Base Starting point for the search instead of the default 
11 Filter Conditions for entries 

 

If credentials are correct, you can see queried users. Using Filter button, you can filter queried 

users. 
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After writing necessary configurations, you can add integration with the Add button below. 

 

 

Editing Identity 
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A previously added Integration can be edited by choosing it and clicking the Edit Button.  

 

 

Deleting Identity 

Select the Integration from the Integrations list and click on Delete Tab. 

 

 

 

Warning will be shown after clicking delete button.  

 

 

If you press OK progress bar will be shown. This might take some time. 

 

 

Advanced Options for Identity Integration 
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Port: Port number between 0-65535 which will be used to connect to the server. Default value 

is 0 which is actually translated into default port of Server. 

Search base: The starting point for the search of the users and groups. If it is empty, default 

search base which consists of domain name will be used. If not, it is concatenated to the 

default search base.  

For example if "OU=Ankara" is written on the search base and domain name is 

"example.com", it will be translated into "OU=Ankara, DC=example, DC=com". 

Filter: Conditions for searching users and groups which should conform to the string 

representation for search filters as defined in RFC 4515.  

For example: "&(objectClass=Person)(primaryGroupId=513)". 

 

Other Options in User Management 

Right click on the User Management and select Properties. 
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All the properties of the module are displayed in this screen. 

Click Close to move out of this tab. 

 

Give right click on the User Management Tab and select 

Disconnect to disconnect from the User Management. 

 

WAUTH 
 

WAuth is the module used for user authentication and guest authentication. WAuth is enabled by 

interface and supports specific exceptions. 

WAuth (Wireless Authentication) in LMC enables us to Add New WAuth Interface, Edit 

existing WAuth Interface, and Delete WAuth Interface in User Management Section in LMC. 

Your device configuration for WAUTH  

First Step: 

Add a separate Network for WAuth in the Network settings module. Select Network settings for 

selected interface. 

Choose the interface you want to choose for enabling WAuth.  
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 Edit Interface IP address or Name; 

 

Second Step: 

Create a DHCP Server for WAUTH; 

Click for DHCP configuration. 

 
Third Step: 

Create a Network object in firewall for WAUTH host and Network WAUTH_Net. (For Creating 

Network Object, please refer to Hosts under Network Objects section in Make a new Firewall 

object) 
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Fourth Step: 

Add a policy (For Creating a new policy firewall object please refer to Labris Firewall 

Management) 

 

 

Fifth Step: 

Enable Wauth for the selected interface by configuring in interface WAUTH tab in Firewall 
module.  
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Sixth Step: 

Add a user for WAUTH.  

Click for User Management. 

  

Configuring WAUTH policy 

Click on Add Tab to add Interface to the WAUTH in User Management. 

 

 

Below screen appears. 
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These are the inputs for the Authentication Policy. 

 

1 Active Enable this option to activate the interface 

2 Policy  Choose required Policy 

3 Interface Choose interface from the drop down list 

4 Name Type name of the Interface 

5 Type Choose type of Interface from drop down list 

6 IP Address Give the IP Address 

7 Statement Type the Statement if any required (Optional) 

 

Click Ok. 

Notice Interface added to the WAUTH in the below screen. 

 

Deleting WAUTH policy 

Select the Interface from the WAUTH list and click on Delete Tab 
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Warning screen is displayed, Click OK to delete the Interface  

 

 

Deleting process is in progress. 

 

 

Below screen appears stating that Deleted successfully & click OK to close the current tab. 

 

 

Editing WAUTH Policy 

 

Select the Group which you want to edit from the list and click on Edit Tab. 
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We can edit any of the fields in the Authentication policy. 

 

Click Ok. 

 

Adding WAUTH Authentication and User 

 

 

Click on WAUTH tab from the dashboard and select Settings 

 

Subnet Rules 

Select Subnet Rules tab to view and change Subnet Rule specific settings. You can use subnet 

rules to enable/disable specific settings for specific networks. To illustrate, your internal 

network may not offer any sign up methods in Wauth Welcome screen but your guest network 

may offer TCKN Sign Up method. You can also set how the login screen should look using for 

different networks (different Company Logo's etc.). Combined with Access Control List (ACL) 

you can allow only specific users/groups to login from your internal network. 

Note: Subnet independent configurations (like Hotel and AD configuration). Should be made on 

Default subnet rule. 
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Subnet Rules - Adding New Subnet Rule 

 

Subnet Rules - Editing Subnet Rule 

 

 

1 Setting Rule Current subnet rule choice. This affects all configuration data in 
all tabs (General, UI, ACL) 

2 Rule Name Name of this subnet rule 
3 Subnet List Comma separated list of networks that this subnet rule should 

apply to. 
4 Save Save changes to subnet rule. 
5 Delete Delete this subnet rule. 

Warning: This also deletes all configuration choices for this rule 
on other tabs (General, UI, TCKN, SMS, ACL etc.) 

 

Subnet Rules - Default 
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Default subnet rule can't be deleted and its networks can't be edited. This ensures that if no 

other subnet rules matches the user, Default subnet rule will be applied for user. 

 

 

General Settings 

Select General tab to view and change the General settings. 

Authentication methods in WAUTH is configured in General tab. 

 

Common Key: 

Common key provides an effective mechanism to prevent unauthorized users from registering. 

During registration, user must provide the common key if authentication method requires it. 

Example scenario:  

TCKN Wauth with common key (Assuming TCKN Wauth is already configured) 

 In General tab; 

o Set CK Option to Manual. 

o Set Common Key to the desired value. 

o Click Save. 

 In TCKN Wauth tab: 

o Activate common key 

You can also set CK Option to Automatic and provide a CK period. If you do this, common key 

will be changed at the end of this period automatically. 

If you want unauthorized users (users who cannot login to web admin panel) to view common 

key, you can set a username and password for this. 

 Set CK Username and CK Password values. 
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 For wauth listening ip 192.168.0.1, as unauthorized user go to: 

192.168.0.1:85/wauth/show_ck/ 

 Enter values from CK Username and CK Password. 

 Current common key will be shown. 

 

Important Note: Common keys are different for each subnet rule. If you have multiple subnet 

rules, you should provide matching subnet rule's CK Username and CK Password. Otherwise 

you will get an error. 
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These are the inputs for the General Settings. 

1 Welcome message Welcome message is displayed in Turkish 

2 Welcome message (EN) Welcome message is displayed in English 

3 Local Authent format Choose Authentication format from the drop down list 

4 SMS Wauth We can enable or disable this option 

5 Active Directory Authent We can enable or disable this option 

6 Hotel Integration We can enable or disable this option 

7 TC Identity NVI 
Confirmation 

We can enable or disable option 

8 Passport Wauth We can enable or disable option 
9 Agreement We can enable or disable this option 

10 Agreement [TR] This option displays information regarding agreement in Turkish. 

11 Agreement (EN) This option displays information regarding agreement in english 

12 Time out We can enable or disable this option 

13 Time period Mention time period in minutes 

14 Authentication Type Choose Authentication type from the drop down list 

15 Ingress session We can enable or disable this option 

16 Reference Emails/Domains We can add or delete reference emails/domains from this field 
17 Reference Timeout We can set reference email timeout (seconds) 
18 Smtp Server Address We can set smtp server address 
19 Smtp Mode We can choose smtp mode (TLS, SSL, Normal) 
20 Smtp Port We can set port number for smtp protocol 
21 Smtp Username We can set username for smtp server 
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22 Smtp Password We can set password for smtp server 
23 Smtp Mail From We can set mail from field in sent mail 
24 CK Option Common key will be set manually or generated automatically. 
25 CK Period Common key regeneration period when common key is 

generated automatically. 
26 Common Key Current common key (will be regenerated on save if it's 

automatically generated) 
27 CK Username Username to get current common key for unprivileged user 
28 CK Password Password to get current common key for unprivileged user 
29 CK Instructions Instructions to show user on sign-up screen. 
30 CK Instructions (EN) Instructions to show user on sign-up screen (english) 

 

Click on Save to save the changes 

Settings of Hotel Authentication 

Select Hotel tab 

 

These are the inputs for the Hotel Authentication. 

1 Default Select User Group 

2 Hotel Name Type the Name of the Hotel 

3 Product type Choose product type 

4 MAC Address Type MAC Address (optional)  
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5 Machine Port Type Machine port (optional)  

6 Real Name Type the name of the Database 

7 Real Name  Type the name of the table (optional) 

8 User Name Type the Username 

9 Password Type the password 

10 User Name Field Name Type Username Field Name (optional) 

11 Password Field Name Type Password Field Name (optional) 

12 Name Field Name Type Name of the Field Name (optional) 

13 Surname Field Name Type Surname of the Field Name (optional) 

14 Departure Date Mention Departure Date (optional) 

15 Timeout Mention Timeout in minutes 

16 Infinite timeout We can enable or disable this option  

17 Multiple Login We can enable or disable this option 

 

Click on Test to test the details and then select save to save the changes 

Settings of SMS Authentication 

Select SMS Authentication 

These are the inputs for the SMS Authentication. 
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1 Default Group Users authenticated with SMS will be a member of 
this group. 

2 Multiple Login SMS users will be allowed to login from different 
devices simultaneously.  

3 Account Quota Account Quota 

4 Account Expr. Date Users authenticated with SMS will be expired after 
this period of time. 

5 Timeout Mention Timeout Period 

6 Cust. Serv. Tel Type Customer Service Telephone number 

7 Comp. Mobile  Type Company Mobile Name 

8 Cust. Serv. Email Type Customer Service Email address 

9 Help page for SMS 
authentication 

Show a help page to user for SMS authentication. 

10 Title of SMS auth. help 
page 

Title of SMS authentication help page 

11 Subtitle of SMS auth. 
help page 

Subtitle of SMS authentication help page 

12 Message of SMS auth. 
help page 

Message to show in SMS authentication help page 

13 Enable Common Key Require common key for new user sign-up. 
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14 SMS sending will be 
afforded by the company 

Cost of SMS sending will be afforded by the host. 

15 Use Custom SMS Api Use another SMS sending API. You need to configure 
this API via "Custom SMS Service Configuration" 
button 

16 Remained Token If SMS sending cost will be afforded by company and 
custom SMS API isn't used, these tokens will be used 
for new registrations. 

17 Custom SMS Service 
Configuration 

Configure custom (third-part) SMS service API. 

18 Buy Tokens Open token purchase page. 

19 Show Common Key Show common key query webpage. 

20 Save Save changes 

 

Click on Buy tokens and select Save to save the changes. 

 

Active Directory Authentication 

Select AD (Active Directory tab)  

Domain name and authenticating account information configuration is done in this tab.  

 

These are the inputs for Active directory Authentication. 

1 AD Domain Name Type Active Directory Domain Name 

2 Disable Group Name Choose this option to Disable Group Name 

3 AD Work Group  Type Active Directory Work Group Name 



 
 

72 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

4 AD Group Name Type Active Directory  Group Name 

5 AD Timeout Mention  Active Directory  Timeout period 

6 Infinite Timeout We can enable or disable this option 

7 AD Quota Mention time period of Active Directory  Quota 

8 Infinite Quota We can enable or disable this option 

9 AD Expire Date Mention time period of Active Directory  Expire Date 

10 Infinite Expr time We can enable or disable this option 

 

 

User Interface Customization 

Select UI (Active Directory tab)  

UI tab is used for customization of guest and user welcome screens.  
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1 Logo Add a company logo 

2 Delete Logo Delete default logo 

3 Logo URL Add a company logo on the web 

4 Background Image Add a image for background 

5 Delete Background Image Delete default background image 

6 Background Image 
Position 

Select position for background image 

7 Background Image 
Repetition 

Select repetition for background image 

8 Page Title Page Title Instructions is displayed in Turkish 

9 Page Title-Eng Page Title Instructions is displayed in English 

10 Login Page Header Login Page Header Instructions is displayed in 
Turkish 

11 Login Page Header-Eng Login Page Header Instructions is displayed in 
English 

12 Login Page Footer Login Page Footer Instructions is displayed in 
Turkish 

13 Login Page Footer-Eng Login Page Footer Instructions is displayed in 
English 

14 Username Caption Username Instructions is displayed in Turkish 

15 Username Caption-Eng Username Instructions is displayed in English 

16 Password Caption Password Instructions is displayed in Turkish 

17 Password Caption-Eng Password Instructions is displayed in English 

18 Login Button Caption Login Button Caption Instructions is displayed in 
Turkish 

19 Login Button Caption-Eng Login Button Caption Instructions is displayed in 
English 

20 Logout Button Caption Logout Button Caption Instructions is displayed in 
Turkish 

21 Logout Button Caption-
Eng 

Logout Button Caption Instructions is displayed in 
English 

22 Background Color Select Background 

23 Header/Footer Font Color Select Header/Footer font color 

24 Page Title Background 
Color 

Select Page Title background color 

25 Page Title Font Color Select Page Title font color 

26 Default Domain Choice Select default domain choice for login screen 

 

Turkish Citizen ID Number Authentication 

Select TCKN Wauth tab (Turkish Citizen ID Number Tab)  

You can set configuration options for Turkish Citizen ID Number authentication method in this 

tab. 
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1 Default Group Users signed up with this method will be a member of this group 
2 Multiple Login TCKN users will be allowed to login from different devices 

simultaneously.  
3 Infinite Quota We can set enable or disable infinite quota 
4 Account Quota We can set time quota for user 
5 Infinite Account We can set enable or disable infinite account time 
6 Timeout We can set time for login time 
7 Account Expiration Date Users authenticated with SMS will be expired after this period of 

time. 
8 Cust. Serv. Tel Type customer service telephone number 
9 Cust. Serv. Mail Type customer service mail 
10 Reference Approval We can enable or disable reference approval 
11 Request Mobile Number We can require user's gsm no with this field. 
12 Use GSM Number for 

Username 
Checking this option will generate username from gsm no 
(instead of TCKN) 

13 Send Password With SMS Activating this will generate a random password for user and 
send it to user's mobile phone. 

14 Enable Common Key Require Common Key for new users. 
15 Show Common Key Show common key query webpage. 
16 Save Save changes. 

 

Passport Number Authentication 

Select Passport Wauth tab (Turkish Citizen ID Number Tab)  

You can set configuration options for Passport Number authentication method in this tab. 
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1 Default Group Users signed up with this method will be a member of this group. 
2 Multiple Login Passport users will be allowed to login from different devices 

simultaneously. 
3 Infinite Quota We can enable or disable infinite quota 
4 Account Quota We can set time quota for user 
5 Infinite Account We can set enable or disable infinite account time 
6 Timeout We can set time for login time 
7 Account Expiration Date Users authenticated with SMS will be expired after this period of 

time. 
8 Cust. Serv. Tel Type customer service telephone number 
9 Cust. Serv. Mail Type customer service mail 
10 Reference Approval We can enable or disable reference approval 
11 Request Mobile Number We can require user's gsm no with this field. 
12 Use GSM Number for 

Username 
Checking this option will generate username from GSM No 
(instead of Passport No) 

13 Send Password With SMS Activating this will generate a random password for user and 
send it to user's mobile phone. 

14 Enable Common Key Require Common Key for new users. 
20 Show Common Key Show common key query webpage. 
21 Save Save changes. 

 

Access Control List 
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Select which users/groups/ip's are allowed to (or not allowed to) login Wauth.

 

1 Ip Addresses Comma separated list of ips 
2 Rule choice Allow or deny these ip's, users  and groups 
3 Select Members Choose users to apply this rule 
4 Select Member Groups Choose groups to apply this rule 
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Creating WAUTH User 

User for WAUTH may be created in two ways. First is LMC. Local users can be created in LMC 

User Management module and directly be used in Wauth. Second is Wauth web based simple 

management screens. By Wauth web screen, one can create Wauth users. 

Select WAUTH tab from the dashboard and click on Create User tab 

 

These are the inputs to Create User. 

1 User Name Type name of the User 

2 Domain Choose Domain Name 

3 Group Select Group for User 

4 Real Name Type Real Name of the User 

5 Expiration Date Select Expiration Date and Time of the User 

6 Quota Mention Quota 

7 Infinite Quota We can enable or disable this option 

8 MAC Address 
(optional) 

Type MAC Address (optional) 

9 Allow multiple Logins We can enable or disable this option 

10 Notes Type any notes regarding User (optional) 

11 Password Type Password of the User 
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Online Users 

IP/MAC addresses and login time information is shown in Online Users screen. Also, this screen 

provides a function to disconnect the user. 

 

 
 

All Users ( User editing ) 

It is the screen that showing all users and information of users. Editing is easily done by clicking 

and opening Edit User window.  

 

Note: If a user is online and his account is deleted, the user will be disconnected. 

 

 
 

This edit window can also be used for just password changing without any account information 

editing. If you do not touch any field other than password, no other information will be 

changed except for password. In the same way, this editing window may be used for prolonging 

account lifetime. 
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1 User Name Show Username 

2 Real Name Edit Real Name 

3 Expiration Date Edit Expiration Date and Time of the User 

4 MAC Address Edit MAC Address 

5 Allow Multiple Login We can enable or disable this option 

6 Quota Edit Mention Quota 

7 Infinite Quota We can enable or disable this option 

8 Notes Type any notes regarding User (optional) 

9 Password Change User Password 

 

WAUTH Welcome Screen 

The guest or user is expected to authenticate him/herself to the system with given credential 

information, credential information they get through SMS messages, TCKN, Passport 

authentication. 

 

Also, the system provides function for authenticating users of Active Directory with their AD 

credentials. 

 

After account creation, user is expected to open an internet browser and will be welcomed 

with a welcome screen. Guest or user should enter the credentials on this stage. 

 

This welcome screen can be shown in different languages according to internet browser’s 

language settings. 
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For obtaining passwords, please follow next parts of the document. 

 

 

 

 
 

1 User Name Username Input 

2 Password Password Input 

3 Domain Select Domain Local or Domain Controller 

4 Login Login Button 

5 Sign Up Alternative Sign-up Methods 

6 Reset Password Reset forgot password 
 

Alternative Sign Up Methods 
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1 SMS Sign Up Sign up using mobile number 
2 TCKN Sign Up Sign up using your TC Identity Number 
3 Passport Sign Up Sign Up using passport number 

 

18. Login 

 

Post-entry Screen 
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1 Logout Logout Button 

2 Change Password Change Password Button 

 

19. Change User Password 

User can change his password with “Change Password” button and Change Password window shown. 
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1 Current Password User Old Password 

2 New Password User New Password 

3 Verify Password New Password Again 

20. Reset Password 
Users who signed up with TCKN or Passport Number may reset their forgot passport.  

 

Reset Password - Personal Info Validation Step 

In this step, user provides the same information during sign up. This fields will be checked against the 

previous information of user and if they match, user will be allowed to reset their password. 
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1 Name First Name 
2 Surname Last Name 
3 Year of Birth Year of birth 
4 E-Mail E-Mail 
5 TC Identity Code TC Identity Number 

 

Reset Password - Set new password step 



 
 

86 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 
 

1 New Password New password for user 
2 Confirm Password Confirm new password for user 

 

 

Reset Password - Password Changed Screen 

After completing all steps user will see the screen below. 
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21.  

SMS Sign Up 

22. Registering with SMS 

Click to “Obtain Password” button. If SMS authentication is disabled, obtain password choice will not be 

shown. For enabling SMS authentication, enable SMS Wauth in Wauth General Settings tab. 

 

GSM number and common key 

Common key is a security solution for preventing unwanted guests to use the corporation’s wifi guest 

internet access. This common key is enabled and set in SMSWauth screen. If CK is enabled, guest is 

wanted to enter it. 
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1 Mobile Number Mobile Telephone Number 

2 Common Key Company Common Key 
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23. TCKN Sign Up 

Users may sign up using their TC Identity Number. Validity of user-provided information (TC Identity 

Code, Name, Surname, Year of Birth) is checked against the records. 

 

1 TC Identity Code TC Identity Number of user 

2 Name Name of new user 

3 Surname Surname of new user 

4 Year of Birth Year of birth 

5 Mobile Number Only visible if Request Mobile Number is activated.  Will be used for 
sending password via sms if Send Password with Sms is activated. 

6 Reference Mail Mail of the person who will approve this new user. This fields is visible 
if Reference Approval is activated. Reference mail should be one of 
the mails or member of a domain configured in General Settings-
>Reference Emails/Domains. 

7 Common Key We can fill common key 

 

24. Passport Sign Up 

Users may sign up using their Passport Number.  
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1 Passport Number Passport number of new user. 

2 Name Name of new user 

3 Surname Surname of new user 

4 Year of Birth Year of birth 

5 Mobile Number Only visible if Request Mobile Number is activated.  Will be used for 
sending password via sms if Send Password with Sms is activated. 

6 Reference Mail Mail of the person who will approve this new user. This fields is visible 
if Reference Approval is activated. Reference mail should be one of 
the mails or member of a domain configured in General Settings-
>Reference Emails/Domains. 

7 Common Key We can fill common key 
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25. Quota 

Labris UTM can measure internet usage of users in terms of byte count and elapsed time. This 

functionality is provided by Quota module. In this section, all information required to configure quota 

settings and monitor quota usage of users is provided. Quota module measures all the traffic which 

passes over Labris UTM. This means if you have multiple internal networks, you can measure and limit 

traffic between internal networks also. 

Terminology 

In order to simplify configuration and enable advanced configuration options, administrator can define 

Quota Policies and Quota Exceptions and use any combination of them for different users or groups. 

Quota Policy 

A Quota Policy is a set of rules which defines how much a user or members of a group can use the 

internet in a period. 

Period: Defines when the usages will be cleared. In other words, it defines when the quota will be 

renewed. It’s useful if you want to set the limits daily, weekly, monthly, yearly. If you don’t want quota 

to reset and define final limits in the policy, you can choose non-periodic. 

Note: Periods are completed at the end of specified unit. For example, if a new policy is created with 1 

Month period on 15th November, usage will be reset on 30th November, not on 15th December. 

Surfing Time:  It allows limiting the quota by time. Time limit allows measuring surfing time of user and 

set limit for them. Surfing time is not measured directly, instead calculated by counting transferred 

bytes in the last minute. If user transferred at least 100 KB in the last minute, it is passed for a minute 

usage. This means minimum unit for surfing time is minute and for example ten seconds of usage may 

be calculated as one-minute usage.  

If period is set, this usage will be reset at the end of period. 

Data Quota: Download and upload limits can be defined here. 

Quota Exception: Multiple Quota Exceptions can be attached to the policy. Order is important. 

Quota Exception 

A Quota Exception is a rule to measure a specific usage pattern and define limit for this pattern. For 

example, you may have a generic quota policy with 5 GB download limit. If you have an ftp server 

outside of your internal network or in a separate network (e.g. DMZ) you may want to set a separate 

limit for transfers between users and ftp server. In this case you need to define an exception an attach 

this exception to your quota policy. 

Destination IP: Set the destination IP address for this exception. You may also specify a network in the 

CIDR form (e.g. 10.0.0.0/16). 

Destination Port: Set the destination port for this exception. You may specify a single port here. 

Different use cases are possible here. For example, you may skip defining destination IP and set 
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destination port as 22. This allows all SSH traffic to match this exception regardless of the destination IP 

address. 

Day of Week Range: Set a filter for week range.  

Time Range: Set when the exception will match during day. Again, different use cases are possible here. 

For example, you may want that FTP exception match only during work hours. In this case, you can set 

Day of Week Range to Monday-Friday and Time Range to 08:00:00-17:00:00. 

Creating a Simple Quota Policy with Single Quota Exception 

This is a simple scenario with general 5 GB download limit, 20 GB download exception for SSH and 20 

GB upload exception for SSH. SSH exception is defined for work hours. Both policy period and SSH 

exception period are set to one month. 

Quota Policy Creation 

This is the main screen of quota. By default, Quota Policies screen is open. You can add new policy, edit 

or delete existing policies here. Right sidebar allows hopping to other screens: Quota Exceptions, Quota 

Monitoring. 

Note: Do not forget pressing Save after adding/editing/deleting. Otherwise your changes will be lost. 
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No Name Description 

1 Add Policy Create a new quota policy 

2 Edit Policy Edit an existing quota policy 

3 Delete Policies Delete existing quota policy 

4 Quota Policies Open Quota Policies screen 

5 Quota Exceptions Open Quota Exceptions screen 

6 Quota Monitoring Open Quota Monitoring screen 

7 Refresh Refresh policies exceptions and monitoring data (unsaved changes will be lost) 

8 Save Save Quota Policies to UTM. Omitting save step will cause changes to be lost 

A Rule No Number of quota policy 

B Name Name of quota policy 

C Type Periodic or non-periodic 

D Period Show if policy is periodic 

E Data Quota Show data quota of policy 

F Time Quota Show time quota of policy 
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No Name Description 

1 Policy Name Name of the policy. This name will be used when assigning to 
users/groups. 

2 Periodic Usage will be zeroed at the end of period. 

3 Non-periodic Usage will not be reset. Limits are final. 

4 Period count Period count. 

5 Period unit Possible values are: Day, Week, Month, Year 

6 Unlimited surfing time Don’t set a limit for surfing time. Disables Hours and Minutes 
fields. 

7 Surfing Time Hour Limit Set how many hours a user is allowed to surf. Combination 
with minutes field is possible. 

8 Surfing Time Minute Limit Set how many minutes a user is allowed to surf. Combination 
with hours field is possible. 

9 Quota Download Limit Set how many megabytes a user is allowed to download.  

10 Unlimited Quota Download Don’t set a limit for download.  

11 Quota Upload Limit Set how many megabytes a user is allowed to upload. 

12 Unlimited Quota Upload Don’t set a limit for upload. 

13 Attach New Exception Attach an existing quota exception to this policy. 

14 Remove an Exception Remove an already attached quota exception from this policy. 

15 Move chosen exception up Move attached exception up in the order. 

16 Move chosen exception down Move attached exception down in the order. 

17 Add Complete policy creation 

18 Cancel  Cancel policy creation 
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Quota Exception Creation 

This is Quota Exceptions screen. Don’t forget pressing save after exception create/edit/delete. 
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No Name Description 

1 Exception Name Name of the exception. This name will be used when attaching 
exception to a policy. 

2 Periodic Usage will be zeroed at the end of period. 

3 Non-periodic Usage will not be reset. Limits are final. 

4 Period count Period count. 

5 Period unit Possible values are: Day, Week, Month, Year. 

6 Destination IP/Net Destination IP Address or Network (CIDR) for this exception. 

7 Destination Port Destination port for this exception (only one port). 

8 Day of Week Range Which days this exception will match. 

9 Time Range Which hours this exception will match. 

10 Surfing time Set time limits for this exception. 

11 Download Limit Set download limit for this exception. 

12 Upload Limit Set upload limit for this exception. 

13 Add Complete exception creation. 

14 Cancel Cancel exception creation. 
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Attaching a Quota Exception to a Quota Policy 
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101 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

Assigning a Quota Policy to User 

After defining a policy (and exceptions), you need to assign users to this policy.  This is possible in both 

LMC and WAUTH. 

LMC 
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WAUTH 

 

Assigning a Quota Policy to Group 

Assignment to groups are only possible in LMC. When you assign a policy to group, all users not having a 

quota policy before are associated with new quota policy. If a user is specifically assigned a quota policy 

before, policy of this user will not be changed with group quota assignment. 
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Monitoring Quota Usage 

Usages of all users can be monitored in LMC. Additionally, a single user can see own usage in WAUTH 

Welcome screen. Monitoring in LMC is more detailed since you can examine by policy and see all 

exception usages also. On the other hand, a user can only see only policy usage in welcome screen. 

Exceptions and usages belong to them are not listed. 

LMC 

Double clicking on a usage shows exception usage.
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WAUTH Welcome Screen 
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System 

System Tab in the LMC provides us with different options like DHCP , DNS , Date / Time 

settings , Configuring backup’s , update , automatic updates , logs and general settings. 

All the above mentioned options can be configured under System Module. When we are connected to 

System Module below screen appears. 

 

 

Viewing Options in System 

When we Right click on “System Tab” we find following options. 

1 Connect It enables us to Connect to the System Module 

2 Disconnect It enables us to Disconnect from System Module 

3 Properties It helps us to view properties of System Module in 
LMC 

 

26. System LMC Module 
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Users 

In System Module on the right pane you can find Users tab in that click on Users 

Adding User 

Click on Add Tab to add a New User in System Module. 
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These are the inputs for adding a New User 

1 Username Type the name of the  Username of the new User 

2 Password Type the Password of the new User 

3 Re-type Re-Type Password of the new User for 
confirmation 

4 Name  Type the Name of the new User 

5 Comment Type reason for the User creation (Optional) 

 

Below screen appears stating that User added successfully, click OK to close the current tab 

 

We can notice new User added in the User’s list of System Module 
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Deleting User 

Select User and click on Remove Tab to delete an User. 

 

When the below screen appears, click Yes to remove User. 
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Alert screen appears displaying User removed successfully; click Ok to close the current tab. 

 

Change Password / Editing User 

 

Select the user from the list and click on Edit 

 

Viewing options in Edit User 
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1 Module Displays all the Modules in LMC 

2 Access level Displays access level of each Module 

3 Set Password This option helps to Set Password to the User 

 

 

Select the Module and choose Access level from the drop down menu as shown below 

 

 

When we click on Set Password, below screen appears. 

 

1 New Password Type password of the User 

2 Re-type 
Password 

Re-type Password of the User for 
confirmation 

 

Click on Set Tab to set New Password 

Below screen appears stating that password is changed successfully, Click Ok to close the 

current tab. 
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Click on Save Tab to save changes. 

 

When the below screen appears, click Ok. 

  

 

 

Click on Close Tab 
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27. DHCP 

DHCP: DHCP stands for Dynamic Host Configuration Protocol 

DHCP server provides IP address and other related configuration information like subnet mask 

and default gateway to the host systems within a LAN network. For every computer it will 

provide unique IP to identify the system.  

By our configuration settings IP address will change certain period of time for the host systems

  

DHCP is useful in extremely larger networks where we want to centralize the IP management to 

reduce human errors. 

ISP (Internet Service Provider) 

Usually ISP’s implement DHCP servers 

DHCP is a server which assigns IPs automatically to the clients requested from a range of IPs. 

IP leasing process: 

1. DHCP discover: The client machine when turned on, broadcasts the network id, broadcast id 

and MAC address on Network for discovering DHCP server. 

2. Offer: The DHCP server listening to the request made by the client offers a pool of IP 

addresses to the client machine. 
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3. Selection: The client machine on receiving the pool of IP address selects an IP and requests 

the DHCP server to offer that IP. 

4. Acknowledgement: The DHCP sends a confirmation about the allotment of the IP assigned 

to the client as an acknowledgement. 

5. IP lease: If the client machine is not restarted for 8 days, exactly after 4days the client 

machine requests the DHCP server to extend the IP lease duration, on listening to this the 

DHCP server adds 8 more days for existing 4 days which is 12 days 

If the client machine is restarted again the DHCP lease process takes place and again the client 

gets an IP for 8 days. 

 

Select System option from the Labris Management console 

 

 

Right click on the System tab and click on Connect to get connected 

Select DHCP option under services. 
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Select Server tab to view the DHCP server details like Name , Subnet , Router , Type and 

Status. 

 

 

 

 

Click on Add to Add the New DHCP Server details. 

 

 

Make DHCP scope Active by enabling the Active checkbox. Select the type of the scope from 

the options mentioned here. In this screen we selected Dynamic option. Also Enable Use 

interface’s IP address as router check box. 

1 Scope Name Type Scope name 

2 Interface Select Interface from drop down menu 

3 IP Range Mention Scope  

 

Click on Add Tab to add an IP Range 
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Continuation to the above screen, choose Lease Time &Maximum Lease Time from the scope 

and type Domain Name, Click on Save Tab. 
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Saving changes is in progress. 

 

Below screen appears stating that Changes are saved and applied, click Ok to close the current 

tab. 

 

 

 

 

 

We can notice from the list that the Server is added 
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If we want to Edit the IP Range, Select IP Range and click on Edit Tab, modify the contents and 

Click Ok to apply changes 

 

 

 

 

Select the Server from the list and click on Edit Tab. 
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We can Edit Scope Name, Interface and IP Range in  Edit DHCP Scope. At the same time we 

can even Add, Edit, Delete IP Rangefrom the same tab.Select IP Range and click on Deleteto 

delete the entire range. 

 

 

 

Adding IP Reservation to DHCP scope 
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These are the inputs for adding IP Reservation 

1 Active We can enable or disable this option 

2 Mac Address Give Mac Address of the Host 

3 IP Address Give the IP Address within the scope of  DHCP server 

4 Hostname Type the name of the Host 

Click on Ok 
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In the below screen we can notice IP Reservation added to the DHCP Server

 

Editing IP Reservation 

Select IP and click on Edit tab 

We can edit all the fields in the Edit tab and click Ok 

 

 Deleting IP Reservation 

Select the IP and click on Delete tab, Click Ok to delete. 
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Below screen appears stating that selected records have been deleted. Click Ok to close the 

current tab. 

 

Select the Server from the list and click on Delete Tab to delete the DHCP Server. 

 

 

Deleting process is in progress. 
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When the below screen appears, click Ok. 

 

We can notice that the selected Server is deleted from the Servers list.

 

 

Lease list options 

Select Lease List to display the details of DHCP Lease List. 

 

Choose IP Address and click on Add Reservation Tab. 
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Click Ok to Add reservation for the selected IP Address. 

 

Select the IP Address and click on delete tab to delete the selected lease list. 

 

Click Ok to delete the selected lease list 

 

 DHCP Relay options 

Select DHCP Relay and click on Add Tab. 
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Give the server IP Address and click OK.

 

We can notice that Server is added in the DHCP Relay. 

To set up the DHCP Relay with one Server and more than one interfaces, each interface should  

be added separately with Server .  

After add operation, a route which is from DHCP Server to DHCP Relay should be added. 

 

Select the Server and click on Edit Tab. 

 

 

 

 

Edit the Server IP Address and click OK. 
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Select the Server and click on Delete Tab to delete server from the DHCP Relay. 

 

Click OK to delete the server from DHCP Relay. 

 

Below screen appears stating that Selected Records have been deleted, click Ok to close the 

current tab. 

 

 

 

 

Global Settings options 

When we click on Global Settings, below screen appears. 

From the IPSec VPN Interface drop down list select the Ethernet adapter. 
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Enable Activate Advanced Parameters, give the IP Address and click on Add and then Save. 

 

Select the IP Address and click on Edit tab to edit IP Address. 
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Edit the IP Address and click OK. 

 

  



 
 

128 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

Select the IP Address and click on Delete button to delete the IP Address. 

 

We can notice that IP Address is deleted, click on Save Tab to save the changes. 
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Below screen appears stating that Changes are Saved. Click OK to close the current tab. 

 

28. DNS 

Domain Name System (DNS) is the name resolution protocol for TCP/IP networks, such as the 

Interne. DNS translates Internet domain and host names to IP addresses. DNS automatically 

converts the names we type in our Web browser address bar to the IP addresses of Web 

servers hosting those sites. 

 DNS is that it serves as the "phone book" for the Internet by translating human-friendly 

computer hostnames into IP addresses.  

In System Module, right pane  click on Services tab and select Cached DNS Server to manage 

DNS Server. 
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In the DNS Server Management tab we find different options like Local Subnet, Real DNS 

Servers. In the Real DNS Servers give the IP Address of the DNS server and click on Add. 

 

Viewing fields in DNS 

1 DNS Server 
Management 

In this we can Add, Delete, Update Local Domain 

2 Real DNS Server In this we can Add, Delete, Update DNS server 

3 Service 
Management 

In this we can Start, Restart, Stop DNS Server and it also displays status of the 
DNS Server 

 

In the below screen we can notice DNS Server is added. 

 

Select the server and click on Start tab to start the services of DNS Server. 
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Below screen appears stating that DNS Service Started, click Ok to close the current tab. 

 

In the below screen we can notice the Status of the DNS Server is shown as Started. 

 

 

 

Select the Server and click on Stop button to stop the services of DNS Server. 
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Below screen appears stating that DNS Service Stopped, click OK to close the current tab. 

 

In the below screen we can notice the status of the DNS Server is shown as Stopped. 
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Select the Server and click on Restart button to Restart the Services of DNS Server. 

 

Below screen appears stating that DNS Service Restarted, click OK to close the current tab. 

 

Select the Server and click on Delete button to delete a DNS Server. 
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In the below screen we can notice newly added DNS Sever got deleted. 

 

29. HA - High Availability Appliance Deployment Architecture 

 

High Availability service is designed for Labris UTM devices to run in a redundant (active-

passive) mode. With this service, you can configure two Labris UTM devices in a redundant way 

and ensure non stop service. 

 

 
 

 

  

•You can also change your prefered language even after you login to the appliance 
as shown in following imageNote



 
 

135 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

Steps; 

 

By following the steps below and with the information in the document, Labris High Availability 

system can be setup. 

 

Active Device (Master) Passive Device (Slave) 
  
 1 - Device hostname is configured 

 2 - IP configuration is done. Here, High Availability 
port and dummy IP settings are configured. (Alias IP 
address configuration is done on the active device on 
first configuration) 

 3 - Console access settings are configured. 

4 - Device hostname is configured.  

5 - IP configuration is done. High Availability port, 
dummy IP and alias IP settings are configured. 

 

6 - Console access settings are configured.  

7 - High Availability service is configured.  

8- All the other configurations are done. Firewall, 
webfilter etc. 

 

High Availability system is tested. 
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Topology 

 

For the redundant setup of Labris UTM devices, the following topology can be used as a 

reference. 

The basic logic while setting the topology is  to connect both of the Labris devices via ethernet 

cable to the other devices that they are connected and connect the two Labris UTM devices to 

each other, for health checking. 

 

For the High Availability system, first of all hostname, IP settings (except alias IP addresses) and 

console access settings are configured on the second device. 

All other configurations are done on the first device. When high availability is started all the 

configurations will be synchronized between the two devices. 

After setting the above topology, you can continue following the configuration steps. 
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Hostname Settings 

 

Devices used in High Availability should have different hostnames. High Availability service 

checks access control between each other using this hostname.  

To configure the hostname, enter the system module from LMC. After clicking General Settings 
you can edit the hostname. 
 

 
 

 
 

1 Hostname Labris UTM Device Name 

2 Save Configuration Save 

 

The same setting is also configured on the second Labris UTM device. On the second device 
another hostname should be given. 
 
 
 
 
 
 
 

IP Configuration 

 

When setting up the High Availability system an unused IP address from the internal network is 

given from the Network Settings module. 

Active and passive devices are configured to have different IP adresses. 
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The IP adresses that will actually be used should be defined as an alias IP on the related 

ethernet. (Only defined on the active device on first configuration.) 

For IP configuration, enter the netwok settings module from LMC. 

IP settings are configured according to your network topology. 

 

 

Dummy IP Address 

 

For ethernet interfaces to be active, an unused IP address which will not normally be used 

should be set  on an ethernet. The IP adresses which will be actually used will be defined  as an 

alias IP on the ethernets. The alias IP adresses are automatically run on the current active 

device by High Availability service. 

 

Dummy IP addresses, which are not used in the network, are given to the related ethernets via 
the IP Configuration menu. For this, after selecting the related ethernet, right click and press 
edit. After the configurations press apply button.  
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1 Name A name defining the ethernet interface 

2 IP Address The IP address used for the selected interface. In this scenario, an 
unused IP address should be given. Also on the second device an 
unused IP address should be given. 

3 Mask Mask of the network address. 

4 Apply Applies the configurations.  

5 Other Parameters For other parameters, please refer to the Ethernet Settings section 
in the admin guide. 

 

This procedure is done for all the used ethernets. 
 

Alias IP 

More than one IP address can be defined on a physical ethernet interface. For this, alias IP 
addresses are added to the system. When using Labris High Availabilty service, IP settings are 
done using alias IPs. Press on the Add button in IP Configuration menu and select Alias IP. 
Define the IP addresses which will actually be used.  



 
 

140 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 

 

 

1 Name A name defining the alias ethernet interface. 

2 IP Address The IP address used for the selected interface. In this scenario, an 
unused IP address should be given. Also on the second device an 
unused IP address should be given. 

3 Mask Mask of the network address 

4 Interface The ethernet interface which the alias IP will be configured on 

5 Next After the settings are configured click on the Next button and the 
alias interface will be defined. 

This way, all IP addresses which will actually be used are added as an alias ethernet interface. 
After the definitions are made, the alias ethernet interfaces which have been defined are 
selected and activated. 
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This procedure is done for all alias ethernets. 

Alias IP addresses are only configured on the active device. There is no need to do this 
configuration for the passive device. 
 

HA Port 

It is the ethernet interface which will be used to communicate between Labris UTM devices. HA 
ethernet interface is defined on both the active and passive devices. The two devices are 
connected via an ethernet cable using these ports configured for HA. 

 

The ethernet interfaces used for HA should be the same on both devices. In other words, if 
the active device is using eth3 for HA, the passive device should also use eth3. 

 

An IP address is given to the ethernet interface configured as HA port. Any unused IP address 
having a minimum mask of /30(255.255.255.252) in the local network can be given. The IP 
adresses given to the HA ports of the active and passive device should be in the same subnet. 
 

 
 

1 Name A name defining the ethernet interface. 

2 IP Address The IP address used for the selected interface. The IP adress given 
to the HA port for the access of two Labris devices. 

3 Mask Mask of the network address.  

4 Apply Applies the changes.  
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5 Other Parameters For other parameters, please refer to the Ethernet Settings section 
in the admin guide. 

 

The same configuration is done for the second device. 

Console Access (Access Between Devices) 

 

For allowing connection between active and passive devices, the IP addresses given to the HA 
ports should be written to the console access configuration of the active and passive devices. 

Just for the first time thsi setting should be done on both devices. After HA starts running, it is 
enough to configure the console access on active device. 

Under the system module in LMC you will see the console access settings. The IP addresses 
defined for the HA ports of both devices should be added here.  
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1 IP/Network  The IP or network addess which will be allowed for accessing the 
device. In this scenario, the IP/network address defined for the HA 
ports are written. 

2 Netmask The netmask of the IP/network addess which is allowed to access 
is written. 

3 Add After clicking this button, it will also be applied. There is no need 
to click the save button additionally. 

High Availability Service Settings 

 

HA service settings are located under the services menu in system module of LMC. 

It is sufficient to make the configurations from the active device. The configuration of the 
passive device is done by the active device automatically. 
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1 High Availability Enable. Activation of the service 

2 Synchronize Period The time period of the synchronization between Active and 
Passive devices. 

3 HA Shared Key The shared key of the HA service between the two device. 

4 Save The button to save and apply the configurations. 

 
 

 
 

1 Node This is used to determine if the device being configured is the first 
(master) device or the second (slave) device. Master device is the 
active device whereas the slave device is the device on stand by 
mode. 

2 Interface The HA ethernet port configured for this device. 

 
 

 
 

1 IP Address The IP address given to the HA port of the other device. 

 

 
 

1 Interface This is used to determine the ethernet which has the address 
which is used to control the life status of the devices by sending 
ping packets. It is advised to select the ethernet which is on the 
LAN. 

2 Reliable Ping IP The IP address of a device which is behind the selected IP address, 
which will be always up and sent ping packets to. 

 



 
 

145 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 
Saving and Applying Configurations 

 

After pressing the save button the configurations are saved. 

 
 

Access to the second device is started over SSH protocol. The key of the second device is seen. 

Click yes if the key is correct. 

 
 

Enter the root password of the other device. This procedure is done only once. It will not 

appear on consecutive configurations. 

 
 

After establishing the connection, the configuration of the other device is saved and the 
synchronization between devices start. 
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After the procedure completes successfully High Availability system will be established. 
 

 
 

The status of the High Availabilty service can be seen below the page. 
 

30. Configuration Backup / Restore 

In System module, right pane select Configuration Backup 

 

According to user requirement choose any one of the radio button in the below screen and 

click on Backup Tab to start the Backup process. 

Choose Configuration radio button and click on Backup button. 
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Click on Save tab to save the file with file name.bak extension in your local machine as in the 

below screenshot. 

 

Creating Backup process for Configuration is in progress. 
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Below screen appears stating that Backup saved at the chosen location in your hard drive, click 

OK to close the current tab. 

 

According to user requirement choose any one of the radio button in the below screen and 

click on Restore to start restore process 

 

 

Choose Configuration and click on Restore button. 

 

Choose the backup file from the local machine and click OK to Restore Backup 
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Restoring Backup process for Configuration is in progress. 

 

 

 

Below screen appears stating that Backup restored, click OK to close the current tab. 

 

Choose User Settings and click on Backup Tab 
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Click on Save tab to save the file with file name.bak extension in your local machine as shown 

in the below screen. 

 

Creating Backup process for User Settings is in progress. 

 

Below screen appears stating that Backup Saved, click OK to close the current tab. 
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Choose User Settings and click on Restore button. 

 

Choose the backup file from the local machine and click Ok to Restore Backup 

 

 

Restoring Backup process for User Settings is in progress. 
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Below screen appears stating that Backup restored, click OK to close the current tab. 

 

 

Choose Permanent Logs and click on Backup button. 

 

Click on Save tab to save the file with file name. tar.gz extension in your local machine at your 

chosen location as shown below. 
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Creating Backup process for Permanent logs is in progress. 

 

 

Below screen appears stating that Backup Saved, click OK to close the current tab. 

 

 

Choose Operational Logs and click on Backup Tab 
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Click on Save tab to save the file with file name .tar.gz extension in your local machine to save 

the operational logs as shown below. 

 

 

Creating Backup process for Operational logs is in progress. 
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Below screen appears stating that Backup Saved, click OK to close the current tab. 

 

Choose Network Logs and click on Backup Tab. 

If we want to delete logs after completion of Backups process for each log, Check the Delete 

logs after backups check box. 

 

Click on Save tab to save the file with file name .tar. gz extension in your local machine as 

shown below. 
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Creating Backup process for Network logs is in progress. 

 

 

Below screen appears stating that Backup Saved, click OK to close the current tab. 

 

 

Factory settings 

Click on Factory to roll back Labris UTM the default settings. 
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31. Update 

In System module, Right Pane under system tab click on update tab 

 

Note – In the below screen if any package is pending for upgrade, please request from the service 

provider using the mail id or call. 

When we click on Update Tab, below screen appears, Package of the Server version and 

Signature has to browsed from local machine and click Install 

 

32. Automatic Update 

In System Module, right pane under System Tab click on Automatic Update Tab to get 

Updated automatically 
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33. Record 

In System Module, right pane under System Tab click on Logs to view 

Logs of LMC 

 

 

 

Below screen appears displaying all the Log Types in LMC. 

Select any required log from the Log Types then the related 

information is displayed in the right pane. 
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Different types of Logs in LMC. 

1 Access.log Log messages  related to Access can be viewed 

2 Administrative Log messages  related  to Administrative can be viewed 

3 Dhcp Log messages  related to Dhcp can be viewed 

4 Lpmac.log Log messages  related to Lpmac can be viewed 

5 L2tp Log messages  related to L2tp can be viewed 

6 Maillog Log messages  related to Maillog can be viewed 

7 Network log Log messages  related to Network log can be viewed 

8 Operational Log messages  related to Operational can be viewed 

9 Ssslvpn Log messages  related to Ssslvpn can be viewed 

10 Wauth-
access.log 

Log messages  related to Wauth-access can be viewed 

 

34. Date / Time Settings 

In System Module, right pane under System Tab click on Date/Time 

Settings. 

 

 

 

 

Below screen appears, set the date and time and click Save to save the Current Date/Time. 

 

35. Console Access Settings 

In System Module, right pane under System Tab click on Console Access Settings. 
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Enable Block remote console access check box to block remote access for other users or 

desktops. 

 

Click on Add Tab to add an IP/Network Address to Console Access Address. 

 

Below screen appears 

 

1 IP/Network Address Type IP/Network Address  

2 Netmask Type Sub Netmask 

We can notice the IP/Network address in the Console Access Address 
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Select the IP/Network Address and click on Edit button. 

 

We can Edit the IP/Network Address and click Apply. 

 

We can notice the applied changes 
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Select the IP/Network Address and click on Remove button, then it will be removed from the 

Console Access Address. 

 

 

36. General Settings 

In System Module, right pane under System Tab click on General Settings. 
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Below screen will appear displaying Hostname, Internal network hostname/IP address, and 

Notification mail address. 

 

 

37. Trusted Time Stamp 

In System Module, rightpane under System tab select Trusted Time stamping 
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Below screen appears displaying settings and Previous Time Stamped Log Packages, select 

log/date/hash row click on Save Tab. 

Turkey is valid within the boundaries of the "Law No. 5651" requirement; 

content provider, provider, access provider and public liability and responsibilities of providers 

of certain crimes committed on the internet with the content relating to the fight over the 

location and access providers and procedures. 

The item is provided on behalf of the meet. 

Must be held according to law, and the mandatory or hits just set cvars labris UTM equipment 

that meets the requirement of the law in any way. 

In the case of certain specified property on every day or istenillmesiperiyorlarda for the 

protection of the State against the log file, which consists of modified authorized the signing of 

the "TURK TRUST" side of the premises. 

Select the Log file and click on Save 



 
 

165 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 

38. Restart 

In System Module, under System Tab click on Reboot to Reboot the 

System. 

 

 

39. Shutdown 

In System Module, under System Tab click on Shutdown to shutdown 

the System. 

 

 

 

 

 

 

Network Settings 

In Network settings IP Configuration and Routing can be done for Labris UTM appliance. 
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In this section we can Add, Delete, Edit and View the Status of the Interface. 

40. IP Configuration 

Labris Secure Gateway is a capable router, and it has 
many Ethernet interfaces both used for security and 
also routing, load balancing and many other network 
tasks. IP Routing is used to Configure Ethernet 
interfaces and routing configuration of Labris Security 
Gateway. 
Right click on Network Settings and select Connect. 

 

IP Alias (Add, Edit, Delete, Status, Enable/disable) 

Below screen appears select IP Configuration, click on 

Add button. 

 

Choose IP Alias radio button from the types of Interfaces, Click on Next button to continue the 

process. 
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Configuration of the Alias connection. 

 

These are the inputs for the Configuration of Interface. 
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1 Name Type the Name  

2 IP 
Address 

Give the IP Address 

3 Netmask Type the Netmask 

4 Interface Select  Interface from the drop down Menu 

 

Installation is finished, Click on Finish button. 

 

 

Below screen appears, click on close button. 
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We can notice the New interface added to the Interfaces list with IP Alias connection.

 

 

 

 

Select the Interface and click on Activate button.

 

 

Activation process is in progress. 
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Now we can notice that the newly added Interface is Active.

 

 

 

 

Editing IP Alias  

Select the Interface and click on Edit button to Edit the Interface. 

 

 

Editing the Alias configuration, give the inputs and click on Apply tab to apply the changes. 
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Note: Click on Save tab to save the changes in configuration. 

 

These are the inputs for Editing the Interface 

1 Name  We  can Edit the existing Name 

2 IP Address We can Edit the existing IP Address 

3 Netmask Give the Netmask for the given IP Address 

 

After applying the changes, Interface will restart. 

Restart process is in progress. 

 

•Click on Save tab to save the changes in ConfigurationNote
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We can notice the changes in the Interface in the Interfaces list.

 

 

 

 

 

 

 

 

Enable / Disable 

Select the Interface and click on Deactivate button to deactivate the Interface. 
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Status 

Select the Interface and Click on Status button to check the status of the Interface 

 

Below screen gives the status of the Interface 
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Right click on the Interface, to perform Edit, Activate, Deactivate, status, Delete, Edit groups, 

Activate groups, Deactivate groups actions. 

 

ADSL (Add, Edit, Delete, Status, Enable/Disable) 

Select IP Configuration and click on Add button 

 

 

Choose ADSL from the types of Interfaces and click on Next button to continue. 
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Choose the Ethernet Interface to the ADSL from the drop down list, check mark the default 

Gateway and click on Next button. 

 

 

User Information should be provided 
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These are the inputs for the User 

1 Login Type Login name of the User 

2 Password Type the Password of the User 

3 Password (again) Type the Password of the User again for 
confirmation 

 

ADSL 

Configuration of ADSL connection. 

 

1 Login It displays Login name of the User  

2 Interface It displays the Interface type 
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3 Device It displays device name 

 

Click on Next button to continue. 

Once the installation is finished, Click on Finish button. 

 

Below screen appears, click on close button. 

 

 

We can notice Interface added in the Interfaces list with ADSL type of connection 
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Select the Interface and click on Activate button to activate the Interface. 

 

Activation process is in progress 
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Bridge(Add ,Edit, Delete, Status , Enable/disable) 

 

To configure Bridge connection for the Interface select Bridge radio button from the types of 

connection. 

Configuration of Bridge Connection screen. 

 

These are the inputs for Bridge connection 

1 Bridge Name Type the Bridge connection 

2 IP Type the IP Address 

3 Netmask Type the Netmask 

4 First Interface Select the  First Interface from the drop down list 

5 Second Interface Select the  Second Interface from the drop down 
list 
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Interface Configuration process is in progress 
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Once the installation finished click on Finish button. 

 

We can notice that the Interface is added in the Interfaces list with Bridge type of connection. 

 

Activation process is in progress. 
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Click on Add button to add an interface. 

 

3G (Add, Edit, Delete, Status, Enable/disable) 

To configure 3G connection for the Interface 

Select 3Gbutton from the types of connection. 

 

Choose the service provider of the 3G modem from the drop down list, check the default 

gateway. 
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Scanning of 3G Modems process is in progress. 

 

Then the below screen appears stating that, User information is used for authentication. 

Choose the “Modem” from the drop down list and enter the “pin” of the modem and click on 

“Next” to proceed further. 
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Note – Since we don’t have connection to the 3G modem, in the below screen message is 

displayed as “There is no plugged modem on the Labris device Please check your modem”. 

Click on Cancel tab. 

 

 

 

 

 

 

3G Release Note; 

1 Configuration of old generation 3G Modem 

• Plug the modem into the USB port on the device. 

• Labris Management Console is opened and accessed to the system with an authorized user name 

and password. 

• By clicking on the add button on the right in the IP Configuration tab from the Network Settings 

Module the  Labris Interface Wizard opens. 

• The forward button is clicked by selecting the 3G on the opened screen. 

• The service provider is selected on the next screen, and in case the added 3G shall be used as the 

default gateway the related box is selected and clicked on next button. 

• In the next screen are the 3G modems listed on the modem line. The appropriate modem is 

selected and , if available, the pin entered, if no pin available then the" no pin" box is selected 

and clicked on the next button. 

• On the next screen are the features of the configured modem listed,  the PPP interface is created 
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by clicking on the next button. 

• By clicking on end button on the next screen the interface wizard is closed. 

• The created PPP interface is listed under interfaces.  

• The related PPP interface is  selected and enabled with the help of the "Activate" button on the 

right  or right-clicking on the interface. Activation may last up to 1-2 minutes.. 

• The type, IP address, connection status, referrals status, signal status will be shown on the 

enabled interface. 

• In case the added modem shall not be used as the default gateway and will be used as additional 

line it has to be saved  as an additional line. For this, it can be added as a line by clicking on the 

advanced button on the Network Settings> Routing screen. 

• The permission rule of the created interface is added to the firewall general policy.  

• According to the usage status of the created interface in the firewall NAT policy the NAT rule is 

added and the modem is made available to use. 

 

2. Configuration of new generation 3G modem 

• The modem is plugged into the USB port on the device. 

• The Labris Management Console is opened and accessed to the system with an authorized user 

name and password. 

• Network settings module is opened. The new generation of devices plugged on the device is seen 

as ether interface. The latest added interface on the interface list is the interface of the modem. 

• The IP address of the modem is usually example:192.168.1.1 or 192.168.2.1.  We can give the IP 

address of the modem interface on the device in the same subnet with the modem interface by 

clicking on create on the right side, for example:192.168.1.2 or 192.168.2.2 

• If the modem is selected as the default gateway the IP address of the modem is entered by 

selecting the related interface in the pre-defined network gateway from the Network Settings> 

Routing section and saved with the button in the bottom right. 

• In case the added modem shall not be used as the default gateway and will be used as additional 

line it has to be saved  as an additional line. For this, it can be added as a line by clicking on the 

advanced button on the Network Settings> Routing screen. 

• The permission rule of the created interface is added to the firewall general policy.  

• According to the usage status of the created interface in the firewall NAT policy the NAT rule is 

added and the modem is made available to use. 

 

Vlan (Add , Edit, Delete, Status , Enable/disable) 

 

To configure VLAN for the Interface. 
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Select VLAN button from the types of connection. 
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Configuration of VLAN 

 

 

 

These are inputs for configuration of VLAN 

1 Name Type the Name 

2 IP Address Give the IP Address 

3 Netmask Give the Netmask of the IP Address 

4 Vlan Tag Give   the Tag of the Vlan 

5 Interface Choose the Interface from the drop down list 

Click on Next tab to continue 

Interface Configuration process is in progress
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Installation finished click on Finish button. 

 

Below screen appears, click on close button. 

 

In the below screen we can notice Interface, click on Activate tab to activate the Interface. 
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Activation process is in progress. 

 

We can notice Interface is Activated in the below screen. 

 

41. Routes 

In Routing tab the touting table of Labris Secure Gateway is displayed. In this table you can see 
the 
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Destination, Mask, Default Gateway, Interface and Metric properties of each route. Destination 
is the destination IP or network; mask defines the destination host or network's Netmask, 
default gateway is next way point of the package. Interface is the interface which will be used 
for routing operation. 

 
 

Default Gateway 

The Default gateway is the default next hop for every packet, when there is no explicitly specified 
gateway for destination of that packet. In order to change the default gateway firstly enter an IP 
address of the default gateway and choose an interface from which Packets are sent to the 
gateway. 
 

 

Static Route 

A static route is a manually configured mapping of an IP address to a next-hop destination. 

A static route causes packets to be forwarded to a different next hop other than the configured 

default gateway. By specifying through which interface/gateway the packet will leave and to 

which device the packet should be routed, static routes control the traffic exiting Labris UTM. 
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Add (Static Route) 

Add static routes when you want to route traffic destined for specific network/host via a 

different next hope instead of a default route. 

Click on Add button to add static route. 

 

Below screen appears. 

 

These are the inputs to Add route 

1 Destination Give the Destination IP Address 

2 Mask Give the Netmask of the Destination IP Address  

3 Gateway Give the Gateway IP Address 

4 Device Choose Device from drop down list 

5 Metric Choose Metric value 
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Click on Add button. 

We can notice Static route in the Routing list. 

 

 

Delete (Static Route) 

Select the Static Route from the list and click on Delete button, to delete Static route. 

 

 

Load Balance (OLD) 

Load Balance (NEW) 

 

42. Load Balance 

--------------BEGIN NEW STUFF-------------------- 

Load balance module allows administrators to create Policy Based Rules using links and/or link groups. 

PBR allows administrators to write advanced route rules. User, group, ip based rules can be written to 

specific destinations over chosen links or link groups. Also for network stability administrators can add 

backup links and link groups. To load balance traffic between links administrators can create link groups. 
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MAIN SCREEN
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No Name Description 

1 
Link and Link Groups Manage all links and link groups 

2 
Policy Based Routing Manage all policy based routing rules (PBR) 

3 
Add Link Create a new link to use in a link group or in a PBR. 

4 
Add Link Group Create a new link group to use in a PBR. 

5 
Edit Link/Link Group Edit an existing link or link group. 

6 
Delete Link/Link Group Delete an existing link or link group. 

7 
Link Groups Link groups section. 

8 
Links Links section. 

9 
Add PBR Create a new policy based routing rule. 

10 
Edit PBR Edit an existing policy based routing rule. 

11 
Delete PBR Delete an existing policy based routing rule. 

12 
Default Route Default gateway written in Route tab is automatically written as 

last rule of PBR. 

13 
Load Balance 
Service Status 

Service status. PBR rules only work when service status is 
"Running". 

14 
Start Service Start service. 

15 
Stop Service Stop service. 

16 
Restart Service Restart service. 

17 
Save Changes Save changes. 

18 
Refresh Screen Refresh everything in the screen. 
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Add Link Screen 

 

No Name Description 

1 
Link Name Name of the new link. 

2 
Gateway Gateway IP address of new link. 

3 
Interface Interface of new link. 

4 
Ping Address Input Use this field to add a new ping ip address. 

5 
Add Ping Address Add the value in Ping Address Input. 

6 
Edit Ping Address Edit selected ping address. 

7 
Delete Ping Address Delete selected ping address 

8 
Ping Addresses Show all ping addresses. To edit/delete, select one. 

9 
Add Link Save new link 

10 
Cancel Cancel. 

 

 

Add Link Group Screen 
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No Name Description 

1 
Group Name Name of the new link group. 

2 
All Links Available links for adding to this link group. 

3 
Add link to group Add selected link to link group (left -> right) 

4 
Remove link from group Remove selected link from group. (left <- right) 

5 
Links in this group Selected links in this link group. 

6 
Create Link Group Create this link group. 

7 
Cancel Cancel. 

 

Network traffic going through link group is load balanced between links in the link group according to 

links' weights. Also links in a link group are failovered, network traffic is not redirected to down links. 
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Add Policy Based Route Screen 

 

No Name Description 

1 
Sources Sources for this policy based routing rule.(PBR) 

2 
Destinations Destinations for this policy based routing rule. 

3 
Link and Link Backup Link and link backup choice for this PBR. 

4 
Add IP or Network Add a new IP or network to this PBR. 

Examples: 192.168.0.5, 192.168.0.0/24, 10.0.20.0/255.0.255.0 

5 
Add Users or Groups Add User or Group 

6 
Delete Delete selected IP/Network/User/Group. 

7 
Link/Link Group Configure link choice for this PBR. 

8 
Backup Link /  
Backup Link Group 

Enable/Disable backup link choice for this PBR. 

9 
Add Policy Based Route Save changes. 

10 
Cancel Cancel. 
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Backup links/link groups are activated if main link is down or if all links in the main link group are down. 

Backup links/link groups are active until main link is up or one of links in main link group's is up again. 

 

Policy Based Route Right Click 

 

No Name Description 

1 
Move to top 

Move selected rule to the top. 

2 
Move to end Move selected rule to the end. 

3 
Insert at top 

Insert a rule at top. 

4 
Insert above  

Insert a rule above the selected rule. 

5 
Insert below  

 

6 
Move up 

 

7 
Move down 

 

 

 

--------------END NEW STUFF-------------------- 

--------------BEGIN OLD STUFF-------------------- 

Load balance can be configured based on following types 

 Configuring a virtual web server with three real web servers 

 Adding a server load balance port forwarding virtual IP 

 Weighted load balancing configuration 

 HTTP and HTTPS persistence configuration 

 Packet load balance or destination load balance 
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By default Load Balance is in disable mode, click on Enable button. 

 

When Load Balance is enabled Gateways section with the fields Gateway, Interface, Weight, 

Reachable, Router are seen 

 

Add (Load Balance Route) 

Click on Add tab to add Gateway 

 

 

Below screen appears 

 

These are the inputs to add Gateway. 

1 IP Address Type IP Address 

2 Interface Choose the Interface from the drop down list 

3 Weight Choose Weight value 
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Click Ok to add Gateway 

We can notice Gateway added in the below screen 

 

Edit (Load Balance Route) 

Select the Gateway and click on Edit tab to Edit the Gateway 

 

Below screen appears 

 

These are the inputs to edit gateway 

1 IP Address We can Edit the  existing IP Address 

2 Interface We can Edit Interface (Optional) 

3 Weight We can Edit Weight value (Optional) 

 

Click Ok to apply changes 
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Delete (Load Balance Route) 

Select the Gateway and click on Remove tab to remove gateway 

 

 

We can notice Gateway removed from the list in the below screen 

 

43. Advanced/ Policy Based Routing 

Click on Advanced Tab 
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There are two sections in the Advanced Routing table: 

 
 
 Upper section is for link configuration and the other one is for decision configuration. A Link is a 
virtual “link” for packets to a specific interface and a gateway. By defining decisions, one can 
redirect a package to a link based on the package's source and destination IP or network 
addresses. 

 

 

 

Link Configuration 

A Link is represented by a name, a default gateway and an interface. 

To create an Interface, click on Add button in the Link Configuration table. 

 

Below screen appears to create a New Gateway 
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These are the inputs to add Link 

1 Link Name Type the Name of the Link 

2 Default Gateway Give the Default Gateway 

3 Interface Choose the Interface from the drop down list 

 

Click on Add tab 

We can notice New Link added in the Link Configuration in the below screen 

 

Decision Table 

A Decision is represented by source IP/network, destination IP/network and the link name to 
which the packages are redirected. 

To add new decision, click on Add tab 

 

Below screen appears 
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 ( OR) 

 

 

 

 

These are the inputs to add Decision 

1 From Click on Add User or Group and browse User or Group as 
Source or we can give the IP address 

2 To Click on Add User or Group and browse User or Group as 
Destination or provide the IP address 

3 Link Choose Link from the drop down list 

 

Click on Add tab 

 

We can notice Decision added in the Decision table in the below screen 

 

•Source IP can also be mentioned in the From tab instead of browsing User or Group.

•Destination IP can also be mentioned in the To tab instead of browsing User or GroupNote
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Click on Save button to save newly added Link and Decision to the Advanced Routing Table. 

 

1 Save It enables us  to Save changes made to the 
Advanced Routing Table 

2 Refresh  It enables  us to Refresh Advanced Routing Table 

3 Cancel It enables us to Cancel and close the tab 

 

Saving and Applying Links and Decisions is in progress. 
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Select the Link and click on Remove tab to remove Link from Link Configuration. 

 

We can notice Link is removed from the Link Configuration. 

 

Select the Decision and click on Remove tab to remove Decision from the Decision table. 

 

Click on Save tab to save the changes made to the Routing. 

Click on Refresh tab to refresh Routing. 
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Saving process is in progress 

 

 

WAN failover (WAN Backup) 

By default load balance is disabled, Click on enable tab, to make Load balance Enable. 

In the below screen we can notice Load Balance Enabled 

 

 

Click on Add tab 
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These are the inputs for the Gateway Edit. 

1 IP Address Type IP Address 

2 Interface Choose Interface from the drop down list 

3 Weight Select Weight. Weight of the distribution 
ratio between each of the two represents 
default gateway. 

Click on Ok tab. 

We can notice one interface in active mode. 

 

 

WAN Failover using CLI 
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When more than one internet line is used for active-passive in-line redundancy then in that 
case truncation of the preferred line is the second line, in the second line of the first line again 
when auto and auto disable. 
 
This process is carried out via the CLI. 
 
These are the following command lines. 

Information 

WAN1 IP Address:10.10.10.2/30 

WAN1 Gateway: 10.10.10.1 

WAN2 IP Address:20.20.20.2/30 

WAN2 Getaway: 20.20.20.1 

LAN IP Address: 192.168.168.0/24 

DMZ IP Address: 10.0.0.0/24 

 

 

 

WAN Failover Configuration 

Step 1: 

The configuration file patch  

 

NOTE: Open CLI and Open conf file for editing using the below command 

vim /opt/labris/etc/sysconfig/labris-trigger.conf 

 

The following is the configuration file, you can use your own network ip addresses contained in 
the update according to the requirement. 
 

#It’s starting 

#NOTE : Default GW for WAN1 (Active) 

route1 = "10.10.10.1" 
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#NOTE : WAN1 up Interface 

route1.iface = "eth1" 

#NOTE : WAN1 live checkup the line will make the control of the external environment, ip 
addresses. 
route1.ping = "144.122.166.1 195.175.39.40"  
 
#NOTE : WAN1 in the absence of the line to the following line in this line. 
route1.action.NOT_ROUTER = "\ 
echo ---METRO ETHERNET1DOWN--- | logger \ 
route del default gw10.10.10.1 \ 

#NOTE : Add a new route for backup link WAN2 

route add default gw20.20.20.1 \ 

 

#NOTE: Users are added to the Internet through a NAT policy to WAN2.The IP address of the 
LAN. If more than one of the same row is copied only ip addresses are changed. 
iptables -t nat -I POSTROUTING -o eth2 -s 192.168.168.0/24 -j SNAT --to-source 20.20.20.2 \ 

iptables -t nat -I POSTROUTING -o eth2 -s 10.0.0.0/24 -j SNAT --to-source 20.20.20.2 \ 

#NOTE : updates the settings for the web filter 

/etc/init.d/labris-webfilter reload \ 

echo "---SNAT changed to METROETHERNET1"  | logger" 

 

#NOTE: Check the status of the line would last WAN1 3 second 

route1.action.ROUTER = " \ 
echo ---METRO ETHERNET 1 UP--- | logger \ 

 

#NOTE :If the WAN1 WAN2 to stand up for the route will be deleted. 
route del default gw20.20.20.1 \ 

#NOTE :WAN1 to route again. 

routeadd default gw10.10.10.1 \ 

//NOTE: Delete old rule for WAN2 

iptables -t nat -D POSTROUTING -o eth2 -s 192.168.168.0/24 -j SNAT --to-source 20.20.20.2\ 

iptables -t nat -D POSTROUTING -o eth2 -s 10.0.0.0/24 -j SNAT --to-source 20.20.20.2\ 

//NOTE: updates the settings for the web filter 

/etc/init.d/labris-webfilter reload \ 
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echo "---SNAT changed to METRO ETHERNET1"  | logger" 

 

route2 = "20.20.20.1" 

route2.iface = "eth2" 

route2.ping = "144.122.166.1 195.175.39.40"  

route2.action.UNREACHABLE = "echo ---METRO ETHERNET 2DOWN--- | logger" 

route2.action.REACHABLE = "echo ---ADSLMODEMUP--- | logger" 

route2.action.ROUTER = "echo ---ADSL-LINE-UP--- | logger" 

route2.action.NOT_ROUTER = "echo ---ADSL-LINE-DOWN--- | logger" 

 

/etc/init.d/labris-trigger restart 

#It’s finished 

Step 2: 

Add Advance routing on the new gateway for wan2. 

Click on Advanced option under Routing in Network Settings tab. 

Click on Add tab to add a link. 

 

 

Give the Link Name, mention Default Gateway and choose interface from the drop down list 

and click on Add tab. 
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We can notice new Link added to the Link Configuration table. 

Under Decision Table click on Add tab. 

 

Step 3: 

Add a source/policy base route on the decision table for DMZ and LAN network. 
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Mention Source and Destination IP address and choose Link from the drop down list. 

Click on Add tab. 

 

 

In the below screen, we can notice Decision added in the Decision table. 
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Firewall 

Firewall is software which controls the traffic of incoming and outgoing by analyzing the data 

packets which is allowable or not in a network. It serves as a gate keeper between severs and 

outside of the world. 

A firewall is a software program or piece of hardware that helps screen out hackers, viruses, 

and worms that try to reach your computer over the Internet. 
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Right click on Firewall and select Connect. 

 

 

44. Make a new firewall object 

A firewall is a rule that describes us what all the incoming connections that are accepted by 

which instances. Each firewall contains one rule, which specifies a permitted incoming 

connection request, defined by source, destination, ports, and protocol. 

By default, all incoming traffic from outside a network is blocked and without an appropriate 

firewall rule, no packet is allowed into an instance. You need to set up firewalls to allow 

incoming network traffic to permit these connections. Each firewall represents a single rule 

that determines what traffic is permitted into the network. It is possible to have many firewall 

rules and to be as general or specific as  we would like. 

When we get connected to Firewall, below screen appears. 

By default Labris Demo is displayed. 
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Right click on Policy, Select New Policy 

 

 

 

It consists of two fields, Name and Network Interfaces. 

In the Name tab, name of the new firewall object should be mentioned. 

Network Interfaces with Name, IP , Mask are selected by default. 

Click on Add tab. 
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We can notice new firewall object under firewall. 

It consists of two fields. 

Compile, Save and Install the rules of new firewall object field displays information regarding 

newly added object to the firewall. 

Properties of new firewall object displaying General, Options, Notes, SSH Inspecting. 

 

Under General tab, the name of the new firewall object is displayed 
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Under Options tab, we can checkmark  options like Firewall is part of “ANY”, Accept TCP 

sessions opened prior to firewall installation, Accept ESTABLISHED and RELATED packets 

before and click on Apply tab to apply these rules to the firewall object. 

 

 

Under Notes tab, we can describe any points regarding new firewall Object and click on Apply 

tab. 
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SSH inspecting 

SSH inspecting is a unique security solution which enables both real-time inspection, and full 

replay of SSH, SFTP, Telnet, and RDP traffic and sessions to meet compliance, governance, 

auditing, and forensics requirements in enterprises and government entities. 

In SSH Inspecting tab, we can check mark options like Allow HTTP request through ssh port 

forwarding, Allow scp, Allow shell login, Allow sftp and click on Apply tab to apply them to the 

firewall object. 

 

Click on Save tab to save changes. 
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Input tab appears, Give the name of the New file (new firewall object name) and click on Ok to 

close the current tab. 

 

Below screen appears stating that “New sample Object have been saved successfully” click Ok 

to close the current tab 

 

 

45. Objects 

Firewall rules can be created in an object-oriented design. A firewall object is a named 
collection that represents specific networks, services, or connections. Using firewall objects 
gives you the following advantages:  

 Each object has a unique name that is more easily referenced than an IP address or a 
network range. 
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 Maintenance of the firewall rules is simplified. When you update a firewall object, the 
change is automatically updated in every rule that uses the object.  

 The Firewall objects are a prime example of those building blocks. They are something that can 
be configured once and then used over and over again to build what you need. They can assist 
in making the administration of the LABRIS UTM unit easier and more intuitive as well as easier 
to change. By configuring these objects with their future use in mind as well as building in 
accurate descriptions the firewall will become almost self-documenting. That way, months 
later when a situation changes, you can take a look at a policy that needs to change and use a 
different firewall object to adapt to the new situation rather than build everything new from 
the ground up to accommodate the change. 

 

Objects folder consists of Network Objects, Services, Dos &DDOS, QoS/Bandwidth, Schedule, 

Application Control, Firewall. 

 

 

Network Objects 

Network objects are used to categorize IP addresses into different types of network entities. 

These network entities are then used to represent sources and destinations in the access rules, 

publishing rules, cache rules, traffic chaining rules, and HTTP compression settings that make 

up your firewall policy. 

Expand Network Objects. 

It consists of Hosts, Networks, Address Ranges, Object Groups, Users. 
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Brief Summary about each of the parameters in Network Objects: 

1 Hosts It enables us to Add new Host 

2 Networks It enables us to Add new Networks 

3 Address Ranges It enables us to Create new Address 
Range 

4 Objects Groups It enables us to Add new Object Groups 

5 Users It enables us to Add new User Groups 

 

Hosts 

 

 

Expand Hosts, by default it consists of three Hosts. 

They are INSIDE, OUTSIDE, WAUTH 
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Right click on Hosts to Add new Host. 

 

Below screen appears, Select General tab. 

It consists of two fields, Name and Interfaces. 

In the Name tab, name of the new Host Object should be mentioned. 

These are the inputs for the Interfaces: 

1 Name Type the name of the Interface  

2 IP Give the IP Address of the Interface 

3 MAC(Optional) Give the MAC Address (Optional) 

 

 

 

Click on Add tab to Add new Host. 
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Select Notes tab to provide information about the newly added Host and click on Apply tab. 

Cancel tab helps to cancel the Notes. 

 

We can notice newly added Host under the Hosts list with selected type of the Interface. 

 

Right click on  added Host, to perform actions like viewing Properties of the Host, to find out 

where it is used, copying Host, Deleting Host and Adding new Interface to the Host. 

 

To Add new Interface to the Host, Right click on the Host select Add new Interface tab. 
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Below screen appears, Select General tab. 

It consists of two fields, Name and Interfaces. 

In the Name tab, name of the new Interface should be mentioned. 

These are the inputs for the Interfaces: 

1 IP Give the IP Address of the Interface 

2 MAC(Optional) Give the MAC Address (Optional) 

 

 

Click on Add tab. 

We can notice the newly added Interface under the New Host.  

Right click on the Interface to perform actions like viewing Properties of the Interface, to find 

out where it is used, copying Interface, Adding new IP address to the Interface, Adding new 

MAC address to the Interface and Deleting Interface. 
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We can notice Interfaces for the newly added Host in the below screen. 
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Networks 

 

Expand Networks, by default it consists of two Network 

They are Standard and User Defined networks 

 

Right click on Networks, to Add new Network 
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Below screen appears, Select General tab. 

It consists of two fields, Name and Interfaces. 

In the Name tab, name of the new Network object should be mentioned. 

These are the inputs for the Interfaces: 

1 IP Give the IP Address of the Interface 

2 MAC(Optional) Give the MAC Address (Optional) 

 

 

 

Click on Add tab. 

We can notice Newly added Network under the User Defined Network with selected type of 

the Interface. 

 

Right click on added Network, to perform actions like viewing Properties of the Network, to 

find out where it is used, copying Network, Duplicating Network and Deleting Network. 
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Address Ranges 

 

 

Expand Address Ranges, User Defined is displayed 

 

Right click on User Defined, to Create New Address Range 
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Below screen appears, Select General tab. 

It consists of two fields, Name and Address Range. 

In the Name tab, name of the new Address Range should be mentioned. 

These are the inputs for the Address Range: 

 

1 Start IP Give the IP Address of the Interface 

2 End IP Give the MAC Address (Optional) 

 

 

Click on Add tab. 

We can notice the new Address Range in the below screen. 

Right click on  added Address Range, to perform actions like viewing Properties of the New 

Address Range, to find out where it is used, copying New Address Range, Duplicating New 

Address Range and Deleting New Address Range. 
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When we click on Duplicate New Address Range, below screen appears. 

In which it displays Name of the Duplicate Address Range and Address Range. 

 

We can notice Duplicate Address Range under User Defined list. 
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Object Groups 

 

Expand Object Groups, by default Standard and User Defined Object Groups are displayed. 

 

Right click on Object Groups, to add new object Group. 

 

Below screen appears. 

Select General tab, give the name of the new Object Group. 

We can copy and paste new Objects in this Object Group. 



 
 

233 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 

Click on Add tab. 

We can notice new Object Group in the User Defined. 

 

 

Right click on the Object Group, to perform actions like viewing Properties of the Object 

Group, to find out where it is used, copying Object Group, Duplicating Object Group and 

Deleting Object Group. 
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Right click on the object Group and select Properties. 
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We can notice name of the Object Group and list of objects in the Group. 

 

 

Users 

Expand Users. 

 

 

By default User Defined is displayed. 

 

 

Right click on the User Defined to Add new User Group. 
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Below screen appears. 

 

These are the inputs two add new User Group: 

1 Name  Type  Name of the new User Group 

2 Users in Data base Displays Users in Data base 

3 Users in Current Group Displays Users in Current Group 

4 
 

It enables to add Users from Database to Current Group 

5 
 

It enables to remove Users from Current Group 

Click on Add tab. 

We   can notice new User Group under the User Defined list. 
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Right click on the User Group, to perform actions like viewing Properties of the User Group, to 

find out where it is used, copying User Group, Duplicating User Group and Deleting User 

Group. 

 

 

46. Services 

In Firewall Builder, service objects are represented by IP, ICMP, TCP, and UDP services such as 

"host unreachable" in ICMP, HTTP in TCP, GRE in IP, and DNS in UDP. Firewall Builder plays a 

crucial role in providing  necessary service objects for hundreds of well-known and frequently-

used services in ICMP (IP protocol number 1), TCP (IP protocol number 6), and UDP (IP protocol 

number 17). 
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Expand Services, service Objects ICMP, IP,TCP ,UDP, Custom, Service Groups are displayed 

 

ICMP 

Expand ICMP, by default Standard and User Defined. 

 

Right click on Standard, to add new ICMP service 
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Select General tab, to givethe name of the ICMP object and choose the type of object from the 

drop down list in the Type tab 

 

 

Enable Any kind option and click on Add tab
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We can notice new Object under User Defined. 

 

Right click on the new ICMP Service object, to perform actions like viewing Properties of the 

ICMP Service object, to find out where it is used, copying ICMP Service object, Duplicating and 

Deleting ICMP Service object. 

 

IP  

Expand IP, by default Standard and User Defined. 



 
 

241 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 
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Right click on IP, to add new IP service 

 

Select General tab, give the name of the IP object and choose Protocol Number. 

Click on Add tab. 
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We can notice new IP object under User Defined. 

 

Right click on the new IP Service object, to perform actions like viewing Properties of the IP 

Service object, to find out where it is used, copying IP Service object, Duplicating and Deleting 

IP Service object. 
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TCP 

Expand TCP ,by default Standard and User Defined are displayed. 

 

 

Right click on TCP, to add new TCP service. 
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Select General tab, give the Name of the TCP object and choose Source port range, 

Destination port range. 

Click on Add tab. 

 

Select Flags tab, to enable Flags which need to be examined by the firewall.  

Click on Apply tab. 
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We can notice new TCP object in the User Defined option. 

 

Right click on the new TCP Service object, to perform actions like viewing Properties of the TCP 

Service object, to find out where it is used, copying TCP Service object, Duplicating and 

Deleting TCP Service object. 
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UDP 

Expand UDP ,by default Standard and User Defined are displayed. 

 

Right click on UCP, to add new UCP service. 
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Select General tab, give the Name of the UDP object and choose Source port range, 

Destination port range. 

Click on Add tab. 

 

 

We can notice new UDP object under User Defined. 

 

  



 
 

249 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

Right click on the new UDP Service object, to perform actions like viewing Properties of the 

UDP Service object, to find out where it is used, copying UDP Service object, Duplicating and 

Deleting UDP Service object.  

 

Service Groups 

Expand Service Groups, by default Standard and User Defined are displayed. 

 

Right click on Service Groups, to add new Service Group. 
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Below screen appears. 

Select General tab, give the name of the new Service object Group. 

We can copy and paste new Objects in this Service Object Group. 

Click on Add tab. 
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We can notice new Service Group under User Defined. 

 

Right click on the new Service Group, to perform actions like viewing Properties of the New 

Service Group, to find out where it is used, copying New Service Group, Duplicating and 

Deleting New Service Group. 
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Right click on the Service Group and select Properties.  

 

Below screen appears, name of the Service Group and list of Objects in this Service Group is 

displayed. 
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47. DoS/DDoS 

 

A Denial of Service (DoS) attack is a malicious attempt to make a server or a network resource 

unavailable to users, usually by temporarily interrupting or suspending the services of a host 

connected to the Internet. 

The most common type of Denial of Service attack involves flooding the target resource with 

external communication requests. This overloaded prevents the resources from responding to 

legitimate traffic, or slows its responses so significantly that it is rendered effectively 

unavailable. 

A Distributed Denial-of-Service (DDoS) attack is one in which a multitude of compromised 

systems attack a single target, thereby causing denial of service for users of the targeted 

system. The flood of incoming messages to the target system essentially forces it to shut down, 

thereby denying service to the system to legitimate users. 

In a typical DDoS attack, the assailant begins by exploiting a vulnerability in one computer 

system and making it the DDoS master. The attack master, also known as the boot master, 

identifies and identifies and infects other vulnerable systems with malware. Eventually, the 

assailant instructs the controlled machines to launch an attack against a specified target. 

*Source - www.searchsecurity.com 

 

 

 

 

Expand DoS & DDoS, by default User Defined is displayed. 

http://searchsoftwarequality.techtarget.com/definition/denial-of-service
http://searchnetworking.techtarget.com/definition/master
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Right click on Dos &DDoS, to add new DoS 

 

General 

Below screen appears. Select General tab it consists of two fields, Name & General Settings. 

In the Name field, name of the Dos object should be mentioned. 

In General Setting’s field, we can enable or disable Before Dnat, Log, Drop. 

 

SYN Flood 

SYN Flood helps us to view and change the SYN Flood Settings. 
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We can enable or disable SYN Flood, Per Source, Per Destination, and Total.  

Give the appropriate Count and Burst values. 

 

UDP Flood 

UDP Flood helps us to view and change the UDP Flood Settings. 

We can enable or disable UDP Flood, Per Source, Per Destination, and Total.  

Give the appropriate Count and Burst values. 
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CONN Flood 

CONN Flood helps us to view and change the UDP Flood Settings. 

We can enable or disable CONN Flood, Per Source, Per Destination, Total.  

Give the appropriate Count and Burst values. 

 

ICMP Flood 

ICMP Flood helps us to view and change the UDP Flood Settings. 

We can enable or disable ICMP Flood, Per Source, Per Destination, Total.  

Give the appropriate Count and Burst values. 

 

 

ICMPv6 Flood 

ICMPv6 Flood helps us to view and change the UDP Flood Settings. 

We can enable or disable ICMPv6 Flood, Per Source, Per Destination, and Total.  

Give the appropriate Count and Burst values. 
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Notes 

In Notes column, we can write information regarding new DOS Object.  

 

After providing all the inputs to the New Dos Object, click on Apply tab. 
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Click on Add tab. 

 

In the below screen, we can notice New Dos Object under User Defined. 

 

 

Right click on the New Dos object, to perform actions like viewing Properties of the Dos object, 

to find out where it is used, copying object, Duplicating and Deleting Dos object. 

 

 



 
 

259 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

48. QoS/Bandwidth 

QoS (Quality of Service) plays a crucial role in ensuring high-quality performance to latency and 

bandwidth sensitive applications. Differential treatment of traffic based on rules are accepted 

and prioritized. Necessary protocols and performance of the network is effectively improved by 

QoS. 

 

 

Expand QoS/Bandwidth, by default User Defined is displayed. 

 

Right click on User Defined under QoS/Bandwidth, to add new QoS/Bandwidth. 

 

General 

To make a new QoS/Bandwidth, select General tab. 

Give the name of the QoS/Bandwidth object. 
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 Give appropriate values for Rate (Mbit/s), Ceil (Mbit/s), Burst (Byte) and Priority in 

QoS/Bandwidth Settings. 

Choose Interface for the New QoS/Bandwidth object from the list of Interfaces. 

 

 

Choose between per ip or shared, for your rule’s purpose. Then press apply to save changes. 

Notes 

Select Notes tab to write notes regarding new object creation. 
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Click on Apply tab. 

 

In the below screen we can notice QoS/Bandwidth object. 

 

Right click on the new QoS/Bandwidth object, to perform actions like viewing Properties of the 

QoS/Bandwidth object, to find out where it is used, copying object, Duplicating and Deleting 

QoS/Bandwidth object. 

 

 

 

49. Schedule 

Firewall rules are scheduled in such a way that they must be Active only at certain times of the 

day or particular days or particular hours and minutes. 

Firstly schedule should be created under Firewall and then apply a schedule to the rule or while 

creating a rule pick up appropriate defined schedule to the rule. 



 
 

262 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

We can create one time schedule or recurring time schedule. One time schedule is applied only 

once for the specified period in the schedule, recurring time schedule are applied repeatedly at 

specified times. 

 

 

 

Standard 

Expand schedule, Standard and User Defined is displayed. 

 

Expand standard, by default some schedule objects are displayed under Standard Schedule. 

 



 
 

263 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

Right click on the schedule object, to perform actions like viewing Properties of the Schedule 

object, to find out where it is used, copying object, Duplicating and Deleting Schedule object. 

 

 

50. User Defined 

Right click on User Defined to Add new Time Definition. 

 

General 

Select General tab, Give the name of new time Object in the Name field. 
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Click on Add tab. 

Start 

Schedule object start time should be mentioned in this section, select Start tab. 

 

 

These are the inputs for Start 

1 Active date Enable Active date to choose start date from the calendar 

2 Active hour Enable Active hour to choose starting  hours and minutes 

3 Active day Enable Active day to choose starting day from drop down list 

 

After choosing appropriate date, hour and day disable Active mode of date, hour, day and click 

on Apply tab 
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Stop 

Schedule object stop time should be mentioned in this section, select Stop tab. 

 

 

1 Active date Enable Active date to choose stop date from calendar 

2 Active hour Disable Active hour for not mentioning stop hour and minutes 

3 Active day Enable Active day to choose  week day  

 

Notes 

Select Notes tab, to write necessary information regarding time Object. 
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Click on Apply tab. 

We can notice new time Object in the below screen. 

 

Right click on the schedule object, to perform actions like viewing Properties of the Schedule 

object, to find out where it is used, copying object, Duplicating and Deleting Schedule object. 
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51. Application Control 

Using Application Control in firewall enables us to block applications based on Users or User 

Groups. So, that you can control risky port and protocol hopping applications before they get 

in.You can also reduce your attacks surface by enforcing mobile applications and social media 

application policies. You can even control bandwidth 

 

User Defined 

Expand Application Control, by default User Defined is displayed. 
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Right click on User Defined to add new Application Group. 

 

 

Creating new application group 

 

These are the inputs for new Application Group. 
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1 Name Type the name of the Application Group 

2 Application in 
Database 

It displays list of Application in Database 

3 Application in Current 
Group 

It displays list of Applications in Current Group 

4 
 

This symbol enables to add Applications in to Current Group from Database 

5 
 

This symbol enables to remove Applications from  Current Group to Database 

 

In the below screen we can notice new Application Group. 

 

 

Right click on the Application Group, to perform actions like viewing Properties of the 

Application Group, to find out where it is used, copying Application Group, Duplicating and 

Deleting Application Group. 
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52. Firewall 

Firewall is a concept which blocks unwanted traffic and passes desirable traffic to and from 

both sides of the network. 

A firewall is a system (either software or hardware or both) that enforces an access control 

policy between two networks. 

Example:  

 Allows: http, mails etc 

 Keeps out : Intruders ,Denial of services attacks, spam etc. 

 

 

53. Labris Firewall Management 

Install, Save (create a new policy object for first setup), Install Policy 
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Creating new policy firewall object 

Give the Name of the Object in the Name tab, by default Network Interfaces have been 

selected for the new firewall object and click on Add tab. 

 

 

 

 

 

Below screen appears stating   Welcome to Labris Firewall Policy Maker. 
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Now we have created a new firewall object and we will configure it now. 

 

 

 

Add Next Generation Firewall 

First step: 

Create Global policies 
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Global policy   

Global policies in one logical system are in a separate context than other security policies. 

According to the source from the target set on the way to the Objects or forbids. In addition, 

these rules can be imported  from the previously created Network Objects(Hosts, Networks, 

Addresses, Address Ranges, Object  Groups and Users), Services (ICMP,IP,TCP,UDP, Custom, 

Service Group), DoS/DDoS Objects, QoS(Bandwidth Management) Objects can be added to the 

schedule Objects for controlling application profiles. 

Second step: 

Create NAT Policies 

NAT Policy 

NAT: It is a service of routing provides network address translation from private to public 

When we have 2 networks public & private in order to protect private network from public 

network (intruders) we need NAT. 

NAT enables one way communication. i.e. private network can communicate with public 

network but not vice versa. 

NAT policies 

It allows you to control Network Address Translation based on matching combinations of 

Source IP address, Destination IP address, and Destination Services.  

For example, a lot of the IP subnet address from internal network will route to outside network 

with single IP address. 

Third step: 

Physical interfaces 

The physical interface that are supported by the device and subsequently added to the 

interface listed in the area. 

This field contains the interfaces for the WAUTH interface, Dynamic source address translation 

interface, and the external network interface definitions. 
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Firewall Properties 

 Interface - Use this property to match which network port or data link packet is 

traversing such as "eth0" for Ethernet built-in. 

 Source MAC Address - Use this property to specify an Ethernet Hardware Address that 

matches the source MAC (Media Access Control) address in the link layer frame header. 

 Destination MAC Address - Use this property to specify an Ethernet Hardware Address 

that matches the destination MAC (Media Access Control) address in the link layer 

frame header. 

 Source Net - Use this property to specify a single IP address or network range that 

matches the source IP address of a packets IP header. 

 Destination Net - use this property to specify a single IP address or network range that 

matches the destination IP address of a packets IP header Network ranges can be 

specified as address1-address2. 

 Protocol - Use this property to specify the protocol number that appears in a packets IP 

header. 

 IP Options - Use this property to specify the IP option numbers that appear in a packets 

IP header. 

 ICMP Type - Use this property to specify the ICMP type that appears in a packets ICMP 

header. 

 ICMP Code - Use this property to specify the ICMP code that appears in a packets ICMP 

header. 
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 TCP Header Flags - Use this property to specify the TCP header flags that appear in a 

packets of TCP header. 

 TCP Options - Use this property to specify the TCP option numbers that appear in a 

packetsof TCP header. 

 Destination Port - Use this property to specify a single protocol port or range of 

protocol ports that matches the destination port of a packets TCP or UDP header. Port 

ranges can be specified as port1-port2. 

 URL Keyword - Use this property to search for keywords that appear within a HTTP 

(web site) URL. 

 Parent Match Count - Use this property to notify you if the parent rule has been 

matched a specified number of times. 

 Parent Byte Count - Use this property to notify you if the parent rule has been matched 

by network traffic containing a specified number of bytes. 

Right click on Firewall object to view Properties of firewall object. 

Select General tabto view details about Name of the Firewall object. 

We can change name and click on Apply tab to change the name. 

 

 

Select Options tab. 
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We can Enable or Disable Options Firewall is part of “ANY”, Accept TCP sessions opened prior 

to firewall installation, Accept ESTABLISHED and RELATED packets before first rule. 

 

Click on Apply tab to apply changes to the firewall object. 

Select Notes tab to write information regarding firewall object (Optional). 
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Click on Apply tab to apply changes. 
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Select SSH Inspecting tab 

We can Enable or Disable Allow HTTP request through SSH port forwarding, Allow SCP, Allow 

shell login, Allow sftp. 

 

Click on Apply tab to apply changes 

 

Global Policy table 

Global policy table is displayed with the fields Source, Destination, Service, Action, Schedule, 

QoS/Bandwidth, Application, Security policy, Options. 

How to add new Global policy? And what can be done? 

Example1: My host objects for policy

 

My global policy  
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In the above screen we can notice columns such as Source, Destination, Service, Action, 

Schedule, QoS/Bandwidth, Application, Security Policy, Options. 

Application is allowed if the created Source with interfaces INSIDE & OUTSIDE is accessed, and 

when the Destination, Service, Schedule, QoS/Bandwidth, Application, Security Policy options 

are Selected as ANY. We can even drag-and-drop the desired objects created earlier, or copy 

and paste can be added with it. 

Example 2: My network objects for policy. 

 

All of the destinations on the IP addresses of the source of the rule INSIDE_Net with access to 

only the specified services. This rule also holds at their outer radio marker internal IP addresses 

on the policy. 

Example 3: How do we add a rule for users and My.applicaiton.info.stacktrace users with QoS, 
control, DDOS and schedule how do we apply. 
 
 

 
The rule previously created users ((For creating users please refer to users section in User 

Management ) in the same way as the example demonstrates how to use the drop-down with 
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the yerede rule, let's link the current field) and user network appeal (For adding users in 

Network objects please refer to users field in Network Objects Section)owed as the source, 

and again before our Schedule-appeal (Please refer to Schedule section in Network Objects 

and the link in the same was the example demonstrates how to use the drop-down with the 

yerede rule, let's link the current field),QoS-appeal (Please refer to Qos/Bandwidth section in 

Network Objects here's the link and the link in the same way as the example demonstrates 

how to use the rule drop down yerede with the current field link), and DoS/DDoS previously 

created object located at the source by placing the user in the appropriate fields in the rule or 

the rope according to the specified criteria. 

 

 How to add an application control rule for users? 
 

 

 

The rule previously created users ((For creating users please refer to users section in User 

Management ) and here is the link in the same way as the example demonstrates how to use 

the drop-down with the yerede rule, let's link the current field) and Application control profile 

(Please refer to Application control section in Network Objects and here is the link in the same 

way as the example demonstrates how to use the drop-down with the yerede rule, let's link the 

current field). 

Read all the rules in the table. Buy why you must be careful when writing the canonical 

ordering Application control. If the source specified in the rule is a rule used in the queues and 

objects in higher action has been ruling on the accept or deny rule. 

Example 4: The outside should be accessed with specific protocols for access to the web or 
other services to the rule writing. And create a new NAT policy (NAT policy Please refer 
Example2) 
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For example, one in which each web server and outside a place gave over to access http and 

https protocols. The source column of the address will be "any", which is the target column 

because the target to a specific server to be accepted through the "host object" (for creating 

hosts object Please refer to Hosts field in Network object section here is the link to give the 

host object will be created in the same manner as the host and the creation stage of the policy 

section and use the example currently in the link). 
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NAT (Network Address Translate) Policy table 

NAT Policy table is displayed with the fields Original Src, Original Dst, Original Srv, Translated 

Src, Translated Dst, Translated Srv, Comment. 

In this section, in accordance with the global policy also created the device permissions, 

changing the status of the source, destination, and services will write the rules. 
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Example1: Internet NAT policy 

 

For example, a lot of the IP subnet address my device contains and leave all our internet users 

out of their IP addresses through a single IP address we need over. So we have to translate the 

network address. 

IP subnet is 255.255.255.0 and your default gateway is 192.168.168.1 and 192.168.168.0 

considering the need to build rule my IP Address; a of range IP address and target the source 

192.168.168.0 255.255.255.0 on the Internet as a place to which "any" and all the services in 

the same way that any change in the subverted will be converted to the destination address in 

the above policy, such as changing to run assuming the IP address. In our example, changing IP 

address is 192.168.168.1 
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Example2: Web server access from Wide Area Network.  

 

Any source outside web server "any" http and https access to the supplier global policy is 

written as (For global policy please refer to ADD Next generation firewall section)  and later to 

the server on specific ports from outside should identify which requests inside. 

Example 3: Web Filter service enables. 

Internet web filter service requests that returning web filtering. The following rule is written to 
the NAT policy. 
 

 

The resources specified in the rule, the user/user group, IP addresses/IP range, in the case of 

http service running on the device to web subnet, IP filter rule is required to be sent to the 

service. This rule should be written to all devices with web filtering. (For web filter please refer 
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to Filters section here is the link to the web filter also web filter configuration screens to give 

the link). 
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Interfaces 

By default seven Interfaces are present in the firewall object. 

They are eth0, eth1, eth2, eth 3, eth4, eth5, tun0. 

Select General tab, Name of the interface is displayed. 
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Select Settings tab, we can Enable or Disable Dynamical source Address Translation, This 

interface is an external network interface. 
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Select Notes tab, to write information regarding Interface (Optional). 
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Select WAUTH tab, we can   enable or disable options like Active, Use SSL Connection, Use 

Default Gateway IP 

 

Firewall Application 

 The Web Application Firewall (WAF) protects applications from current and future 

security threats by combining multiple security engines into a cohesive Web 

defense. 

 Not like a “normal” firewall- Applies rules to HTTP conversations 

 Allow or deny based on expected input – Unexpected input is a common method of 

exploiting an application. 

 SQL injection – Add your own commands to an application’s SQL query. 

 A major focus of payment card industry, Data Security Standard (PCI DSS). 

 

SSH Inspection 

Labris SSH Inspector provides an easy and effective way to limit actions allowed over ssh. Its 
engine detects the internals of ssh traffic and allows administators to manage and log ssh 
traffic in depth. Administators can allow/block/log shell login, sftp, scp or HTTP request through 
ssh port forwarding. 
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Enabling SSH Inspection 

SSH Inspection configuration is done in firewall object settings under Firewall module. 
 

 

In firewall object properties administrators can choose which actions will be enabled in ssh 
traffic. 
 

 

 

Restricting SSH Activities 

 
In Firewall module under NAT Policy administrators decide which users will be redirected to 
SSH Inspector. 
 
Administrators add users/hosts/networks to be restricted to Original Src of NAT rule, port 
number of SSH service to Original Srv, internal interface IP of restricted network to Translated 
Dst and port number of SSH Inspector to Translated Srv. 
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After installing NAT rule SSH traffic of users will be inspected by Labris SSH Inspector and 
unauthorized actions will be blocked. 
 

Monitoring SSH Activities 

 
SSH activities of users are logged under /var/log/labris/sshinspection and can be monitored by 
accessing Labris UTM over ssh. 
 

 
 

Usage Notes About Labris SSH Inspector 

 

 When using Labris SSH Inspector clients should accept Labris SSH Inspector's SSH key as 
their remote SSH server key. 

 When using Labris SSH Inspector remote SSH key changes are not visible to clients 
behind Labris SSH Inspector. 

 

Network Address Translate (NAT) 

Network Address Translation is used to communicate the internal network to internet. It will be 

configured in the Router. 

What is the NAT? 

Network Address Translation is nothing but converting a group of computers IP Address to 

communicate or to send the packets to the outside of the world through the internet. 

Whenever the host computer in a Network need to send packets to the other internet user it 

will be possible through the Router. In the router it must be configured for the communication 

between outside of the internet user and host computer in a company LAN Network. The 

router only will take care the changes in IP address whenever sending and receiving the packets 

to and from outside of the network and internal LAN. It will be configured in Router in a table.  

Why it is made? 

In the whole world there are billions of computers. For communication between them they 

need unique IP Address like our street numbers and door numbers .NAT is a network 

protocol used in IPv4 networks that allows multiple devices to connect to a public 

network using the same public IPv4 address. NAT was originally designed in an attempt to 

help conserve IPv4 addresses.  NAT has become a common, indispensable feature in routers for 

home and small-office Internet connections. 
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NAT Types 

There are three types of NAT 

SNAT 

Static NAT: In this type, host computer will have particular IP Address to communicate with 

outside network. It is used for one device to communicate with outside network. 

DNAT 

Dynamic NAT: In this type, Router will assign the IP Address to communicate with outside 

network. It is used for communication of group of computers with outside network.  

PAT 

 PAT (Port Address Translation): This is the type of dynamic, but it will map multiple 

unregistered IP Addresses to registered single IP Address using port numbers called Port 

Address Translation. 

Port Forwarding/Port Mapping 

Port Forwarding is also known as Port Mapping is the process that a router uses to sort the right 
kind of network data to the right port. Computers and routers use ports as a way to organize 
network data. Different types of data, like web sites, file downloads, and online games, each are 
assigned a port number. The router or firewall uses forwarding to send the correct data to the 
correct place. 

A firewall protects a computer by blocking unauthorized information, but if a firewall blocked all 
the incoming and outgoing data, the computer would be unable to access the Internet. When a 
computer user wants some data to go through the firewall and to send it to a specific location, 
he can set up port forwarding. This gives the firewall instructions about which types of data are 
allowed and how they should be directed. 

Information on the Internet is associated with a port. Web pages, for example, are typically 
assigned port 80. File transfer protocol (FTP), often used for downloading and uploading files, 
typically uses port 21. Online games may use a number of different port numbers, but often 
choose numbers in the thousands. 

 Port forwarding also serves as another way to protect computers. People outside the network 
will only have access to the router or firewall, which will, in turn, control which types of data 
reach the computers. Any data that does not come to the router with the correct port will not 
be passed through to the computers inside the network. 

Reverse Proxy engine 
 

Reverse proxy engine is the feature for proxying web sites hosted on different real server with 
different internal IPs through a single public IP address. Engine welcomes any incoming web 
connection to your web sites. Then, fetch the web site data from the real server in your LAN or 
DMZ and gives to the client.  
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For example, any incoming web connection to your public IP (for example 85.10.10.10) will be 
welcomed by the engine. There may be several web sites be hosted on this IP address. These 
web sites may be hosted in different real/virtual machines inside your network. The engine will 
bring web sites from where they are located and give to the client. 
 
The engine is configured through a configuration file on current version. (/etc/sysconfig/Labris-
reverseproxy.conf). Configuration options and remarks are explained in the following table. 
 
  

[options] 
listen_port=2480 
listen_port_ssl=2443 
  

"listen_port" and "listen_port_ssl" attributes are 
used for configuring listen ports for http ad https, 
respectively. 
Default value should be used, if there are not any 
special conditions. 

default_certificate_file=/etc/httpd/certs/server1.crt 
default_certificate_key_file=/etc/httpd/certs/privkey.pem 

These attributes used for setting SSL certificates 
which are used for terminating SSL connections. 

[revproxy1] 
original_website_name=www.labrisnetworks.com 
incoming_conn_type=nonssl 
realserver_conn_type=nonssl 
realserver_conn_url=http://www.labrisnetworks.com/ 

A block of variables are defined for each web site 
served through this reverse proxy engine.  
Each block has a name which is enclosed between 
“[  ]” and should include 4 attributes. 
 
"original_website_name" attribute is the web site 
name that the end user uses in his/her web 
browser to request your web site. 
 
"incoming_conn_type" attribute defines incoming 
connection type. Options are "ssl" and "nonssl". 
  
"realserver_conn_type" attribute defines protocol 
with the real server hosting the web site. Options 
are "ssl" and "nonssl". 
  
"incoming_conn_type" and 
"realserver_conn_type" attributes are also used for 
terminating a SSL connection and fetching data 
from a nonssl web server. 
  
"realserver_conn_url" attribute defines the address 
for the real web server inside your networks. Each 
definition should end with a “/”. Internal IP 
addresses for the real servers are defined in hosts 
file (etc/hosts) or in first DNS forwarder server.  

  
After configuring the engine itself, traffic should be redirected to the engine. 
 

1. First of all traffic should be allowed. Traffic coming into YourPublicIP:2480 and 
YourPublicIP:2443 should be allowed. 
 
Example Global Policy; 
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2. HTTP/HTTPS traffic should be redirected into the engine. Traffic coming into 
YourPublicIP:80 (or other http port) should be redirected to UTM_IP:2480 (or 
configured listen_port). Traffic coming into YourPublicIP:443 (or other https port) 
should be redirected to UTM_IP:2443 (or configured listen_port_ssl). 
 

Example NAT Policy; 
 

 
 
  

54. Sample configuration: 

  
/etc/sysconfig/labris-reverseproxy.conf: 
  
;options must be set 
[options] 
listen_port=2480 
listen_port_ssl=2443 
; default certificate will be using on a ssl connection if any 
; certificate for VirtualServer defined 
; default_certificate_file=/opt/labris/etc/labris-lmc/certs/server.crt 
; default_certificate_key_file=/opt/labris/etc/labris-lmc/certs/server.key 
default_certificate_file=/etc/httpd/certs/server1.crt 
default_certificate_key_file=/etc/httpd/certs/privkey.pem 
  
; Configuration parameters for VirtualServer setup 
; numbers at the end of section names (revproxy*) 
; must be increased sequentially 
; (but writing order can be random) 
; following configuration examples demonstrate connection types 
; (incoming_conn_type - realserver_conn_type) 
; non-ssl - non-ssl 
; ssl - non-ssl 
; non-ssl - ssl 
; ssl - ssl 
  
  
[revproxy1] 
original_website_name=www.labrisnetworks.com 
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incoming_conn_type=nonssl 
realserver_conn_type=nonssl 
realserver_conn_url=http://www.labrisnetworks.com/ 
  
[revproxy2] 
original_website_name=www.labrisnetworks.com 
incoming_conn_type=ssl 
realserver_conn_type=nonssl 
realserver_conn_url=http://www.labrisnetworks.com/ 
 

VPN 

VPN stands for Virtual Private Network. It is a Private Network which allows us to connect to 

public network remotely in a secured way. 

Personal VPN's allow you to encrypt your data from being sent from your computer to a VPN 

Server. This prevents hackers from stealing your information when you access the Internet 

from a public Wi-Fi. VPN’s can be used for several other things, than just getting passed 

blocked sites, use Windows Firewall to block non-VPN traffic for selected applications, e.g. your 

torrent client, a browser, download manager, etc. When using a VPN to secure a public Wi-Fi 

spot.  

From using your ISP connection, permit it to connect the the Internet using only the VPN 

connection. Unfortunately, this will not work with the built-in firewall in Windows XP or Vista. 

Right click on the VPN tab and select Connect. 
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IPSEC VPN Configuration 

55. Profile Administration; 

It is the section where IPSEC Profile definitions are made. 

 

1 Profile Administration Manage IPSEC Profile 

2 Add Profile Create a New IPSEC Profile 

3 Edit Profile Edit Selection IPSEC Profile 

4 Delete Profile Delete Selection IPSEC Profile 

 

Step 1: 

56. Add Profile 

It is used to create a new IPSEC Profile. 

 

1 Profile Name IPSEC Profile Name 

2 Active Status Active / Passive 

3 Description Description for IPSEC Profile 

4 Select Policy Select Policy for FAZ1 and FAZ2 
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5 Add Policy Add New Policy Profile. Click for Details or Example 

6 Identity Confimation Shared Key 

7 Identity Confimation RSA. Click for Details or Example 

8 Shared Key Shared Key Input 

9 Show Password Show Shared Key 

10 Local WAN IP Select Local WAN Interface 

11 Local Networks (Automatic) All Local Networks Route Remote Network 

12 Add Local Networks (Manuel) Add Local Networks or IP Address Manuel 

13 Edit Local Networks (Manuel) Edit Local Networks or IP Address Manuel 

14 Delete Local Networks (Manuel) Delete Local Networks or IP Address Manuel 

15 Local IP Local IP Active / Passive 

16 Local ID Lacal ID Active / Passive 

17 Local IP Select Local IP from List 

18 Local ID Local ID Input 

19 Select All Remote Networks Select All  

20 Add Remote Networks Create a Remote Networks Button Click for Details or Example 

21 Edit Remote Networks Edit Remote Networks 

22 Delete Remote Networks Delete Remote Networks 

23 Filter Filter Remote Networks Input 

24 Save Save IPSEC Profile 

25 Cancel Cancel IPSEC Profile 

26 Advanced Settings Advanced Settings Button 

 

57. Identity Confirmation RSA; 

RSA (Rivest Shamir Adleman) 

It is the section where common security key, used in the stage of establishing 

connection with the remote network with which IPSEC VPN will be made, is defined. 

RSA is an internet encryption and authentication system. 
 

 
 
 

1 RSA Identity Confirmation for RSA 

2 Create RSA Key RSA Key Execute Button 

3 Local Local RSA Key Input 

4 Remote Remote RSA Key Input 
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58. Add Local Networks (Manuel); 

It is the section where local network or IP addresses which can communicate with the remote 
network with which IPSEC VPN will be made, are defined. 
 

 
 

1 Select Select Network or IP Address from Database 

2 New Create a New Network or IP Adress 

3 IP Create a New IP Address 

4 Network Create a New Network 

5 Name Network Name 

6 Network or IP Address Network or IP Address Input 

7 Netmask Netmask for Network 

8 Save  Save Configuration 

9 Cancel Cancel Configuration 

 

59. Add Remote Networks; 

It is the section where local network or IP addresses in the remote network with which IPSEC 
VPN will be made, are defined. 
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1 Active Remote Network Projile Active/Passive 

2 Auto Start Connection Auro Start When Disabled 

3 NAT Traversal NAT Traversal Active/Passive 

4 Remote Name Name for Remote Network 

5 Remote WAN IP Remote Static WAN IP Address 

6 Local Networks (Automatic) All Local Networks Route Remote Network 

7 Add Local Networks (Manuel) Add Local Networks or IP Address Manuel 

8 Edit Local Networks (Manuel) Edit Local Networks or IP Address Manuel 

9 Delete Local Networks (Manuel) Delete Local Networks or IP Address Manuel 

10 Remote IP Remote IP Active / Passive 

11 Remote IP Input Remote IP Input 

12 Remote ID Remote ID Active / Passive 

13 Remote ID Input Remote ID Input 

14 Genarate Firewall Rule Autımatically Add Firewall Rule Automatically for Remote Network Access 

 
 

60. Policy; 

It is the section where IPSEC PHASE1 and PHASE2 definitions are assigned to created profile. 
 

 
 

1 Policy Manage IPSEC Profile 

2 Select All Select All Policy 

3 Add Create a New Policy 
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4 Edit Edit Selection Policy 

5 Delete Delete Selection Policy 

 

Step 2: 

61. Add Policy 

It is the section where connection method and policy general definitions before IPSEC PHASE1 

and PHASE2 are made. 

 

 
 

1 Policy Name Policy Name Input 

2 Description Description for Policy 

3 Main Mod Connection Mod is Main 

4 Aggressive Mod Connection Mod is Aggressive 

5 Ikev2 Mod Connection Mod is Ikev2 

6 Compact Data Transfer Compact Data Transfer Active / Passive 

7 Fragmented Packet Handing Fragmented Packet Handing Active / Passive 

8 Re-keying Enable Re-keying Enable / Disable 

9 Key Tries Key Tries Value Input 

62. Add PHASE-1; 

It is the section where settings such as Encryption, Authentication, Connection times, The method to 

follow in case of disconnection, are defined. It is required that the configuration made here is mutually 

equal with the settings in the second place with which IPSEC VPN connection will be made. 
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1 Encryption Encryption Metod 

2 Authentication Authentication Metod 

3 Encryption-More Encryption Metod 

4 Authentication-More Authentication Metod 

5 Encryption-More Encryption Metod 

6 Authentication-More Authentication Metod 

7 Key Life Time Key Life Time / Sec 

8 Rekey Margin Rekey Margin / Sec 

9 Randomize Re-keying Margin Randomize Re-keying Margin / % 

10 Diffie Hellman Groups-1 Dh Groups -1 / 768 bit 

11 Diffie Hellman Groups-2 Dh Groups -2 / 1024 bit 

12 Diffie Hellman Groups-14 Dh Groups -14 / 2048 bit 

13 Diffie Hellman Groups-15 Dh Groups -15 / 3072 bit 

14 Diffie Hellman Groups-5 Dh Groups -5 / 1536 bit 

15 Diffie Hellman Groups-16 Dh Groups -16 / 4096 bit 

16 Dead Peer Detection Dead Peer Detection Active / Passive 

17 Action Action : Restart / Clear / Hold 

18 Delay Delay Time / Sec 

19 Timeout Connection Timeout / Sec 

20 Save  Save Configuration 

21 Cancel Cancel Configuration 

63. Add PHASE-2; 

It is the section where the second PHASE settings such as Encryption, Authentication, Connection 
times, are defined. It is required that the configuration made here is mutually equal with the settings in 

the second place with which IPSEC VPN connection will be made. 
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1 Encryption Encryption Metod 

2 Authentication Authentication Metod 

3 Encryption-More Encryption Metod 

4 Authentication-More Authentication Metod 

5 Encryption-More Encryption Metod 

6 Authentication-More Authentication Metod 

7 Key Life Time Key Life Time / Sec 

8 PFS Groups (DH) PFS Groups Active / Passive 

9 Diffie Hellman Groups-1 Dh Groups -1 / 768 bit 

10 Diffie Hellman Groups-2 Dh Groups -2 / 1024 bit 

11 Diffie Hellman Groups-14 Dh Groups -14 / 2048 bit 

12 Diffie Hellman Groups-15 Dh Groups -15 / 3072 bit 

13 Diffie Hellman Groups-5 Dh Groups -5 / 1536 bit 

14 Diffie Hellman Groups-16 Dh Groups -16 / 4096 bit 

15 Save  Save Configuration 

16 Cancel Cancel Configuration 
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Step 3: 

64. Add Global Policy 

For Remote Network access permissions in cases where Generate Firewall Rule 

Automatically option is not selected, Step 3 and Step 4 must be applied. 

 

 

Step 4: 

65. Add NAT policy 

 

 

66. Delete Profile 

Select Delete profile to delete Connection. 
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Then a screen appears prompting Are you sure you want to delete connection Test VPN, click 

on Yes tab to delete connection. 

 

Below screen appears stating Changes saved, click on Ok. 

 

67. Connection Tracking; 

 

IPSEC Connection Monitoring / Status, Send and Recive Bytes/Package, Phase-1/Phase-2 

ReAuthentication Status. 

 

SSL VPN Configuration using CLI. 

Open CLI using root user 

Step 1: 

For SSL VPN, sample Configuration file is copied to relevant folder. labris-ssl-vpn.conf file is 

edited taking the following sample as base. 

# cd /etc/openvpn/ 
# ls 



 
 

305 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

samples 
 

# cp -a samples/labris-ssl-vpn/* . 
# ls -ltr 
labris-ssl-vpn labris-ssl-vpn.conf up-down.sh  samples 
 
# vim labris-ssl-vpn.conf 
 

And edit labris-ssl-vpn.conf; 

#SSL VPN client using ip address (SSLVPN Network) 

server 172.16.0.0 255.255.255.0 

# Change Maximum online client count 
max-clients 100 
 
# access to Local Area Network address (INSIDE Network) 
push "route 192.168.2.0 255.255.255.0" 
 
Step 2: 

68. Create a new global policy 

 INSIDE Network access to SSLVPN Network and SSLVPN Network access to INSIDE Network. 

 

Step3: 



 
 

306 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

69. Create a new NAT Policy 
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Step4: 

Select a SSL VPN User (Please refer User Management section to add user) and add/Select VPN 

user (Please refer SSl VPN Client section for VPN User Administration  Add) 

 

Step5: 

70. Add a user on policy. 

(Please refer to Users in Object Group section for Create Network Object  Users) 

 

71. SSL VPN CLIENT - User Administration 

The management part deals with adding user names and passwords to electronic directories 

along with the assignment of rights to data and network resources such as files, databases, 

printers, Internet. Maintenance includes updating the directories when employees change their 

job classifications or departments or leave the company. 
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In the right pane under VPN Main, select SSL VPN CLIENT - User Administration. 

 

1 Select All Select All Users 

2 Delete Delete Selection User/Users 

3 Edit Edit Selection User 

4 Add Add User 

5 Settings Setting SSL VPN CLIENT 

 

SSLVPN Client 

 

SSL VPN (Secure Sockets Layer virtual private network) is a form of VPN that can be used with a 

standard Web browser. In contrast to the traditional Internet Protocol Security (IPsec) VPN, an 

SSL VPN does not require the installation of specialized client software on the end user's 

computer. It is used to give remote users with access to Web applications, client or server 

applications and internal network connections. 

An SSL VPN consists of one or more VPN devices to which the user connects by using his Web 

browser. The traffic between the Web browser and the SSL VPN device is encrypted with the 

SSL protocol or its successor, the Transport Layer Security (TLS) protocol. An SSL VPN offers 

versatility, ease of use and granular control for a range of users on a variety of computers, 

accessing resources from many locations 

 

 

Add 

Click on Add tab 
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Below screen appears. 

 

These are the inputs adding User to SSLVPN Client 

1 All Users All the Users  are displayed  in this field 

2 Selected Users Selected Users are only displayed in this field 

3 
 

This symbol helps us to add Users  to Selected Users from All Users 

4 
 

This symbol helps us to remove User from Selected Users list 

Click on Ok to add User. 

Adding User is in Progress 

 

In the below screen we can notice Selected User added to the SSLVPN Client. 
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Edit 

Select User and click on Edit tab 

 

Edit User tab appears, we can only edit IP Address and click on Ok tab. 
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Editing User is in Progress. 

 

 

In the below screen, we can notice IP Address has been changed. 

 

 

Delete 

Select User and click on Delete tab. 

 

Then below screen appears, Click Ok to delete. 

 

Deleting Process is in progress. 

 

Below screen appears displaying information, Selected records have been deleted. Click on Ok 

to close the current tab. 
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Settings 

Click on Settings tab to view and change the Settings of SSL VPN Client. 
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AD Settings tab appears. 

 

1 Group Authorizing We can enable or disable this option 

2 Domain Name Domain Name is selected by default 

3 Work Group Work Group is selected by default 

4 AD Group Select AD Group from the group table. 

Click on Ok. 

L2TP 

L2TP uses packet-switched network connections to make it possible for the endpoints to be 

located on different machines. Layer Two Tunneling Protocol (L2TP) is an extension of the 

Point-to-Point Tunneling Protocol (PPTP) used by an Internet service provider (ISP) to enable 

the operation of a virtual private network (VPN) over the Internet. 

The two main components that make up L2TP are the L2TP Access Concentrator (LAC),which is 

the device that physically terminates a call and the L2TP Network Server (LNS), which is the 

device that terminates and possibly authenticates the PPP stream. 
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Add 

Enable L2TP connection to view and change settings of L2TP and to Add, Edit, Delete Users to 

L2TP. 

Click on Add tab 

 

Add User tab is appeared. 

 

 

These are the inputs to add an User. 
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1 Name Type the name of the User 

2 Password Type the Password for the User 

3 IP We can enable default IP or give an IP within the IP range 

 

Click on Ok to add User. 

In the below screen, we can notice new User added to the Users list of L2TP within the IP 

Range. 

 

Edit 

Select the User and click on Edit tab. 
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Below screen appears. 

We can edit Name, Password and the IP of the User. 

 

Click on Ok. 

We can notice the changes made to the User in the below screen. 
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Delete 

Select the User and click on Delete tab.

 

Delete User tab appears with User name, click on Yes tab to delete the User. 

 

We can notice the selected User deleted. 

 

72. Service Management 

In the right pane under VPN tab, select Service Management. 

 

1 VPN Connection Type VPN Connection Type List 
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2 Status Connection Status 

3 Action Connection Start / Stop / Restart 

FILTER 

 

Filters are rule sets that control the flow of traffic into and out of a device. it consists of a series 

of from-then statements 

You cannot apply more than one firewall filter per port, VLAN or router interface per direction 

input and output. For example, for a given port you can apply at most one filter in the input 

direction and one filter in the output direction. You should try to be conservative in the number 

of terms that you include in each filter, because a large number of terms require longer 

processing time during a commit operation and can make testing and troubleshooting more 

difficult.  

 

The purpose of the filter is system can drop packets based on header information, rate-limit 

traffic, classify packets into forwarding classes, log and count packets or prevent denial of 

service attacks. 
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Right click on Filter and select Connect. 

 

73. Filter Groups 

 

Add New Filter Policy 
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These options will be exposed to the web filter. 

 

Add/Edit Filter Group 

Click on Add icon to add a filter group. 

 

Add Group tab appears, Give the Name of the Group and click on Ok. 
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In the below screen we can notice new Filter Group added in the list. 
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Editing Filter Group

 

These are the inputs for Filter Groups  

1 Name  We can edit name of the filter group 

2 Default Group Choose Default Group from the drop down list 

3 Mode Choose  Mode type from the drop down list 

4 Filtering Level Choose Filtering level form the drop down list 

5 Anti-virus Scanning We can Enable/Disable this option 
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Click on Save icon to save the Group configuration

 

Delete Filter Group 

Click on the Remove icon to Delete Group.

 

Delete Group tab appears, click on Yes to Delete Group. 
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In the below screen we can notice Filter Group deleted. 

 

Time limit 

Time limit enables us to set up Starting time and ending time of the Filter Groups. 

 

Add Time 

Click on Add time tab 
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Time Limits tab appears. 

 

These are the inputs for adding Time Limit. 

1 Start Time Choose the starting time 

2 End Time Choose the ending time  

3 Days We can enable specific days  

Click on Ok. 

In the below screen, we can notice Time Limit  
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Delete Time 

Select the Time Limit and click on Delete tab. 

 

In the below screen we can notice Time Limit deleted. 
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Add Users 

Click on Add Users tab 

 

 

 

 

 

 

 

 

 

 

Add Members tab appears, in which we can choose Members and click on Ok. 
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In the below screen, we can notice selected Members added to the Filter Group. 

 

 

 

 

Add Groups 

Click on Add Groups tab. 
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Add Members tab appears, select the Groups and click on Ok. 

 

In the below screen, we can notice Group added in the Users list. 
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Add IP/ IP Range 

Click on Add IP tab. 

 

Add IP tab appears, type valid IP Address within the range mentioned in the below tab and click 

on Ok. 
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In the below screen, we can notice IP Address in the Users tab. 

 

Delete 

Select the IP Address or User or Group and click on Delete tab. 
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In the below screen, we can notice selected Group deleted. 
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74. Banned Filters 

 

Select the profile from the drop-down menu and below shown settings (Domain, URL, Regex 

URL, Phrases, Extensions, Mime, and Content) can be done separately for each profile. 

In the below screen we have selected default profile. 

 

 

75. Domain/ Category Filtering 

Domain filter is the firewall function to help you block the specified domain. When we click on 

Domain tab, all the categories in the Domain are displayed. Exceptional sites from banning are 

being selected in the Categories list. 
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Add 

Click on Add tab. 

 

Add site tab appears, type domain name to be banned and click Ok. 
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Message tab appears stating that This site is already in banned list, Click Ok. 

 

Add More 

Click on Add More tab. 

 

Add Bulk Site tab appears type name of the domain as one in each line and click Ok. 
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Message tab appears stating that This site is already in banned list, Click Ok. 

 

Message tab appears stating that This site is already in banned list, Click Ok. 

 

Message tab appears stating that This site is already in banned list, Click Ok. 

 

Delete 

Select the site and click on Delete tab. 
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76. URL/Category Filtering 

URL categories help us ensure real-time protection against today's targeted and advanced 

threats. 

 

Add 

Click on Add tab 
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Add Site tab appears type domain name to be banned and click Ok. 
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In the below screen, we can notice domain name added in the Banned list. 

 

Add More 

Click on Add More tab. 

 

Add Bulk URL tab appears, type name of the domain as one in each line and click Ok. 
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Delete 

Select the URL and click on Delete tab. 

 

77. Regex URL Filtering 

This is completed when parts of the HTTP request are matched with the use of a list of regex 

patterns. You can either block specific URL’s or block all URL’s except for a select few particular 

URL’s. 



 
 

342 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 

Add 

Click on Add tab 

 

Add URL Regex  tab appears, type regex to be banned and click Ok. 
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In the below screen, we can notice Regex URL added to list 

 

 

 

 

 

 

 

 

Add More 

Click on Add Multiple tab. 
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Add URL Regex tab appears, type regex as one in each line and click Ok. 

 

In the below screen, we can notice Regex URL added in the list. 
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Delete 

Select Regex URL and click on Delete tab. 

 

 

Delete URL Regex tab appears, click on Yes. 
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In the below screen, we can notice Regex URL deleted. 
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78. Phrases 

Add 

In Banned filters, Select Phrases and Click on Add tab 

 

Add phrase tab appears.  
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These are the inputs to Add Phrase. 

1 Beginning Words Enter the Beginning words of the phrase 
2 Ending Words Enter the Ending words of the phrase 
3 Phrase for any position Enter a phrase 
4 Phrase for exact match Enter a phrase for exact match 

 

Click on OK. 

In the below we can notice that Phrase is added to the list. 

 

Delete 

Select the Phrase from the list and click on delete tab. 

 

 

Delete Phrase tab appears stating Are you sure? Click on Yes. 
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79. Content Change 

In this section, as seen in the places specified words or addresses to the new string to be 

replaced with the value entered into the field provided. 

Content Filtering generally refers to the filtering of inappropriate content or messages, such as 

content containing objectionable materials, personal or sensitive information, in terms of 

information security. Content Filtering has different applications like for example, in internet 

the browsing, receiving mails accessing database, etc. 

 

 

 

 

Add 

Click on Add tab 
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Add New Regular Expression tab appears, type regex and click Ok. 

 

New string tab appears, type string and click Ok. 
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In the below screen, we can notice Regex with new string. 

 

 

Delete 
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Delete Content tab appear, click on Yes. 
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In the below screen, we can notice content is deleted. 

 

80. Extension Filter 

 

 

Add 

Click on Add tab. 
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Add Extension tab, type extension and click Ok. 

 

Add Comment tab appears, type comment for the extension and click Ok. 
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In the below screen, we can notice extension added to list. 

 

Delete 

Select the extension and click on Delete tab. 

 

Delete Extension tab appears, click on Yes. 
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In the below screen, we can notice extension deleted. 
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81. Application Types Filter (MIME) 

 

Add 

Click on Add tab. 

 

Add Mime tab appears, give Mime type and click Ok. 

 

In the below screen, we can notice Mime type added in the list. 
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Add More 

Click on Add Multiple tab. 
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When the below screen appears enter the Mime extensions of the applications which you 
want to ban and click on Ok. 

 

 

In the below screen, we can notice Mime types added in the list. 

 

 

Delete 

Select the Mime type and click on Delete tab. 
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Delete Mine tab appears, Click on Yes.  
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In the below screen, we can notice Mime type deleted. 

 

82. Exception Filters 
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83. Domain 

Click on Domain tab 

 

 

Add 

Click on Add tab. 

 

Add site tab appears type domain name and click Ok. 
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In the below screen, we can notice domain name added. 

 

 

Add Multiple 

Click on Add Multiple tab. 

 

Add Bulk site tab appears, type domain name one in each line. Click Ok. 
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In the below screen, we can notice Multiple domains added. 
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Delete 

Select Domain and click on Delete tab. 

 

Delete Site tab appears, click on Yes. 

 

In the below screen, we can notice selected domain deleted. 
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84. URL 

Click on URL tab 

 

Add 

Click on Add tab. 

 

Add URL tab appears, type URL and click Ok. 
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In the below screen, we can notice URL added. 

 

 

Delete 

Select URL and click on Delete tab. 

 

 

Delete URL tab appears, click on Yes. 

 

In the below we can notice URL deleted. 
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85. Phrases 

In the exceptions Filters, Select Phrases tab 

 

Add 

Click on Add to add the Phrases to the exception phrase list 
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When the Add phrase screen appears , give the necessary inputs in the boxes 

 

Options in Add phrase screen are 

1 Beginning word In the beginning word box , enter the benning word of the phrase 

2 Ending word In the Ending word box , enter the ending word of the phrase 

3 Phrase for any 
position 

In the Phrase for any position box , enter a Phrase for any position 

4 Phrase for exact 
match 

In the Phrase for exact match box , enter a Phrase whicg matches exactly 

 

You can notice that a phrase is added to the list 

 

Delete 

Select the phrase and click on Delete tab to delete the phrase from the list
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Below screen appears stating that Are you sure, click on Yes 

 

86. Grey Site 

Select Grey Site tab. 

 

 

Add 

Click on Add tab. 

 

Add Grey Site tab appears, type domain name and click Ok. 
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In the below screen we can notice domain added. 
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Add Multiple 

Click on Add Multiple tab. 

 

Add Bulk Site tab appears, type domain name as one in each line  and click Ok. 

 

 

 

 

 

 

 

 

In the below screen we can notice multiple domains added. 
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Delete 

Select the domain and click on delete tab. 
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Delete Grey Site tab appears, Click on Yes. 

 

In the below screen we can notice Domain deleted. 

 

 

87. Grey URL 

Select Grey URL tab. 

 

Add 

Click on Add tab. 
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Add Grey URL tab appears, type URL and click Ok. 

 

In the below screen we can notice URL added. 

 

Add More 

Click on Add Multiple tab. 
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In the below screen we can notice multiple URL added. 
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Add Bulk URL tab appears, type domain name one in each line and click Ok. 

 

 

Delete 

Select the URL and click on Delete tab. 
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Delete Grey URL tab appears, Click on Yes. 

 

In the below screen we can notice Grey URL deleted. 

 

88. Settings 

 

Reporting Options 

Choose use HTML template file radio button for Web Access Denied Reporting. 

 

 

In Reporting options click on Customize tab. 
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Customize tab appears displaying HTML coding. Here we can modify the code if required 

 

Authentication 

Three types of Authentication are available. 

They are NTLM Authentication, Basic Authentication, IP Authentication. 

We can enable or disable above mentioned three Authentication types. 

 

Join Active Directory Domain 

Enable NTLM Authentication and click on Join AD Domain button. 
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NTLM Authentication tab appears. 

 

These are the inputs for NTLM Authentication. 

1 Domain Type domain name 

2 DC Hostname Type DC Hostname 

3 Domain Controller Give the Domain Controller IP 

4 Password Server Give  the  Server Password  

5 Workgroup Type Workgroup or enable Try to find work group automatically 

Click Ok. 

 

Join Domain tab appears. 
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These are the inputs to join domain. 

1 Username Type  Username to join Domain 

2 Password Type Password 

Leave Active Directory Domain 

Click Leave AD Domain button. 

 

89. HTTPS Filtering 

Introduction and Preliminary Information 

What is SSL/TLS and HTTPS? 

"SSL" means "Secure Sockets Layer". This was coined by the inventors of the first versions of the 

protocol, Netscape  

"TLS" means "Transport Layer Security". The name was changed to avoid any legal issues with Netscape 

so that the protocol could be "open and free" (and published as a RFC). It also hints at the idea that the 

protocol works over any bidirectional stream of bytes, not just Internet-based sockets. 

TLS is the new name for SSL. Namely, SSL protocol got to version 3.0; TLS 1.0 is "SSL 3.1". TLS versions 

currently defined include TLS 1.1 and 1.2. So it’s generally called SSL/TLS. 

HTTPS is a protocol for secure communication over a computer network which is widely used on the 

Internet. HTTPS consists of communication over Hypertext Transfer Protocol (HTTP) within a connection 

encrypted by Transport Layer Security or its predecessor, Secure Sockets Layer. The main motivation for 

HTTPS is authentication of the visited website and protection of the privacy and integrity of the 

exchanged data. 

Note: Explanation and definitions are borrowed from StackExchange and Wikipedia. 
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Certificate Authorities (CA), Chain of Trust and Certificate Chain 

A certificate authority (CA) is an entity that issues digital certificates. A digital certificate certifies the 

ownership of a public key by the named subject of the certificate. This allows others (relying parties) to 

rely upon signatures or on assertions made by the private key that corresponds to the certified public 

key. In this model of trust relationships, a CA is a trusted third party—trusted both by the subject 

(owner) of the certificate and by the party relying upon the certificate. 

Digital certificates are verified using a chain of trust. The trust anchor for the digital certificate is the 

root certificate authority. 

A certificate chain is a list of certificates (usually starting with an end-entity certificate) followed by one 

or more CA certificates (usually the last one being a self-signed certificate), with the following 

properties: 

1 - The Issuer of each certificate (except the last one) matches the Subject of the next certificate in the 

list.   

2 - Each certificate (except the last one) is supposed to be signed by the secret key corresponding to the 

next certificate in the chain (i.e. the signature of one certificate can be verified using the public key 

contained in the following certificate). 

3 - The last certificate in the list is a trust anchor: a certificate that you trust because it was delivered to 

you by some trustworthy procedure. 

Note: Explanations and definitions are borrowed from relevant Wikipedia pages. 

Creation of Labris UTM CA 

Since HTTPS connection and chain of trust is unbreakable by definition, explicit permission needs to be 

granted by clients in order to inspect the content of HTTPS connections. This happens in the form of 

Root CA import in client machines.  

Importing the Root CA of Labris UTM means that client trusts the UTM and promises to trust certificates 

issued by Labris UTM. When a client tries to establish a new HTTPS connection with a web server, Labris 

UTM intercepts the connection and redirects it to labris-webcache daemon. Labris-webcache analyses 

the connection request, extracts the destination domain and decides if this connection should be 

inspected or not. If the connection requires inspection, labris-webcache establishes a new HTTPS 

connection with the webserver, verifies its certificate chain and issues a new certificate for domain 

signed by Labris UTM CA. This whole process allows labris-webcache to maintain two HTTPS 

connections, first one between client and UTM, second one between UTM and webserver. This allows 

decryption and re-encryption of HTTPS connection on-the-fly and inspection of its content. This is also 

called Man-in-the-Middle (MitM) and makes labris-webcache man in the middle. Doing this on a public 

network (like ISP provided) and without explicit permission from clients may be illegal.  

 

 

 



 
 

383 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

Configuration 

This tab allows tuning the configuration options of HTTPS Filtering. 

 

HTTPS Filtering Settings 

Deep Inspection (Default) 

Perform man-in-the-middle inspection for HTTPS connection. Requires Labris UTM Root CA import in 

client machines. 

Domain-only Inspection 

Try to extract destination domains and apply domain-based rules if it’s possible. This option doesn’t 

require certificate import. On the other hand, labris-webcache can’t perform deep analysis of packets 

and in some situations where domain name is not present during HTTPS connection, domain-based 

rules may not work. 

HTTPS Filtering Exceptions 

Domain Names to Bypass Deep Inspection 

Some applications and domains used by them can’t be inspected for various reasons including but not 

limited to: 

- Key pinning 

- Deviation from SSL/TLS protocol 

- Proprietary algorithms or cipher suites 

- Using TCP port 443 for Non-HTTPS protocols. 
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Some of the problems above may be solved by adding relevant domains to exception. If adding an 

exception doesn’t solve the problem, not redirecting connections to labris-webcache for known 

destination IP addresses should solve the problem. 

Certain domains (or all subdomains of a domain) can be added to this list if it causes problem or it’s not 

appropriate to decrypt and inspect its content on-the-fly. 

 

 

Bypass Websocket Domain Names Automatically 

Some websites and applications use Websocket connection over HTTPS connections. Websocket 

connections start with HTTP handshake and uses 101 Upgrade response to upgrade the connection to 

Websocket protocol. Since they are not actually HTTP over TLS they cannot be effectively inspected and 

passed. So domains using Websocket needs exception to not break them. Labris UTM may inspection 

HTTP headers and recognize Websocket headers on-the-fly. This allows auto-adding Websocket 

domains to exception list. User may manage and examine these domains later in the “Domain Names to 

Bypass Deep Inspection” list. 

Warning: Allowing Websocket domains may allow bypassing filter rules. Make it ‘off’ if you think your 

clients may act maliciously. 

 

Domain Names Requiring Deep Inspection Exception 

Labris provides a list of known domains which require exception in order to make related applications to 

work. You can examine the list and add them directly to “Domain Names to Bypass Deep Inspection” 

list. 
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Insecure Cipher Suites 

Some algorithms are considered insecure and cipher suites using them are disabled by default. Allowing 

them solve connection problems with web servers using these cipher suites. 

Insecure algorithms:  DSS, 3DES, RC4, MD5, IDEA 

Cipher suites using them: 
TLS_DHE_DSS_WITH_3DES_EDE_CBC_SHA 
TLS_DHE_DSS_WITH_AES_128_CBC_SHA 
TLS_DHE_DSS_WITH_AES_128_CBC_SHA256 
TLS_DHE_DSS_WITH_AES_128_GCM_SHA256 
TLS_DHE_DSS_WITH_AES_256_CBC_SHA 
TLS_DHE_DSS_WITH_AES_256_CBC_SHA256 
TLS_DHE_DSS_WITH_AES_256_GCM_SHA384 
TLS_DHE_DSS_WITH_CAMELLIA_128_CBC_SHA 
TLS_DHE_DSS_WITH_CAMELLIA_256_CBC_SHA 
TLS_DHE_DSS_WITH_SEED_CBC_SHA 
TLS_DHE_RSA_WITH_3DES_EDE_CBC_SHA 
TLS_ECDH_ECDSA_WITH_3DES_EDE_CBC_SHA 
TLS_ECDH_ECDSA_WITH_RC4_128_SHA 
TLS_ECDHE_ECDSA_WITH_3DES_EDE_CBC_SHA 
TLS_ECDHE_ECDSA_WITH_RC4_128_SHA 
TLS_ECDHE_RSA_WITH_3DES_EDE_CBC_SHA 
TLS_ECDHE_RSA_WITH_RC4_128_SHA 
TLS_ECDH_RSA_WITH_3DES_EDE_CBC_SHA 
TLS_ECDH_RSA_WITH_RC4_128_SHA 
TLS_RSA_WITH_3DES_EDE_CBC_SHA 
TLS_RSA_WITH_IDEA_CBC_SHA 
TLS_RSA_WITH_RC4_128_MD5 
TLS_RSA_WITH_RC4_128_SHA 
TLS_RSA_WITH_SEED_CBC_SHA 
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Insecure Protocols 

SSL version 2 and version 3 are considered insecure and disabled by default. Allowing them may solve 

connection problems with web servers which doesn’t support TLS. 

Certificate Import (Desktop) 

Windows 

System-wide Import (Internet Explorer, Chrome) 

Importing certificate to system certificate store of windows allows Internet Explorer, Chrome and other 

applications trusting system store to work without certificate warning. 

 

Internet Explorer shows certificate warning before import  

If root certificate is not imported 

to the system, browser shows a 

warning about certificate 

security. 
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Double-clicking on the root 

certificate opens certificate 

details windows. Clicking on 

Install Certificate option opens a 

new dialog. 

 

 

 

 

 

 

Please choose Local Machine 

and click Next. 
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Click Yes.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Choose “Place all certificates 

in the following store” and 

click Browse. 
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Choose Trusted Root Certification 

Authorities as store. 

 

 

 

 

 

 

 

 

 

 

 

Click Next. 
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Click Finish. 

 

 

 

 

 

 

 

 

 

 

Internet Explorer shows no warning after certificate import. 
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Firefox 

 

Firefox doesn’t use system 

store instead uses its own 

certificate store. Shows a 

warning before certificate 

import. 

 

 

 

 

 

 

 

 

 

On the right click options. 
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In Advanced menu, choose 

Certificates tab and click View 

Certificates. 

 

 

 

 

 

 

 

On Authorities tab, click 

Import. 

 

 

 

 

 

 

 

Choose Root UTM CA. 
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Click “Trust this CA to 

identify websites. 

 

 

 

 

 

 

 

You can see Labris UTM CA 

is present in Certificate 

Store. 

 

 

 

 

 

 

 

Firefox shows no warning 

after certificate import. 
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OS X 

System-wide Import (Safari, Chrome) 

Importing to system allows Safari and Chrome certificate problems. 

 

Open Keychain Access. 

On the left sidebar ensure System 

keychain and Certificates are selected. 

Click File -> Import Items 

 

 

 

 

 

 

 

 

Choose UTM Root CA certificate file click Open. 
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Double click on the imported certificate. This will open certificate details.  

 

 

 

Expand the section Trust. 
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Choose Always Trust for Secure Sockets Layer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Linux 

Firefox 

Steps are the same as Firefox on Windows. 

Chromium 

Click Settings on right and click Show advanced settings. 
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Click Manage certificates. 
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Open Authorities tab 

and click Import. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Choose Root UTM 

CA. 
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Click “Trust this 

certificate to identify 

websites”. 

 

 

 

 

 

 

 

 

 

 

Certificate is listed here. 
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Chromium shows no 

warning and certificate is 

signed by Labris UTM CA. 

 

 

 

 

 

 

 

 

 

 

 

Certificate Import (Mobile) 

iOS 

Certificate can be transported to device via e-mail. Importing is simple. Use the steps below. 
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Android 

System-wide Import 

Certificate should be imported to Android Trusted Credentials.  Sending the certificate via mail is the 

recommended way. Other possible options would be placing the certificate on a HTTP server or on a FTP 

server. 
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Download attachment from mail 

 

Give a name to certificate 
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Set-up screen lock 

If device doesn’t have a screen lock set up already, Android may require this prior to certificate import. 

Different vendors and different Android versions have implemented different policies about this issue. 

Some of them may enforce PIN lock while some others seems to accept also Pattern screen lock. 

        

 

Certificate import completed 
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Network Monitoring Warning 

After importing the certificate, Android System shows a warning 

with the title of ‘Network Monitoring’ even if cellular connection is 

used instead of Wi-Fi. Some vendors and some Android versions 

allow dismissing this warning while others don’t. If system doesn’t 

allow dismissing, there is no way to disable this warning. 

 

 

 

 

 

 

 

 

Checking trusted CAs 

     

Imported certificate can be 

examined under the Trusted 

Credentials menu. 
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Testing certificate import 

 

Dolphin Browser 

Dolphin respects CAs trusted by 

system. HTTPS Filtering works with 

no issues after certificate is 

imported. Inspection of 

connection details shows that 

Labris UTM analyses the 

connection. 

 

 

 

 

 

 

 

Chrome 

Chrome respects CAs trusted by 

system. HTTPS Filtering works 

with no issues after certificate 

is imported. Inspection of 

connection details shows that 

Labris UTM analyses the 

connection. 

 

 

 

 

 

 

 

 



 
 

406 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 

Opera 

No issues after importing certificate.        

 

 

 

 

 

 

 

 

 

Clearing Trusted Credentials and Disabling Screen Lock 

Android doesn’t allow disabling screen lock when a third-party CA is imported.  To clear the credentials 

store and disable screen lock, follow the steps below. 

Warning: Clearing credentials will prevent establishing HTTPS connections. Do this only if the device will 

not be subject to HTTPS filtering anymore. 

     1 

                                                           
1  
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Firefox (Not Supported) 

Firefox for Android doesn’t use System CA Store for validation and doesn’t provide a way to import 

third-party CAs. So it can’t be used with HTTPS filtering. 

 

Windows Phone 

Windows phone doesn’t recognize PEM encoded “*.crt” certificates. Certificate needs to be converted 

to DER format and its extension must be “.cer”. This can be accomplished in a Linux system with the 

following command: 

openssl x509 -in sslfilter2.crt -outform der -out sslfilter2.cer 
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Certificate Distribution via Active Directory 

You can use the steps below to distribute Labris UTM Root CA via Active Directory. 
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Customizing Root CA Details 

You can use the below command to regenerate the certificate with custom details: 

openssl req -new -key /opt/labris/etc/labris-webcache/certs/sslfilter2.key -x509 -days 3650 -out 

/opt/labris/etc/labris-webcache/certs/sslfilter2.crt 

 

Openssl will ask for details. Fields and default values of Labris UTM CA are shown below: 

Country Name (2 letter code) [GB]: TR 
State or Province Name (full name) [Berkshire]: ANK 
Locality Name (eg, city) [Newbury]: Ankara 
Organization Name (eg, company) [My Company Ltd]: Labris UTM CA, Certificate ID: <ID> 
Organizational Unit Name (eg, section) []: Labris HTTPS Inspection Module Unit, Certificate ID: <ID> 
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Common Name (eg, your name or your server's hostname) []: Labris HTTPS Inspection Module, 
Certificate ID:<ID> 
Email Address []: - 
 

Firewall Configuration 

Connections to TCP Port 443 must be intercepted in order to make HTTPS Filtering work. 

 

 

NTLM Authentication AD Configuration 

90. General View 
 
Active Directory users can be used in areas such as Firewall, Webfilter, VPN, Wauth by integrating Labris 
products with Active Directory. Authorization can be made with the user name or rules can be written.  
 
Logon script must be set for all users with Group Policy on Active Directory for using simple 
authentication system. Logon script shares user information periodically with Labris. With this method, 
the correct settings can be made by making the necessary settings on structures which have more than 
one location and using the same active directory.  
 

91. Prerequisite  
 
Active Directory Structure must be set and all computers must be included in Active Directory.  
Active Directory integration must be made with Labris.  
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92. Scenario  
 
Logon script settings will be made by using Group Policy on active directory integrated with Labris.  
How to make settings on structures which have more than one location and using the same active 
directory will be explained 
 
This expression was performed on Windows Server 2012.  
Although general method is same for Windows Server 2003/2008, the location of the menu on server 
can be different. 

93. Configuration  
 
Step 1: The attached files are downloaded and are copied to netlogon directory of Active Directory 
server.  

a. Run opens by using "Windows + R" keys combination and netlogon directory is called as in 
the picture. 
 

  
 

Attached files are copied to this area. 
           

 
b. networksettings registry file is edited for the network settings. 

Right button + edit are clicked on networksettings file.  
Appropriate definitions are made to your network settings in registry file opened.  
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If the regedit file is not set, the gateway of computer sends requests to the IP address by 
default. If the default gateway is Labris device, it works without any problems. 
 

 
 

Parameter Description 
 

No Parameter Value Description 

1 Location Name  Istanbul The location name to be made network identification.  

2 Network 
Address  

192.168.20.0 Network address of the Labris device location is written.  

3 Subnet Mask  255.255.255.0 The subnet mask belongs to network address specified is defined.  

4 Labris IP 
address  

192.168.20.1 Labris device's IP address in location is written. 

5 Labris Port  9090 The port accepting requests on Labris. TCP 9090 

6 requestsleep 3000000 It is set that it will make communicate with Labris device in how many 
milliseconds. It is set 5 minutes by default. It can be set so as to at least 
1 minute. 
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Step 2: Active Directory Group Policy settings are made.  
 

It is entered in the Group Policy Management window. 
 

 
 

Default Domain Policy is set. If desired, settings can also be made here by creating a 
different group policy. 

 
Script Settings section opens. 
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a. Logon settings open. Add is clicked in the window appeared. regedit file displays, which we 
copied under netlogon directory with the Active Directory IP address. 

 
Parameter Description 
 

No Parameter Value Description 

1 Script name regedit.exe Registry editing tool in which will run registry 
file that we set. 
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2 Script 
Parameters 1 

/s It will not be displayed while applying registry 
record in user computers. 

3 Script 
Parameters 2 

\\192.168.20.254\netlogon\networksettings.reg The path of networksettings.reg file is 
displayed, which we copied to netlogon 
directory of active directory server.  

 
Labris User logon tracker settings are made.  
Add Again and Browse is clicked on Logon script settings  
\\SunucuIP\netlogon\ is written to the address line of window appeared and entered.  
Labris-user-login-tracker-x86.exe is selected and opened 

 
  
Operation mode and registry record are given as script parameters with path on the server. 

   
Parameter Description 

No Parameter Value Description 

1 Script name \\192.168.20.254\netlogon\Labris-user-login-
tracker-x86.exe 

File path definition is made for Labris user 
logon tracker program. 

2 Script 
Parameters 1 

logon When the user logs on, the operating mode 
of the logon tracker is set as logon. 

3 Script 
Parameters 2 

\\192.168.20.254\netlogon\networksettings.reg In case of failure writing of the registry record 
to the user's computer, logon tracker tries to 
perform settings by reading the registry file 

file://///192.168.20.254/netlogon/networksettings.reg
file://///SunucuIP/netlogon/
file://///192.168.20.254/netlogon/Labris-user-login-tracker-x86.exe
file://///192.168.20.254/netlogon/Labris-user-login-tracker-x86.exe
file://///192.168.20.254/netlogon/networksettings.reg
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here. It is written with a space after the value 
of Script parameters 1. 

 
In the latter case, Logon Script settings should be as follows. 
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b. Logoff settings are clicked and then Add is clicked. 
As in the setting of logon, Labris-user-login-tracker-x86.exe is selected and script 
parameters are written. 
 

 
 
Parameter Description 
 

No Parameter Value Description 

1 Script name \\192.168.20.254\netlogon\Labris-user-login-
tracker-x86.exe 

File path definition is made for Labris 
user logon tracker program. 

2 Script 
Parameters 1 

logoff When the user logs off, the operating 
mode of the logon tracker is set as logoff. 

3 Script 
Parameters 2 

\\192.168.20.254\netlogon\networksettings.reg In case of failure writing of the registry 
record to the user's computer, logon 
tracker tries to perform settings by 
reading the registry file here. It is written 
with a space after the value of Script 
parameters 1. 

 
 

In the latter case, Logoff Script settings should be as follows. 

 

 

file://///192.168.20.254/netlogon/Labris-user-login-tracker-x86.exe
file://///192.168.20.254/netlogon/Labris-user-login-tracker-x86.exe
file://///192.168.20.254/netlogon/networksettings.reg
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c. Group Policy settings are applied. 
For the changes to be valid, Group Policy settings will be updated for all users.  
Run opens by using "Windows + R" keys.  
The settings are applied by giving gpudate / force command to this area. 

 

 
 

d. Control of the settings is made. 
The user computer is log off and logon again after settings successfully applied. It can be seen 
that Labris-user-logon-tacker-x86.exe is running in task manager (ctrl + shift + esc) 
application. 
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To provide control over Labris; 
"labrisdb_user_manager.py -getall-ip" command is written on the command line and it is 
seen that the IP addresses of users came. 
 

94. Logging Options 

Log Level and Log Exception Hills tabs are displayed. 

 

Network Settings 

Network settings consists of four fields. They are Filter IP , Filter Port, Proxy IP and Proxy Port. 

Give appropriate Filter IP, Filter Port, Proxy IP and Proxy Port. 
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Weighted Phrase Settings 

In the Weighted Phrases Settings we can choose Weighted Phrase Mode. 

If it is on then the phrases found that made up the total which exceeds the naughtiness limit 

will be logged, if the level is high enough reported. 

 

 

 

Cache Settings 

We can view and change Cache Settings. 

 

Fork Pool Settings 

We can view and change Fork Pool Settings. 
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Click on Save tab to save the changes. 

 

 

95. Log Monitoring 

When we click on Log Monitoring tab, Live traffic Monitoring tab appears. 
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96. Show 

Click on Show tab to see current traffic on Webfilter. 

 

 

 

Filter 

Below screen appears. 

 

 

Start 

 

These are the inputs to start 
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1 URL Type URL 

2 Client IP Give the client IP Address 

3 Client User Name Type client User Name. 

 

Click on Start tab. 

In the below screen we can notice service has been started. 

 

Clear 

When we select the log and click on clear button the logs  can be cleared from the list. If there 
are too many rows in the table we can select each one of them and Click on the Clear button, 
to  delete a log. 
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ANTISPAM/ANTIVIRUS 

 

 

97. Spam Mail Box 

Search Criterions 

 

 

These are the inputs for Spam Mail Box. 

1 Sender Enable Sender and type Sender name 

2 Recipient Enable Recipient and type Recipient name 
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3 Date and Time Enable Date and Time, choose Start Date and End Date 

4 Search Click on Search tab to find out Mail. 

Info tab appears stating No Mail, Since No mail has been sent. Click Ok 

 

Virus Mail Box 

Search Criterions 

 

These are the inputs for Virus Mail Box 

1 Sender Enable Sender and type Sender name 

2 Recipient Enable Recipient and type Recipient name 

3 Date and Time Enable Date and Time, choose Start Date and End Date 

4 Search Click on Search tab to find out Mail. 

 

 

Info tab appears stating No Mail, Since No mail has been sent. Click Ok 
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98. Antispam-Antivirus Options 

Domain Control 

 

Domain Control tab appears with the fields Domain and Relay IP 

Add New Domain tab appears. 

Type Domain name and Give Relay ip address. Click Ok 

 

It takes some time to Apply changes. 
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In the below screen, we can notice New Domain added in the Domain Control tab. 

 

 Select the Domain and Click on Edit tab. 

 

 

Edit tab appears. 

We can edit Domain name and Relay IP address. Click Ok. 
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It takes some time to apply changes. 

 

In the below screen, we can notice changes made in the new domain. 

 

  Select the Domain and click on Remove tab. 
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It takes some time to apply changes. 

 

In the below screen, we can notice Domain deleted in the Domain Control tab. 

 

Settings 

Add a Global policy. 
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99. Antispam Options 

Antispam consists of three fields. 

They are Bypass spam check, By pass header check, spam mail receivers. 

Check Options 

It helps us to enable Bypass spam check, By pass header check, spam mail receivers and 
perform actions like Add, Delete on check options. 

 

Enable Bypass spam check list and click on Add tab. 

 

Add Domain Name or Mail Address tab appears. 

Type Domain name or e-mail address. Enable No include, check domain part and click on Add 
tab. 
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In the below screen, we can notice domain name added in the spam check list. 

 

Select domain and click on Delete tab. 

 

Warning tab appears stating Are you sure? Click on Yes 

 

Enable Bypass header check list and click on Add tab. 

 

Add Domain Name or Mail Address tab appears. 

Type Domain name or e-mail address. Enable No include, check domain part and click on Add 
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tab. 

 

In the below screen, we can notice domain name added in the header check list. 

 

Select domain and click on Delete tab. 

 

Warning tab appears stating Are you sure? Click on Yes 

 

Enable Spam mail receivers list and click on Add tab. 

 

 

Add Domain Name or Mail Address tab appears. 
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Type Domain name or e-mail address. Enable No include, check domain part and click on Add 
tab. 

 

In the below screen, we can notice domain name added in the Spam mail receivers list. 

 

 

 

Select domain and click on Delete tab. 

 

 

Warning tab appears stating Are you sure? Click on Yes 
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Report Options 

 

These are the inputs for the Report options. 

1 Modify spam mail subject To modify spam mail subject select yes or else no 

2 Warn spam sender To Warn spam sender select yes or else no 

3 Spam subject tag Type tag of Spam subject. 

4 Spam admin mail address Type spam admin mail address 

5 Spam mail policy Select policy from the drop down list. 

 

Click on Save tab to save changes made to the AntiSpam-AntiVirus. 

 

 

100. Whitelist Blacklist 

Enable White List 

Enable white list to perform action like Add, Edit, Delete, Delete All Whitelist. 
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Click on Add tab. 

 

 

Add Domain Name or Mail Address tab appears. 

Type Domain name or e-mail address, we can enable Check Domain part if necessary and click 

on Add tab. 

 

 

In the below screen, we can notice mail address added in the White list. 

 

 

 

Select mail address and click on Edit tab. 
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Edit List tab appears, we can edit URL and click on Save tab. 

In the below screen, we can notice changes made to the mail address. 

 

Select mail address and click on Delete tab. 

 

Warning tab appears stating Are you sure? Click on Yes 

 

Below screen we can notice selected mail deleted from the white list. 

Click on Delete All tab to delete all the mail addresses in White list. 
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Warning tab appears stating Are you sure? Click on Yes 

 

Enable black List 

Enable Black List to perform actions like Add, Delete, Delete All in Black list. 

 

Click on Add tab. 

 

Add Domain Name or Mail Address tab appears. 
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Type Domain name or e-mail address, We can enable Check Domain part if necessary and click 

on Add tab. 

 

In the below screen, we can notice mail address added to the Black list. 

 

Select mail address and click on Edit tab. 

 

Edit List tab appears, we can edit URL and click on Save tab. 

 

In the below screen, we can notice changes made to the mail address. 
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Select mail address and click on Delete tab. 

 

Warning tab appears stating Are you sure? Click on Yes 

 

 

In the below screen we can notice selected mail deleted from the Black list. 

Click on Delete All tab to delete all the mail addresses in White list. 

 

Warning tab appears stating Are you sure? Click on Yes 



 
 

447 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 

101. Antivirus Options 

Antivirus consists of two fields. 

They are Virus check bypass list and Virus mail receivers list. 

 

Antivirus Options 

It helps us to enable Virus check bypass list and Virus mail receivers list and perform actions like 
Add, Delete on check options. 
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Enable virus check bypass list and click on Add tab. 

 

Add URL or Mail Address tab appears. 

Type URL or e-mail address.  We can enable No include, check domain part only when we give 
domain and click on Add tab. 

 

In the below screen, we can notice mail address added in the Virus check bypass list. 
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Select mail address and click on Delete tab. 

 

Warning tab appears stating Are you sure? Click on Yes 

 

Enable Virus mail receivers list and click on Add tab. 

 

Add URL or Mail Address tab appears. 

Type URL or e-mail address.  We can enable No include, check domain part only when we give 
domain and click on Add tab. 
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In the below screen, we can notice mail address added in the Virus mail receivers. 

 

Select mail address and click on Delete tab. 

 

Warning tab appears stating Are you sure? Click on Yes 
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Report Options 

 

These are the inputs for Report Options. 

1 Warn virus sender To Warn virus sender select yes or else no 

2 Warn virus recipient To Warn virus recipient select yes or else no 

3 Infected mail policy Select policy from the drop down list 

4  Admin address Type spam admin mail address 

5 ‘X_HEADER_TAG’ value Give header tag value 

6 ‘X_HEADER_line’ value Give header line value. 

 

Click on Save tab to save changes made to the Antivirus options. 
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IDS/IPS 

Right Click on the IDS / IPS tab and click on Connect to get connected to the IDS/IPS tab 

 

102. Sensor Settings 

Once you get connected you can find two options on the top i.e., Sensor settings and alert 
settings.  

Click on Sensor settings , in that tab you can find Intrusion detection system  

Intrusion Detection System 
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103. Settings 

Network Settings 

Under Intrusion Detection System we find options like Settings > Network settings 
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Changing variable 

Select one of the variable from the list in the right pane, below you can edit the contents of the 

variables in variable settings tab and click on Change. 

 

Changes are applied to the variables immediately. We can notice in the below screen. 

Select the variable and double click on Control/Status to make the Variable Enable. 
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Changes are applied to the variables immediately. We can notice in the below screen. 
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Deleting variable 

Select one of the variables from the list right pane and click on Delete. 

Selected variables are deleted from the list immediately. 

 

 

 

 

Cancel 

Click on Cancel tab to revert back to the same settings as before. 
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Click on Apply tab to apply the modified settings in Network settings tab 

 

Click Ok to save the changes 
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Interface 

Select Interface tab from the left pane 

 

From the drop down list select any one of the required Ethernet type 

 

 

 

 

 

 

 

Adding IP 

Click on Add tab to Add the new IP Address to the unblockable list 
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Enter the IP Address which you wanted to add to the list and click on “EKLE” 
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Delete 

Select one of the IP Address which you want to remove from the list and click on Remove tab. 

 

 

Selected IP Address is removed from the list immediately, which you can notice from the below 

screen. 
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Refresh 

Click on Refresh Tab to refresh the entire tab. 

 

Rule sets 

Select Rulesets tab from the left pane. 
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Click on New File to create a new rule file. 

 

 

Give the name of the file without any extension and click Ok. 
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You can notice that the new file with the name test is added to the list. 

 

 

 

Select the required file form the list and click on delete file tab to remove the file form the list. 
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Rulesets List 

Expand Rulesets from the Leftpane. 

We can find different list of Rulesets. 

Expand any one of the Rulesets as shown in the below figure. 
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Select any one of the Rule from the RuleList. 
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Click on the icon from the Action Tab to Block , UnBlock or cancel the selected 

Rule. 

 

 

 

Click on the highlighted icon to Start / Stop the Rule. 

Red Light – Stop 

Green Light - Start 
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Click on the highlighted icon to redirect to the reference URL which is specified in the list. 

 

 

Click on Apply tab to apply the modified settings in Rulesets tab. 
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Click on Ok to save the changes. 

 

Click on the Start tab as shown in the screen to start the IDS Service for chosen sensor 

 

Below screen appears stating that Starting IDS service is in progress. 

 

Click on the Stop tab as shown in the screen to stop the IDS Service for chosen sensor. 

 

 

Below screen appears stating that Stopping IDS service is in progress. 
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104. Alert Settings 

In the Alert tab we can find options like Mail Alert Settings ,Report Mails and Alerts. 

 

Mail Alert Settings 

Give the inputs in the below fields. 

 

 

1 Sender mail 
address 

In this field give the sender mail address 

2 Administrator 
mail address 

In this field give the administrator mail address 

3 SMTP host In this field give the details of the SMTP server 
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Report Mails 

In the Report mails tab specify the To address and Schedule time to send mails. 

 

 

Alerts 

In the Alerts tab, we can change the IDS Alert Duration depending on the requirement. 

 

 

Click on save tab to save the modified settings 

 

 

 

MESSAGING 

Right click on Messaging, Select Connect. 
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105. Domains 

When we get connected to Messaging, we can notice Domains in the right pane. 

 

Domain 

Click on Add tab to add new Domain to Messaging. 
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Domain Add tab appears. 

Type the name of domain and give information regarding Domain in the Description column. 

Click on Add tab. 

 

Below screen appears stating that Adding Domain process is in progress. 

 

In the below screen, we can notice new Domain added. 

 

 

Click on Modify tab to make any changes to the Domain. 
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Domain Edit tab appears, we can modify Description of the Domain and click on Add tab. 

 

In the below screen, we can notice changes made to the Domain. 

 

Select the Domain and click on Delete tab. 

 

Delete Domain tab appears stating Are you sure to delete the domain? Click on  Delete tab. 



 
 

474 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 

Below screen appears stating that Deleting Domain process is in progress. 

 

When we click on Domain in the right pane, details of that particular domain is displayed. 

 

All Users 

When we expand domain, we can find options like All Users, Aliases, Groups 

 

Select All Users, Click on Add tab to add new User. 

When we click on Add tab, Message is displayed stating Please create a group before adding 

new users! 

Click Ok. 

Before adding new user, we must create a Group in the domain. 
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Select Groups and click on Add tab. 

 

Group Add tab appears, Type the name of the Group and give the information regarding Group 

in the Description column. 

Click on Add tab. 
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In the below screen, we can notice new Group added to the Domain. 

 

Now select All Users and click on Add tab. 

 

Add New User tab appears. 
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These are the inputs to add New User. 

1 User Name Type the User Name 

2 First Name Type the First Name 

3 Last Name Type the Last Name 

4 Title Give the Title of the User 

5 Group Choose Group from the drop down list 

6 Description Give the Description of the User 

7 Employee Number Type Employee Number 

8 Telephone Number Type the Telephone Number 

9 Alternative E-mail Give the Alternate E-mail Address 

10 Total Size Choose the required Size 

11 Number of emails Type the Number of emails 

12 Forwarding Give the Forwarding E-mail Address if necessary 

13 Password Give the Password for the User 

14 Re-type Password Re-type Password  for Confirmation. 

 

Adding User process is in progress. 

 

In the below screen we can notice New User added to All Users. 
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Select the User and click on Modify tab to make any changes to the User. 

 

Modify User tab appears. 

Except User Name all the remaining fields can be modified. 

Click Ok. 

 

 

Select User and click on Delete tab to delete an User. 
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Delete User tab appears stating Are you sure to delete the Users below? Click on  Delete tab. 

 

Deleting User process is in progress. 

 

Aliases 

Select Aliases and click on Add tab. 

 

Add Aliases tab appears. 
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Type the Address and Aliases. 

Click on Add tab. 

 

Adding Alias process is in progress. 

 

In the below screen, we can notice New Alias added. 

 

 

Select the Alias and click on Modify tab to make any changes t the Alias. 
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Modify Alias tab appears, we can modify Aliases column and click on Modify 

 

Select the Alias and click on Delete tab to delete an Alias. 

 

Delete Alias tab appears, click on Delete. 

 

Deleting Alias process is in progress. 

 

In the below screen, we can notice Aliases deleted. 
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Groups 

Select Groups and click on Add tab. 

 

 

Group Add tab appears. 

Type the Name of the Group and give information regarding Group in the Description column. 

Click on Add tab.  

 

In the below screen, we can notice New Group added. 
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Select the Group and click on Modify tab. 

 

Modify Group tab appears ;we can modify Description of the Group and click Ok.

 

Select the Group and click on Delete tab. 

 

 

Delete Group tab appears stating Are you sure to delete the group below? Click onDelete tab. 

 



 
 

484 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

106. Services 

Services help us to know the status of the Messaging. It also enables us to start, stop the 

Service. 

 

Select Services and click on the highlighted icon to the stop Service. 

 

Mesg2 tab appears stating Stopping service, Please wait… 

Stopping services process is in progress. 

 

 

In the below screen, we can notice mes2 Service Status:  Stopped. 

 

Select Services and click on the highlighted icon to the start the Service. 
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Mesg2 tab appears stating Starting service, Please wait… 

Starting Services process is in progress. 

 

In the below screen, we can notice mes2 Service Status:  Running. 

 

 

Select Services and click on the highlighted icon to the Reload Service. 

 

Mesg2 tab appears stating Reload settings, please wait… 



 
 

486 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

Reload settings process is in progress. 

 

In the below screen, we can notice mes2 Service Status:  Reloaded. 

 

 

107. Configuration  

 

 

When we expand Configuration tab only General is displayed. 

Click on General tab, Host Name and Domain Name are appeared. 

Click on Save tab. 

 

Saving General Configuration process is in progress. 
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Below screen appears stating General configuration settings saved, Click Ok. 
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Load Balancer 

Right click on Server Load Balancer, select connect. 

 

When we get connected to Server Load Balancer below screen appears. 

 

 

 



 
 

489 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

108. Configuration 

Load balance service open to outside servers, outside-in line with the demands of a specified 

weight values is used to send the request packets to servers. 

For example, there is a web site, and you experience performance issues on the server because 

of the intense traffic. In such cases, you can use the same web resources can come in a second 

web server and load balance property between the two servers can share a server densities 

according to the packages. 

 

In the below screen, we can notice external source Address. 

In the internal servers field we can find two piece of the same source files in the background 

using the server providing the same background via request packets on port 443, respectively 

one among them, is the intensity of the request packet weight. 

 

 
 

 

 

 

 

Externally Advertised Services 

It enables us to Add, Delete and Update Externally advertised services 

 



 
 

490 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 

To add new service. 

Mention External IP address and its Port number. 

Mention Failback IP address and its Port number. 

Choose the type of the Connection scheduling method and enter Persiste value.  

After providing all the inputs, click on Add tab. 

 

Connection scheduling methods 

These are four types of server load balancing methods which are also known as “scheduling 
methods” or “algorithms”. 
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Round Robin 

Round Robin is one of load balancing algorithm. It maintains a list of servers and forwards a 

new connection to the next server in the member list. Round robin is simple and effective 

method of distribution. This method functions best if all the servers have similar resource 

capacity. 

Weighted Round Robin  

The weighted Round robin algorithm maintains a weighted list of servers and forwards new 

connections in proportion to the weight of each server. 
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Least connection 

Least Connection is one of load balancing algorithm. This Algorithm maintains a record of active 

server connections and forwards a new connection to the server with least number of active 

connections. Least connection method functions best in environments where the servers have 

similar capabilities. 

Weighted Least connection 

The weighted least connection algorithm maintains a weighted list of application servers with 

their number of active connections and forwards a new connection to an application server 

based on a combination of its proportion to the weight and number of active connections. Like 

the least connections methods, these load balancing methods select pool members or nodes 

based on the number of active connections. This method work best in environments where the 

servers have different capacities. 

In the below screen, we can notice New service added. 

 

 

Select the service and click on Delete tab. 

 

 

To Update the service, Select the service. 
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 We can modify External IP address and its port number, Connection scheduling method type. 

After making necessary changes, Click on Update tab. 

 

In the below screen, we can notice Updated server. 

 

Internal Servers for Selected External Service 

Internal Address 

It enables us to Add, Delete and Update Inter server for selected external service. 

 

To add Internal server. 

Mention Internal address, port number, weight, Check timeout and Check port. 

After providing all inputs click on Add tab. 
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In the below screen, we can notice Internal server added. 

 

Select the server  and click on Delete tab. 

 

 

To Update the server, Select the server. 

We can modify internal IP address, Port, Weight, Check Timeout and Check Port. 

After making necessary changes, Click on Update tab. 
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In the below screen, we can notice Updated server. 

 

Service 

Service tab enables us to know the status of the service. 

 

Click on the highlighted icon to stop the service. 

 

In the below screen, we can notice Red color status which indicates Server stopped. 

 

Click on the highlighted icon to start the service. 

 

In the below screen, we can notice Green color status which indicates Server stopped. 
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109. Global 

Global Settings 

Click on Global tab.  

 

 

It enables us to view and change the Global Settings. 

 

These are the inputs for Global. 

1 Notification Email Give the Notification Email address 

2 Notification Email From Give  the From address Notification Email 

3 SMTO Server Give the SMTO Server address 

 
Click on Update tab. 
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110. Monitor 

Service Monitor 

Select Monitor tab 

 

Click on Update tab to update the information  

 

You can notice that information is updated in this tab 
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License 

Right click on License and select connect. 

 

New License 

Click on New License, Information regarding License is being displayed. 
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Click on Get Hardware Information button. 

 

In the below screen, we can notice Hardware Information gathered from server is displayed. 
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Install License 

Enter file name or choose Open file if we have a license file. 

Signature of the file should be mentioned or choose Open file if we have a Signature and click 

on Send the file to the server. 

 

 

111. Glossary 

 

• For License file, please request from the service provider.Note
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DHCP Dynamic Host Configuration Protocol 

DNAT Destination Network Address Translation 

DNS Domain Name System 

DOS Denial of service 

DDOS Distributed Denial of service 

ICMP Internet Control Message Protocol 

IDS Intrusion Detection System 

IP Internet Protocol 

IPS Intrusion Prevention System 

LMC Labris Management Console 

L2TP Layer 2 Tunneling Protocol 

MIME Multi Purpose Internet Mail Extensions 

NAT Network Address Translation 

PAT Port Address Translation 

QOS Quality of service 

SNAT Secure Network Address Translation 

SSL VPN Secure Socket Layer Virtual Private Network 

TCP Transmission Control Protocol 

UDP User Datagram Protocol 

UTM Unified Threat Management 

VPN Virtual Private Network 

WAN Wide Area Network 

WAUTH Wireless Authentication 

 

112. Labris Firewall Messages 

  

_lfp_ DROP IN ethN OTHER SRC Blocking occurred because the source address of the packets 
incoming from an interface which is defined as external interface 
overlaps with either the network address of an internal interface 
or the internal networks defined under this internal interface. 

_lfp_ DROP IN ethN 127.x SRC Blocking occurred because the source address of a packet 
incoming from external interface belongs to 127.0.0.0/8 
network. 

_lfp_ DROP IN ethN BCAST SRC Blocking occurred because the source address of a packet 
incoming from external interface belongs to Broadcast type. 

_lfp_ DROP IN ethN BCAST PKT Blocking occurred because the packet type of a packet incoming 
from external interface is Broadcast. 

_lfp_ DROP IN MNG FWD The packet forwarding process is blocked because the relevant 
interface has been defined as management interface. 

_lfp_ DROP OUT MNG FWD The packet forwarding process is blocked because the relevant 
interface has been defined as management interface. 

_lfp_ DROP IN MNG LMCS Access to LMCS service port numbered 4000 from an interface 
except Management Interface is blocked. 
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_lfp_ DROP OUT MNG LMCS  Response access from LMCS service port numbered 4000 
towards an interface except Management Interface is blocked. 

_lfp_ DROP IN MNG WEB  Access to LRMS service port numbered 81 from an interface 
except Management Interface is blocked. 

_lfp_ DROP OUT MNG WEB  Response access from LRMS service port numbered 81 towards 
an interface except Management Interface is blocked. 

_lfp_ DROP IN MNG SSH  Access to SSH service port numbered 22 from an interface except 
Management Interface is blocked. 

_lfp_ DROP OUT MNG SSH  Response access from SSH service port numbered 22 towards an 
interface except Management Interface is blocked. 

_lfp_ DROP IN MNG IF  A management request connection which does not have 
management permission is blocked. 

_lfp_ DROP OUT MNG IF Response to a management request connection which does not 
have management permission is blocked. 

_lfp_ DROP IN CONSOLE Access to management ports is blocked. 

_lfp_ DROP OUT CONSOLE Access response from management ports is blocked. 

_lfp_ DROP IN IF BAD SRCIP  Blocking occurred because the source address of the packets 
incoming from the relevant internal interface does not overlap 
with neither the network address of the internal interface nor 
the internal networks defined under this internal interface. 

_lfp_ DROP IN ethN OWN SRCIP B locking is done because the source address of the packet 
incoming from any overlaps with the IP address of one of the 
interfaces defined on the device. 

_lfp_ DROP ICMP DoS  ICMP: Blocking occurred due to fragment or invalid session state. 

_lfp_ DROP TCP DoS TCP: Blocking occurred due to fragment or invalid session state. 

_lfp_ DROP UDP DoS  UDP: Blocking occurred due to fragment or invalid session state. 

_lfp_ DROP TCP Scan TCP: Packets which are coming with scanning purpose and have 
packet flags which are expected to be absent normally, are 
blocked. 
FIN,URG,PSH / ALL 
SYN,RST,ACK,FIN,URG  / ALL 
NONE / ALL 
ALL / ALL 
FIN / ALL 
SYN,RST / SYN,RST 
SYN,RST / SYN,RST 
tcp-option 64  
tcp-option 128 



 
 

503 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

_lfp_ DROP FRAG Scan TCP Fragment Scan: Packets which are coming with scanning 
purpose and have packet flags which are expected to be absent 
normally, are blocked. 
FIN,URG,PSH / ALL 
SYN,RST,ACK,FIN,URG  / ALL 
NONE / ALL 
ALL / ALL 
FIN / ALL 
SYN,RST / SYN,RST 
SYN,RST / SYN,RST 
tcp-option 64  
tcp-option 128 

_lfp_ DROP SESSIONLESS PKT  Communication packets coming with a purpose other than 
opening session although there’s no session are blocked.  

_lfp_ DROP PKT Too small  UDP, TCP, ICMP packets which are smaller than they should be 
are blocked. 

_lfp_ DROP LRMS Abuse  Extremely fast connection request to LRMS management service 
port is blocked. 

_lfp_ DROP SSH Abuse  Extremely fast connection request to SSH management service 
port is blocked. 

_lfp_ DROP WAUTH INPUT  Packets belonging to an unauthorized IP although WAUTH is 
active are blocked. 

_lfp_ DROP WAUTH FORWARD  Packets belonging to an unauthorized IP although WAUTH is 
active are blocked. 

_lfp_ DROP Default  Packets are blocked with the predefined blocking rule running 
after all the rules added by the user. 

_lfp_ Default --DENY  Packets are blocked with the predefined blocking rule running 
after all the rules added by the user. 

_lfp_ Default_ ethN -- DENY Packets are blocked with the predefined blocking rule running 
after all the rules added by the user. 

_lfp_ Rule NNN -- ACCEPT Permitted with the rule numbered NNN defined through LMC. 

_lfp_ Rule NNN -- DROP Blocked with the rule numbered NNN defined through LMC. 

_lfp_ Rule NNN -- REJECT Actively rejected with the rule numbered NNN defined through 
LMC. 

_lfp_ Rule NNN -- LOG Only logged with the rule numbered NNN defined through LMC, 
no other process is performed. 

_lfp_ USER DEFINED PREFIX:  Logged with "USER DEFINED PREFIX" name specified by system 
administrator in a rule defined through LMC. ACCEPT, DROP state 
shall be specified by user. 
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_lfp_ IPMAC_MAXCONN:  Blocking occurred because the maximum number of connections 
assigned per IP is exceeded. 

_lfp_ IPMAC_ABUSE Blocking occurred because of contrary situation to IP-MAC 
mapping rules. 

_lfp_ i PROXYCONNLIMIT_DROP Blocking occurred because number of sessions limit from internal 
clients to proxy system on the device is exceeded. 

_lfp_ i FLOODCONTROL_DROP:  
_lfp_ f FLOODCONTROL_DROP 

Temporary blocking occurred because an internal client 
exceeded the connection limits to a single destination. 

_lfp_ i CLIENTFLOOD_DROP: 
_lfp_ f CLIENTFLOOD_DROP: 

Temporary blocking occurred because an internal client 
exceeded the defined packet speed limits. 

_lfp_ i CONNLIMIT_DROP: 
_lfp_ f CONNLIMIT_DROP: 

Temporary blocking occurred because an internal client 
exceeded the defined number of sessions limits. 

  
 

 

2013.7.31-3:33:12 USER IP URL *EXCEPTION* You_have_ 
privileged_username. GET 0 0 - 2 304 - GRUP - TCP_MISS/304  13 
DEFAULT_PARENT/127.0.0.1 

URL is permitted. 

*SCANNED* POST A sent web POST request is 
scanned and permitted. 
Blocking occurred because the 
source address of a packet 
incoming from external 
interface belongs to 
127.0.0.0/8 network. 

CONTENTMOD GET The incoming content is 
replaced with regular 
expressions. 

URLMOD GET The outgoing request URL is 
replaced with regular 
expressions. For example with 
the purpose of forcing to Safe 
Search 

*DENIED* Banned_file_extension:_.exe GET 0 0 Banned extension Access is blocked due to a 
banned file extension (exe) 

*DENIED*Banned_Site:_facebook.com GET Access is blocked due to a 
banned site. 

*DENIED* Banned_URL:_adfarm.mediaplex.com/ad GET Access is blocked due to a 
banned URL. 

http://www.adapazarinet.com/sakarya/images/logo.gif
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*DENIED* Banned_MIME_Type:_video/mp4 GET 0 0 Banned MIME 
Type 

Video (mp4) content is blocked 
due to a banned MIME Type. 

*EXCEPTION*You_have_accessed_to_a_priviliged_site. GET Access permission is given to a 
site that is added to 
exceptions. 

*DENIED*Banned_irregular_expression_(URL) Blocking occurred because URL 
matched with a blocked 
pattern. 

*SCANNED**DENIED*Limit_of_blocked_expressions_is_exceeded:_50
_ 

Blocking occurred because web 
page content contains blocked 
expressions above the limit. 

*SCANNED**DENIED*Banned_words_are_found Blocking occurred because 
banned words are found in the 
web page content. 

 

 

 

 

 

 

 

 

 

 

1. Labris Logview User Guide 

1. Introduction 

Labris Logview is a project which aims to make monitoring the system wide logs easier to 

system admins. User can see all logs for entire: 

1 Firewall Firewall Network Logs View 

2 Access Access Logs View 

3 Operational Operational Logs View 

4 Administrative Administrative Logs View 

5 Wirelass Authentication Wireless Authentication Logs View 

6 IPMAC IPMAC Logs View 

7 DHCP DHCP Logs View 
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8 Mail Mail Logs View 

system sources. 

Logview allows user to define different log sources and regarding columns. Users can easily 

access new logs via “Live Monitoring” and reach older records for a given date range. 

 

Logview Records table while streaming with some sample logs 

 

Figure  Logview records table with some historical logs 
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2. Parts & Tools 

Logview has some easy-to-use parts and useful tools: 

 

 

 

 

 

 

 

 

 

 

 

 

Figure  Parts & Tools on main display 
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 1 . Records tables 

1 Show / Hide Column Fitering Select Show or Hide Column Filtering 

2 Export Filtered Records Select Export Filtered Records 

3 Remove Table Select Remove Table 

 

 
 

4 Table Length Select Table Length 

5 Backward Pages by 10 Select Backward Pages 

6 Previous Page Select Previous Page 

7 Go to Page Number Write Go to Page Number 

8 Next Page Go to Next Page  

9 Forward Pages by 10 Select Forward Pages 

10 Refresh The Table Refresh The Table Button 

11 Switch on/off Switch on/off Live Monitoring 
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 2 . Live monitoring shortcuts 

 

 

 

1 Firewall Firewall Network Logs View 

2 Access Access Logs View 

3 Operational Operational Logs View 

4 Administrative Administrative Logs View 

5 Wirelass Authentication Wireless Authentication Logs View 

6 IPMAC IPMAC Logs View 

7 DHCP DHCP Logs View 

8 Mail Mail Logs View 

 

 3 . Layout options 

 

1 Single View Select Single View 

2 Column View Select Column View 

3 List View Select List View 

4 Grid View Select Grid View 

 

 4 . Settings 

 

 

1 Change Settings Select Change Settings 

2 Save Screen Save Screen 

3 Load Screen Load Screen 
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 5 . Language selector 

 

 

1 English Select English Language 

2 Turkish Select Turkish Language 

 

 6 . Server status & service controller 

 

 

1 Restart Services Restart all Services 
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 7 . Sidebar 

 

1 Dashboard Select Dashboard for Dashboard Screen 

2 All Logs Select All Logs 

3 CPU Usage CPU Usage Info 

4 RAM Usage RAM Usage Info 

5 Disk Usage Disk Usage Info 

 

3. Instructions 

Logview is a web-based application and the only thing you could run it is a Web browser. We 

advice you to mostly use Chrome, Safari or Firefox. Logview does not support IE versions before 

8.0. 

Logview uses Websocket and most of near future Web technologies; therefore the browser you 

would use must support all these technologies. 

4. Records Table 

Records table shows records from your UTM device that is gathers all logs from defined 

sources. You can see any log data, which is gathered from given date range and given, source. 

You can access column filter feature just by clicking 1.1 Show / Hide column filtering button and 

you can make a search by typing any keyword regarding column data. 

The picture shows a table that its column filter is not enabled yet: 
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And by clicking 1.1 Show / Hide Column Filtering button you will see the filters, even they are 

already filtered: 

 
 

 

It can be search by using some operators: 

 “=” use it for define an equation such as for User column use like “user@domain” or 

type “=username@domain” 

 “!=” use it for User column use like “user@domain” or type “=username@domain” 

 “&&” use it for “and” keywords such as for User column use like “=user@domain && 

!=anotheruser@domain” 

 “||” use it for “or” keywords such as for User column use like “=user@domain || 

!=anotheruser@domain” 

 

In records table you can export your filtered data by clicking 1.2 Export filtered records as CSV 

mailto:!%3Danotheruser@domain
mailto:!%3Danotheruser@domain


 
 

513 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

or TXT file formatted. 

 

And you can remove the table by clicking 1.3 Remove table button. 

Records table also has a footer, which includes: 

  record  length: use it to set content length of a table by page 10, 15, 20, 30 and 50 

 

  backward- forward buttons: use it to shift pages by 10 forward or backward  

  previous-   next buttons: use it to shift pages one by one  

  reload buttons: use it to reload the page if you think something goes wrong about the 

table  

 streaming on/off button: enable or disable stream, it is better to stop stream when 

filtering data.  

Records tables also have nice user-friendly features. You can resize columns by pulling the next 

line to the column and leave it when you reach the size you want. Initially records tables have 

own predefined size to provide best-fit size for the data inside the column. You can also order 

historical records table just by clicking the header of the column you would like to sort by; and 

also you can show or hide columns by clicking the down-arrow on the column heading as show 
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in figure. 

Another feature tables have is “replacing columns”. You can replace columns by drag and drop. 

Drag a column you want to move then drop to put where you want. 

4.1. Real-time Monitoring 

Logview provides a real-time monitoring for streaming logs. You can just click the shortcut 

buttons and it fires an event to create real-time logs monitoring tables. 

 

 

1 Firewall Log View All Firewall Logs 

2 Access Logs Internet Access Logs 

3 Service Logs Device Service Logs 

4 Administrative Logs Administrative Logs for This Device 

5 Wireless Authentication Logs Wireless Authentication Logs 

6 Mail Logs Mail Logs for SMTP, IMAP and POP3 

7 IP-MAC Logs IP AND MAC Address Logs 

8 DHCP Logs DHCP Logs 

 

Real-time monitoring tables allow you to track real time logs. Even if you want to filter them 

then it still keeps streaming 

Historical Logs 

 

Historical logs are all logs that are retrieved from older logs. You can create a historical records 

table from sidebar. 
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After you click the domain name you will see a window like below: 

As we see in the figure, there are log sources and regarding fields which will be defined as 

columns when the table is created. We can select which column will be shown or hidden. In 

date range selection section, there are predefined date ranges 1 day, 3 days, 1 week. In 

another case, you can also select date range by manually. 

 

 

Figure: Create Historical Log Table 
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Figure: Create Historical Log Table - Pick Date Range 
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5. Utilities 

5.1. Settings 

Settings section lets you change settings along Logview. By clicking 4.1 Change Settings you will 

able to set default behavior of columns to be shown or hidden. 

If you check any field on this window, it will be shown in records table as shown column. If you 

uncheck a field, it will be hidden on the table.

 

Choosing Default Log Fields which, are shown as predefined column in the table 



 
 

518 Labris Networks 

Administration Guide for Labris UTM  
Version 3.4.2 

 

Settings Data Store to retrieve data from localhost or remote host 

5.2. Save Screen 

Logview allows you to save different views depending on your needs. You can create different 

widgets for different log sources, you can resize columns, set filters, change layouts and then 

you can click on “Save Screen” and give it a name. The page automatically saves the view after 

some critical events. 

 

5.3. Load Screen 

Logview stores your saved screen with any parameters and settings you asdf, as mentioned 

above. You can make a search then you fill find all saved screens and select which one you 

would like to load. 
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5.4. SMTP Settings 

It can be set SMTP settings by new version of Logview. You can either provide your own SMTP server 

settings or set any other SMTP server provider settings to send email(s) from Labris appliances. As it is 

shown in the figure below, there are mandatory fields you have to set and you have a “Test Connection” 
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button to correct your settings before save it.

 

 

6. Regional Settings 

Logview supports multilingual operations. Basically, it comes with English and Turkish. If clients 

require it, it is easy to add more languages to be supported. 

 

Main display in English 
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Main display in Turkish 

 

 

7. Service Monitoring 

You can monitor background service’s status of Logview. The status indicator will be green if all 

background services work fine, but the indicator will be yellow if some of services are ok but 

some have problem. If you see yellow indicator you should see system logs. If the indicator is 

red you should talk with the technical support. 

 

There is also a service controlling option under the Server Status menu to restart services. If 

you see yellow indicator you may go through to try restarting services. If it may keep staying in 

the yellow status please contact the technical support. 
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8. Layout Options 

Logview is a single page application that supports widgetizing the layout. You can monitor 4 

different log sources in different records table. There are 4 layout option to placed widgets in 

the page:  

 

1 Single Widget View Single Widget View Button 

2 Column View Select Column View 

3 List View Select List View 

4 Grid View Select Grid View 

 

Logview starts with a single widget if there is no dashboard saved and if the dashboard has no 

widget on it. So, Logview loads a firewall records table in single widget view. You can change 

the widgets, view option, columns, filters and then save the dashboard or save it with a 

different name. 

8.1. Single Widget View 

In single widget view layout you can see only one widget at a time. If you pick a streaming 

records table or create a historical records table it will replace the previous widget with itself. 

In another case, if you have more than one widget in a different view then you select the single 

view, the layout option will remove all widget except the one that added last. 
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8.2. Column View 

In column view you can put widgets in columns and vertically display them. 

 

8.3. List View 

In list view you can put widgets in an horizontal order. 

 

It is easy to track log records while you have two streaming records table to compare some 

data. You can select columns and watch logs while the records table streams. 

8.4. Grid View 

Grid view has a wide gallery-like view and puts widgets in a 4 piece grid layout. 
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This view helps you to compare or watch 4 different log sources in tables. 

9. Reports 

By a new version 1.2.0-84 of Logview, we provide a brand new reporting module. Since, our products 

have already reporting module ERM, by this new module we add improving features listed below: 

 Enables custom query writing, 

 PDF report generation, 

 Table and chart(PIE chart only for recent version) displaying in PDF, 

 Report template add/edit/remove features, 

 Schedule report generation by user, 

 Email and FTP upload feature, 

 Manually upload or email generated report to given destination, 

9.1. Create Template 

The figure shown below helps you create a “Report Template” which, defines “Report” fields, data set, 

chart set, schedule settings, email settings and FTP settings. In this view you can use All records in a log 

table or write your own custom query based on SQL syntax. See details in the figure below: 
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Write custom SQL query and Logview suggest column names and basic SQL keywords. 
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Select columns which, are will be shown in the report table. 

 

Select chart field to be shown in Pie chart 
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Schedule settings tab 
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Email Settings Tab 

 

FTP Settings Tab 
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The figure above, contains all report templates which, are created by user or pre-defined by Labris 

regarding most required report enquiries. Some buttons and details can be seen in a template row: 

name, description, period, created date, show reports grid and generate a new report, edit and remove 

template. 

 

There are helper tooltips on every single buttons placed in a row. It helps you about what its click event. 

Show Report Table: Open a popup and show reports listed in a table that belong to the template. 

Generate New: Generates a new report depending provided details such as data set, table settings, 

chart settings, schedule settings, emails settings and FTP settings. 

Edit: Helps you edit the template details. 

Remove: Delete the template and all reports generated previously by the template details. 
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Reports Grid shows all generated reports 

 

 

In reports table you can download, upload or send email manually. You can leave FTP and email settings 

as given previously or write new settings to deliver the report seperately to different email addresses or 

FTP destinations. 
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FigureFTP Upload popup 

 

Send email popup 

 

Pie Chart result which, is shown in the report 
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